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1. Safety precautions
 ►Observe these precautions carefully to ensure safety.
 ►After reading this manual, pass the manual on to the end user to retain for future 
reference.
 ►The user should keep this manual for future reference and refer to it as necessary. This 
manual should be made available to those who repair or relocate the units. Make sure 
that the manual is passed on to any future air conditioning system user.

 :     indicates a hazardous situation which, if not avoided, could result in 
death or serious injury.

 :    indicates a hazardous situation which, if not avoided, could result in 
minor or moderate injury.

 :    addresses practices not related to personal injury, such as product 
and/or property damage.

1-1. General precautions

Do not install the controller in areas where large amounts of oil, steam, organic solvents, 
or corrosive gases (such as ammonia, sulfuric compounds, or acids), or areas where 
acidic/alkaline solutions or special chemical sprays are used frequently. These substances 
may significantly reduce the performance and corrode the internal parts, resulting in 
electric shock, malfunction, smoke, or fire.

To reduce the risk of short circuits, current leakage, electric shock, malfunction, smoke, or 
fire, do not wash the controller with water or any other liquid.

To reduce the risk of electric shock, malfunction, smoke, or fire, do not touch the electrical 
parts, USB memory, or touch panel with wet fingers.

To reduce the risk of injury or electric shock, before spraying a chemical around the 
controller, stop the operation and cover the controller.

To reduce the risk of injury, keep children away while installing, inspecting, or repairing the 
controller.

If you notice any abnormality (e.g., burning smell), stop the operation, turn off the 
controller, and consult your dealer. Continuing the operation may result in electric shock, 
malfunction, or fire.

Properly install all required covers to keep moisture and dust out of the controller. Dust 
accumulation and the presence of water may result in electric shock, smoke, or fire.

To reduce the risk of fire or explosion, do not place flammable materials or use flammable 
sprays around the controller.

To reduce the risk of electric shock or malfunction, do not touch the touch panel, switches, 
or buttons with a sharp object.

To avoid injury from broken glass, do not apply excessive force to the glass parts.

To reduce the risk of injury, electric shock, or malfunction, avoid contact with the sharp 
edges of certain parts.

https://planetaklimata.com.ua/ua/
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Consult your dealer for the proper disposal of the controller. Improper disposal will pose a 
risk of environmental pollution.

1-2. Precautions for relocating or repairing the unit

The controller must be repaired or moved only by qualified personnel. Do not disassemble 
or modify the controller. Improper installation or repair may result in injury, electric shock, 
or fire.

1-3. Additional precautions

To avoid discoloration, do not use benzene, thinner, or chemical rag to clean the controller. 
When the controller is heavily soiled, wipe the controller with a well-wrung cloth that has 
been soaked in water with mild detergent, and then wipe off with a dry cloth.

This appliance is not intended for use by persons (including children) with reduced 
physical, sensory or mental capabilities, or lack of experience and knowledge, unless they 
have been given supervision or instruction concerning use of the appliance by a person 
responsible for their safety. Children should be supervised to ensure that they do not play 
with the appliance.
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2. Introduction
AE-200A/AE-50A/AE-200E/AE-50E is a centralized controller.
EW-50A/EW-50E is an LCD-less total management system.
Any connected air conditioning systems can be operated or monitored on the AE-200A/AE-50A/AE-200E/AE-50E’s 
LCD or the Web browser.
Each AE-200A/AE-50A/EW-50A/AE-200E/AE-50E/EW-50E can control up to a total of 50 indoor units and other 
equipment. By connecting AE-200A/AE-200E (main controller) and AE-50A/AE-50E/EW-50A/EW-50E (sub 
controllers), up to 200 indoor units and other equipment can be controlled.
Additionally, by integrating AE-200A/AE-50A/EW-50A/AE-200E/AE-50E/EW-50E using the Integrated Centralized 
Control Web, up to 2,000 indoor units can be controlled.

This manual explains methods for configuring the necessary initial settings for when using the Air Conditioning 
Control System. 
Flow of the initial settings and trial run are shown in section 2-2 “Flow of the initial settings and trial run”.

2-1. Terms used in this manual
-  “Centralized Controller AE-200A/AE-200E” is referred to as “AE-200.”
-  “Centralized Controller AE-50A/AE-50E” is referred to as “AE-50.”
-  “Centralized Controller EW-50A/EW-50E” is referred to as “EW-50.”
-   “Booster unit” and “Water HEX unit” are referred to as “Air To Water (PWFY) unit.”
-  “Advanced HVAC CONTROLLER” is referred to as “AHC.”
-  “Hot Water Heat Pump unit” is referred to as “HWHP (CAHV, CRHV) unit.”

https://planetaklimata.com.ua/ua/catalog/lineup/?goodsid=1142&path=root-11-10-184-1142
https://planetaklimata.com.ua/ua/catalog/lineup/?goodsid=1141&path=root-11-10-184-1141
https://planetaklimata.com.ua/ua/catalog/lineup/?goodsid=1140&path=root-11-10-184-1140
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2-2. Flow of the initial settings and trial run
This explains one example of settings procedures.

 Prepare a PC with which to use the Initial Setting 
Tool and Web Browser for Initial Settings.
(See section 10-1.)

(Common: See sections 4-2 and 4-3.
LCD: See sections 5-1-3, 5-1-4, and 5-1-5.
Web Browser for Initial Settings:   See sections 7-1-

1 and 7-1-2.)

Update the AE-200/AE-50/EW-50, and ensure the 
software version matches.
(See section 4-4.)

Configure the [System Exp] setting on the AE-200’s 
LCD.
(See section 5-1-4.)

Register the license for the AE-200/AE-50/EW-50.
(See section 4-5.)

(See section 6-3-1.)

Configure unit settings for the AE-200/AE-50/ 
EW-50.
(See sections 5-1, 5-2, 6-4, 7-1, and 7-2.)

(See section 6-5-3.)

(LCD:   See sections 5-2 to 5-4.
Web Browser for Initial Settings:   See sections 7-2 

to 7-4.)
 * Items that can be set will differ depending on 
settings methods. Refer to section 2-3 and 
configure, ensuring that no items are omitted.

Carry out a trial run in order to check that the 
AE-200/AE-50/EW-50 are operating in accordance 
with settings.

Backup settings, and retain the settings data so 
that it can be used for recovery in the event of 
malfunction.
(LCD: See section 8-1. 
Web Browser for Initial Settings:   See section 8-2.)

 * For dealers and contractors  
Properly carry out initial settings and trial runs, and take care to ensure that no settings have been omitted or configured incorrectly.

Preparation of the PC

Settings with each centralized controller 
[AE-200’s LCD or Web Browser for Initial Settings]

• Unit Info./Basic Settings (including Date and Time settings)
• Network (IP address registration for each centralized controller)

AE-200/AE-50/EW-50 update

AE-200’s LCD
Unit Info.: [System Exp] “Expand”

Integrated Centralized Control Web (Manage with PC)

Managing up to 200 units 
with one AE-200 and one 
or more AE-50/EW-50

AE-200’s LCD
Network : Controller [Exp1–Exp4] selection 

: Destination IP address setting

AE-200’s LCD
Unit Info.: [System Exp] “Do not expand”

No settings with AE-50/EW-50

Managing up to 50 units 
with each AE-200/EW-50 
respectively

Managing up to 200 units 
with one AE-200 and one 
or more AE-50/EW-50

License registration: 
[AE-200’s LCD or Web Browser for Initial Settings]

Integrated Centralized Control

Managing up to 2000 units with 
multiple AE-200 and one or more 
AE-50/EW-50

System Configuration settings (in Basic Settings): [Initial Setting Tool]
Set the configuration and destination IP addresses for 

centralized controllers and expansion controllers.

Floor for Integrated Centralized Control Web (in Floor Settings):
[Initial Setting Tool]

Set the [Managed centralized controller] setting to  
“Manage” for each centralized controller.

Unit Settings
[Initial Setting Tool, AE-200’s LCD, or  

Web Browser for Initial Settings (for each centralized controller)]
• Groups  ・ Interlocked LOSSNAY  ・ Blocks
• Energy Management Block (Initial Setting Tool or AE-200’s LCD)
• PI Controller/AI Controller (Settings in “Measurement” screen on the AE-200’s 

LCD and Web Browser for Initial Settings)

Function Settings
[AE-200’s LCD or Web Browser for Initial Settings (for each centralized controller)]

• Peak Cut and Interlock control will be available with a license registration 
respectively.

• Function setting is not available on the Initial Setting Tool as it is now.
• Set Temperature Range Limit, Night Mode Schedule and System-changeover 

settings are available only on the Web Browser for Initial Settings.

Trial run

Settings back-up

Completed

Not use 
Integrated 
Centralized 
Control 
Web
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Initial settings for AE-200/AE-50/EW-50 can be configured on the LCD, Initial Setting Tool, and Web Browser for 
Initial Settings.

Each has specific characteristics as below.

• LCD
Method for setting the AE-200/AE-50/EW-50 from the AE-200’s LCD.
Configuration of initial settings for single AE-200 systems is possible.
Methods of setting from the LCD are explained in section 5 “Settings on the LCD”.

  Note:  The EW-50 does not have an LCD, therefore it is necessary to configure settings from either the Initial Setting Tool or 
Web Browser for Initial Settings.

• Initial Setting Tool
The Initial Setting Tool is used for configuring settings from a PC.
This allows configuration of initial settings for multiple AE-200/EW-50 systems, and allows batch configuration 
of initial settings for up to a total of 40 AE-200/AE-50/EW-50 units.
The settings data created using the Initial Setting Tool is written from the PC to the AE-200/AE-50/EW-50 over 
a LAN connection. Additionally, settings data can be created beforehand at another location such as an office.
Methods of setting from the Initial Setting Tool are explained in section 6 “Settings using Initial Setting Tool”.

  Note:  It is necessary to set the apportioned electricity billing function initial settings and Integrated Centralized Control Web 
function initial settings from the Initial Setting Tool.

  Note:  It is necessary to set the BACnet® connection function initial settings from the BACnet® Setting Tool.

• Web Browser for Initial Settings
The Web Browser for Initial Settings is used for configuring settings from a PC Web browser. 
This allows separate logins to a single AE-200/AE-50/EW-50, and configuration of initial settings. 
Methods of setting from the Web Browser for Initial Settings are explained in section 7 “Settings using Web 
Browser for Initial Settings”.
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The settings ranges for each of these settings are as below.

 

 

 

Initial Setting Tool 
or Web Browser 
for Initial Settings

LCD

AE-200 system No. 1

AE-200

AE-200 system No. 2

AE-200

EW-50

50 
M-NET 

AC units

50 
M-NET 

AC units

EW-50

AE-50

50 
M-NET 

AC units

AE-200 system No. 3
AE-200

50 
M-NET 

AC units

EW-50

50 
M-NET 

AC units

EW-50

50 
M-NET 

AC units

50 
M-NET 

AC units

EW-50 system
EW-50

50 
M-NET 

AC units

Initial Setting Tool

Web Browser for 
Initial Settings



11WT07627X01

2-3. Functions that can be set
The functions that can be set by using the LCD, Initial Setting Tool, and Web Browser for Initial Settings are 
different. 
Depending on the function to use, it may be necessary to combine multiple initial settings methods.

Functions that can be set are as follows.

Setting item Description LCD Initial Setting 
Tool

Web Browser for 
Initial Settings

Basic 
settings

Date and time settings The current date/time and daylight 
savings time can be set. V V

License registration Licenses for optional functions can 
be registered. V V

Unit information Basic settings can be made. V V V

Language The language to be used for display 
can be set. V

M-NET Whether or not to use an AE-200 
M-NET can be selected. V

Expansion controller
Whether or not to use an expansion 
controller (AE-50/EW-50) can be 
selected.

V

Billing function
Whether or not to use an AE-200 
apportioned electricity billing 
function can be selected.

V *1

Advanced settings

“Time Master/Sub”, “Schedule: 
Season setting”, and “Old model 
compatibility mode” settings can be 
made.

V V V

Network settings Settings for the network-related 
items can be made. V V V

IP address of 
AE-200/AE-50/EW-50 *4

IP address of AE-200/AE-50/EW-50 
can be set. V V

IP address of expansion 
controller

Destination IP address of an 
expansion controller (AE-50/EW-50) 
can be set with AE-200.

V

Unit settings

Group settings

Air conditioning units, Air To 
Water (PWFY) units, LOSSNAY 
units, HWHP (CAHV, CRHV) 
units, general equipment, remote 
controllers, sub system controllers, 
and AHC can be registered to a 
group.

V

Refrigerant system settings 
(for apportioned electricity 
billing function)

Set the refrigerant system 
connection information in the 
apportioned electricity billing 
function to distribute the outdoor 
unit electric energy to indoor units.

V *1

Function 
settings

Interlocked LOSSNAY 
settings

The operation of indoor units and 
LOSSNAY units can be interlocked. V V V

Block (operation block) 
settings 

The groups can be registered to a 
block. V V V

Energy management block 
settings

The groups can be registered to an 
energy management block. V V

PI controller settings

PI controller or Pulse Input (PI) 
settings such as “electricity meter” 
or “water supply meter” can be 
made.

V V V

AI controller settings
AI controller “temperature sensor” 
and “humidity sensor” settings can 
be made.

V V V

E-Mail Error notification e-mail and e-mail 
alarm settings can be made. V

Peak Cut
Peak Cut method and Peak Cut 
control details for each control level 
can be set.

V *5 V *5

Energy Management 
settings

Set to use the energy management 
function to display graphs. V V

Set Temperature Range 
Limit

Set to restrict the local remote 
controller set temperature range. V



12WT07627X01

Setting item Description LCD Initial Setting 
Tool

Web Browser for 
Initial Settings

Function 
settings

Night Mode (quiet operation) 
Schedule

Set to switch outdoor units to quiet 
operation for a certain period of 
time.

V

System-changeover

Set to automatically switch indoor 
unit operation mode (heating 
and cooling) based upon room 
temperature and set temperatures.

V

External Temperature 
Interlock

Set to interlock the temperature 
differential between the set 
temperature and the outdoor air 
temperature to use automatic 
adjustment.

V V

Night Setback Control
Set to automatically cool or heat if 
the indoor temperature goes outside 
a set range at night.

V V

Interlock control
Set interlock restrictions for interlock 
operation when conditions have 
been met.

V *6

AHC Port Name settings Advanced HVAC CONTROLLER 
(AHC) port name can be set. V

Night purge Set night purge to bring in cooler 
outside night air. V V

BACnet® *2 BACnet® objects can be set.

Floor settings

Floor settings Set monitoring by displaying the 
floor layout using the LCD. V V

Floor settings for Integrated 
Centralized Control Web

Set monitoring by displaying the 
floor layout using the Integrated 
Centralized Control Web.

V

Billing 
function 
settings

Billing Function settings Apportioned electricity billing 
function settings can be made. V *1

Outdoor Unit settings Set outdoor unit parameters for 
electric energy apportionment. V *1

Indoor Unit settings Set indoor unit parameters for 
electric energy apportionment. V *1

Measurement settings
Set connection relationship for 
electric energy apportionment 
metering devices and units.

V *1

Charges settings Time period setting for the seasonal 
charges can be made. V *1

User settings

User settings for LCD

Set functions and passwords 
that can be used with the LCD. 
(Maintenance user/building 
manager)

V

User settings for Integrated 
Centralized Control Web *3

Set general user and tenant 
manager settings for Integrated 
Centralized Control Web.

Maintenance
Data back-up/import

Save settings data to a USB 
memory device. Also, this can 
write settings data saved on 
a USB memory device to the 
AE-200/AE-50/EW-50 to restore 
status.

V V

Software update Update AE-200/AE-50/EW-50 
software. V V

*1 For details, refer to the Instruction Book (Apportioned Electricity Billing Function).
*2 Make the settings on the BACnet® Setting Tool. Refer to the Instruction Book (BACnet® Setting Tool).
*3 Make the settings on the Integrated Centralized Control Web. Refer to the Instruction Book (Integrated Centralized Control Web).
*4 LAN2 IP address (IPv4) for BACnet® can be set. IP address (IPv6) can be set only from the BACnet® Setting Tool.
*5 “Energy Management License Pack” is required. (AE-200E/AE-50E/EW-50E only)
*6 “Interlock control” license is required.
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3. Parts to be used
This section explains parts required for initial settings.
Refer to the Installation Manual for parts required for installation of AE-200/AE-50/EW-50.

3-1. Separately sold parts

Item Description
Qty

LCD Initial Setting 
Tool *2

Web Browser for 
Initial Settings

License
Required to operate functions that require a 
license. 
Register for each of AE-200/AE-50/EW-50.

Required number

AE-200 update 
file *1

Required to ensure that all 
AE-200/AE-50/EW-50 versions are the 
same. 
If versions do not match, then they will 
not operate.

1

AE-50/EW-50 
update file *1 1

Initial Setting  
Tool *1

Use to carry out initial settings. 
Required when using Integrated Centralized 
Control Web and apportioned electricity 
billing functions. 
Depending on the version of 
AE-200/AE-50/EW-50, the version of the 
Initial Setting Tool that can be used will differ.

– 1 –

*1 Contact your dealer regarding the update files.
*2 When performing initial settings using the Initial Setting Tool, it is necessary to ensure that the AE-200/AE-50/EW-50 versions match, but 

allowable combinations are as below.

Initial Setting Tool version AE-200/AE-50/EW-50 version .NET Framework

Ver. 1.1 Ver. 7.2–7.3 Ver. 4.5.2 or later

Ver. 1.0 Ver. 7.2 Ver. 4.5 or later

Cannot be used. Ver. 7.1 –

3-2. Commercially available parts

Item Description
Qty

LCD Initial Setting 
Tool

Web Browser for 
Initial Settings

PC PC with which to use the Initial Setting Tool 
and Web Browser for Initial Settings. 1 1

USB memory Required for backup of settings data. 1
LAN cable Required for connection of 

AE-200/AE-50/EW-50 and PC.
Required number Required number

Switching HUB Required number Required number
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3-3. PC requirements
The operating environment for the PC with which to use the Initial Setting Tool and Web Browser for Initial Settings 
is as below.

Item Requirements

CPU 1 GHz or better (at least 2 GHz recommended)
Memory 1 GB
Screen resolution 1024 x 768 or better (at least 1366 x 768 recommended)
OS Windows 7, Windows 8.1 (32bit/64bit)
Operating environment
(only required for Initial Setting Tool) .NET Framework 4.5.2 or later

Browser
(only required for Web Browser for 
Initial Settings)

Microsoft® Internet Explorer 8.0
Microsoft® Internet Explorer 9.0
Microsoft® Internet Explorer 10.0
Microsoft® Internet Explorer 11.0
 * Java execution environment is required.  
(Verified to run on Oracle® Java Plug-in Ver. 1.8.0_60.)

 * Install Oracle® Java Plug-in that is appropriate for your operating system. When using a 
64-bit Internet Explorer, install a 64-bit Java Plug-in.

 * The version of the Oracle® Java Plug-in can be verified by clicking [Java] in the Control 
Panel.

Internal LAN port or LAN card 100 BASE-TX or better

Pointing device Mouse, etc.
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4. Preparation
4-1. Logging in to the Web Browser for Initial Settings

Check that the Web Browser for Initial Settings can be logged in.

(1) Enter the web page address in the address field of the Web browser as follows:
http://[IP address of each AE-200, AE-50, or EW-50]/init/administrator.html
Press the [Enter] key. A login screen will appear.

 Note:  If the IP address of the AE-200/AE-50/EW-50 is [192.168.1.1], 
the web page address is [http: //192.168.1.1/init/administrator.
html].

 Note:  Default IP address of AE-200, AE-50, and EW-50 is 
[192.168.1.1].
When one or more AE-50/EW-50 controllers are connected, 
none of their IP addresses should overlap. The recommended IP 
address ranges are as follows.
AE-200:  Between [192.168.1.1] and [192.168.1.40]
AE-50/EW-50 (when used for system expansion):
  Between [192.168.1.211] and [192.168.1.249] 
EW-50 (when used alone):
  Between [192.168.1.1] and [192.168.1.40]
Refer to section 4-3 “IP address settings” for how to change the 
IP addresses.

 Note:  When one or more AE-50/EW-50 controllers are connected, log 
in to all AE-200, AE-50, and EW-50 Web browsers to make initial 
settings for AE-200, AE-50 and EW-50 respectively. The Web 
browser cannot be switched among the AE-200, AE-50, and 
EW-50.

 Note:  If the login screen does not appear then take the steps explained 
in section 9-1 “Notes on connecting to Web browser” to delete 
the temporary files.

 Note:  The web page will be displayed in the same language as the operating system on the PC. 
The web page can be displayed in other languages by entering the web page address as follows:

Chinese http://[IP address of each AE-200, AE-50, or EW-50]/init/zh/administrator.html
English http://[IP address of each AE-200, AE-50, or EW-50]/init/en/administrator.html
French http://[IP address of each AE-200, AE-50, or EW-50]/init/fr/administrator.html
German http://[IP address of each AE-200, AE-50, or EW-50]/init/de/administrator.html
Italian http://[IP address of each AE-200, AE-50, or EW-50]/init/it/administrator.html
Japanese http://[IP address of each AE-200, AE-50, or EW-50]/init/ja/administrator.html
Portuguese http://[IP address of each AE-200, AE-50, or EW-50]/init/pt/administrator.html
Russian http://[IP address of each AE-200, AE-50, or EW-50]/init/ru/administrator.html
Spanish http://[IP address of each AE-200, AE-50, or EW-50]/init/es/administrator.html

 Note:  You can add the web page address to your Favorites on the login screen for easy access in the future.
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(2) Enter the user name and the password in the login screen, and click [Login]. A setting screen will appear.
The table below shows the default user names, passwords, and functions that are available for maintenance 
users and building managers.

User Default  
user name

Default 
password Available functions

Maintenance 
user initial init

Initial Settings Date and Time, Basic System, Groups,  
Interlocked LOSSNAY, Blocks

Functions 1 E-Mail, Peak Cut, Measurement,  
Energy Management Settings

Functions 2 Set Temperature Range Limit,  
Night Mode Schedule, System-changeover

Functions 3
External Temperature Interlock,  
Night Setback Control, Interlock control,  
AHC Port Name Settings

Ventilation 
Setting Night purge

User Settings User Settings

Utility Back up/import settings data

Building 
manager administrator admin Out of the functions listed above, the items to which access rights 

have been given on the User Settings screen are available.

Note:  A maintenance user can specify the functions to be made available for building managers. Refer to section 7-6 “User 
Settings” for details.

Note:  It is recommended to change the default user name and password so that the users other than the maintenance users 
and building managers will not be able to change the settings.

Note:  When one or more AE-50/EW-50 controllers are connected, log in to all AE-200, AE-50, and EW-50 Web browsers 
to make initial settings for AE-200, AE-50, and EW-50 respectively. The Web browser cannot be switched among the 
AE-200, AE-50, and EW-50.

Note:  The user name and password for Integrated Centralized Control Web differ from the ones for the maintenance user and 
building manager above. Set the user name and password for Integrated Centralized Control Web on the Integrated 
Centralized Control Web.
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(HTTPS connection)
AE-200/AE-50/EW-50 can encrypt communication data using HTTPS (SSL).
When connecting the AE-200/AE-50/EW-50 to the LAN that is accessible to the general public, it is recommended 
that the following settings be made so that the units are monitored and controlled on the encrypted web page.

   Note:  Depending on the operating system or the Java version, HTTPS encrypted communication may not be enabled properly. If 
this happens, use an HTTP connection as explained in the previous page.

(1) Prefix the web address with [https], enter the rest of the address, and 
press the [Enter] key.

https://[IP address of each AE-200, AE-50, or EW-50]/init/
administrator.html

Note:  If the IP address of the AE-200/AE-50/EW-50 is [192.168.1.1], the web page 
address is [https: //192.168.1.1/init/administrator.html].

The encrypted data communication will begin, and the Login screen will 
appear.
When the first time the Web browser is accessed, a security certificate 
error page appears instead of the Login screen. Go to step (2) below.

(2) Enter the following web page address in the address field of the Web browser, and press the [Enter] key:

http://[IP address of each AE-200, AE-50, or EW-50]/cacert.cer

(3) A notification bar or a window to confirm about file download will appear.
Click [Open].

(4) A certificate dialog will appear.
Click [Install Certificate...].

(5) A Certificate Import Wizard window will appear.
Click [Next].
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(6) Choose [Place all certificates in the following store] and click the 
[Browse...] button.
Select [Trusted Root Certification Authorities], click [OK], and then click 
[Next].

(7) Click [Finish] on completing the Certificate Import Wizard.

(8) Click [Yes] on the security warning to install the certificate.

(9) Certificate import process starts. A window will appear when the import 
completes successfully. 
Click [OK].
 Note:  The valid period of the certificate is from April 1st, 2014 to January 1st, 

2051. The system date and time of the PC must be within the period.
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4-2. Date and time setting
Set the date and time for the AE-200/AE-50/EW-50. There are two ways to set the date and time — from the AE-200’s 
LCD, and individually from the AE-200/AE-50/EW-50 Web Browser for Initial Settings.

If an expansion controller is connected in an AE-200 system, connect the AE-200 to the expansion controller over 
a LAN, then set the date and time from the AE-200. Setting the date and time on the AE-200 will synchronize the 
date and time on the expansion controller with the AE-200, therefore setting the date and time on the expansion 
controller is not necessary.

   Note:  After the “Integrated Centralized Control Web” license is registered, the date and time can be set on the Integrated 
Centralized Control Web. For details, refer to [Settings] – [Initial settings] – [Date and Time Settings] in the Instruction Book 
(Integrated Centralized Control Web).

[1]  When setting date and time on the AE-200’s LCD
(1) Touch the [Date and time] tab.

Referring to section 5-1-3 “Date and time”, set the current date, 
current time, and daylight saving time, and then touch [Save 
Settings].
 Note:  The AE-200’s current date and time will be synchronized to 

each AE-50/EW-50 and remote controllers.
 Note:  In order to synchronize the date and time with the 

AE-50/EW-50, it is necessary to set the date and time.
 Note:  The setting will not be saved until [Save Settings] is touched. 

Make sure to touch [Save Settings] after the setting is 
completed.
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[2]  When setting date and time on the AE-200/AE-50/EW-50’s Web Browser for Initial Settings
Click [Initial Settings] in the menu bar, and then click [Date and Time] to access the date and time settings screen.
Set the current date and time, and then click [Save Settings].

   Note:  The date and time settings may not be accessible if logged in as a building manager.
   Note:  The date and time settings made on this screen will be reflected on all the units in the M-NET system, all connected 

AE-50/EW-50 units, and the AE-200 units whose [Time Master] setting is set to [Sub].
   Note:  The date and time cannot be set on this screen if the [Time Master] setting is set to [Sub].
   Note:  The daylight saving time setting is required only on the AE-200.
   Note:  Changing the date and/or time when the charging function is in use can affect the calculation of the charges.
   Note:  When AE-50/EW-50 controller, DIDO controller (PAC-YG66DCA), AI controller (PAC-YG63MCA), or PI controller (PAC-

YG60MCA) is added to the system, set the current date and time on this screen to synchronize the date and time on the 
added controller.

   Note:   Although date and time settings can be made on each AE-50/EW-50, the date and time synchronization from AE-200 is 
performed once a day. Make the date and time settings on the AE-50/EW-50 only after the AE-50/EW-50 is replaced.

(1) Enter the current date and time.

(2) To adjust the daylight saving time automatically, check the [Automatically adjust clock for daylight saving 
changes] checkbox, and select the applicable country in the pulldown menu.

If the applicable country is not in the pulldown menu, select [Custom Settings] instead. A [Custom Settings] 
button will appear on the right of the pulldown menu.
Click the [Custom Settings] button to open the Custom Settings screen, and configure the daylight saving 
time setting.

Daylight saving time 
setting

Click to enable the daylight 
saving time setting.

Refresh
Click to acquire the current 

date and time from the 
AE-200/AE-50/EW-50.

Current date and time
Enter the current date and 
time.

Save Settings
Click to save the changes 
made.

Custom Settings screen
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4-3. IP address settings
Set AE-200/AE-50/EW-50 IP addresses, and configure the expansion controller connection settings on the AE-200’s 
LCD.

For an AE-200 system, set using the following procedure.

 
Set the IP address of AE-50 on the LCD or the Web Browser 
for Initial Settings, and set the IP address of EW-50 on the 
Web Browser for Initial Settings.
(See section 4-3-1 “Setting IP addresses of AE-50/EW-50”.)

Set whether or not to use an AE-200 M-NET on the AE-200’s 
LCD.
(See section 4-3-2 “Setting IP addresses of AE-200”.)

Set whether or not to use an expansion controller on the 
AE-200’s LCD.
(See section 4-3-2 “Setting IP addresses of AE-200”.)

Set the IP addresses of AE-200 on the AE-200’s LCD or the 
Web Browser for Initial Settings.
(See section 4-3-2 “Setting IP addresses of AE-200”.)

Set the connecting IP addresses of expansion controllers on 
the AE-200’s LCD.
(See section 4-3-2 “Setting IP addresses of AE-200”.)

For an EW-50 system, set using the following procedure.

Set the IP addresses of EW-50 on the EW-50’s Web Browser 
for Initial Settings.
(See section 4-3-1 “Setting IP addresses of AE-50/EW-50”.)

Expansion controller 
connected

IP address setting of AE-50/EW-50

M-NET setting

Expansion controller setting

IP address setting of AE-200

Destination IP address setting of  
expansion controller

Completed

No expansion controller 
connected

Expansion controller 
connected

No expansion controller 
connected

IP address setting of EW-50

Completed
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[1]  Settings for connecting the AE-200/AE-50/EW-50 to a dedicated LAN
(1) Enter the AE-200, AE-50, or EW-50’s IP address in the [IP Address] field. If the LAN has been newly set up, 

allocate IP addresses to the AE-200 units in a sequential order starting with [192.168.1.1]. For example, the 
first AE-200 unit will have an IP address of [192.168.1.1], the second AE-200 unit will have an IP address of 
[192.168.1.2] and so on.
Allocate IP addresses to the AE-50/EW-50 units in a sequential order starting with [192.168.1.211].
   Note:  The recommended IP address ranges are as follows. 

AE-200:  Between [192.168.1.1] and [192.168.1.40] 
AE-50/EW-50:  Between [192.168.1.211] and [192.168.1.249] 
PC:  Between [192.168.1.101] and [192.168.1.150]

[IP address setting example]

192.168.1.101 192.168.1.1 192.168.1.211 192.168.1.212 

AE-200 AE-50 AE-50

   Note:  Some hubs have dedicated ports for connection with another hub. 
Connect the AE-200/AE-50/EW-50 and PC to the normal ports.

(2) Enter [255.255.255.0] in the [Subnet Mask] field (unless otherwise specified).

(3) When monitoring the system remotely or using e-mail function via a dial-up router, enter the router IP 
address in the [Gateway] field.
Leave the [Gateway] field blank when not connecting a dial-up router.

[Remote Monitoring System example]

AE-200

   Note:  [192.168.1.254] is recommended for use as the IP address of the dial-up router. Refer to the dial-up router 
instruction manual for details of how to set the IP address.

   Note:  The use of a dial-up router with no modem requires a modem (for analog or ISDN) to be connected between the 
router and the public phone line.

100 BASE-TX LAN straight cable
Hub

PC

Dial-up router
IP Address: 192.168.1.254

Telecommunication Network

IP Address: 192.168.1.1
Subnet Mask: 255.255.255.0
Gateway: 192.168.1.254

IP Address: 192.168.1.101
Subnet Mask: 255.255.255.0
Gateway: Blank

PC

Dial-up router, cellular phone etc.

PC
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[2]  Settings for connecting the AE-200/AE-50/EW-50 to an existing LAN
(1) When connecting the AE-200/AE-50/EW-50 to an existing LAN, consult the system administrator to decide 

the IP, subnet mask, and gateway addresses.

[Existing LAN System example]

10.1.1.250 10.1.2.250 

AE-200

Gateway

Obtain the addresses from 
the system administrator.

IP Address: 10.1.1.1
Subnet Mask: 255.255.255.0
Gateway: 10.1.1.250

Backbone LAN

IP Address: 10.1.1.101
Subnet Mask: 255.255.255.0
Gateway: 10.1.1.250

PC

Obtain the addresses from 
the system administrator.

Gateway

IP Address: 10.1.2.51
Subnet Mask: 255.255.255.0
Gateway: 10.1.2.250

PC
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4-3-1. Setting IP addresses of AE-50/EW-50
Set the AE-50/EW-50 IP addresses. Settings screens will differ depending on the unit model.

AE-50: AE-50’s LCD or AE-50’s Web Browser for Initial Settings
EW-50: EW-50’s Web Browser for Initial Settings

 Note:  Set IP address for “LAN1.”
 Note:  “LAN2” is exclusively used for BACnet® function. To use the BACnet® function, configure the BACnet® settings on the BACnet® 

Setting Tool. Refer to the Instruction Book (BACnet® function) for the BACnet® function settings.

[1]  When setting on the AE-50’s LCD
(1) After the power is turned on to the AE-50, a language selection 

screen will appear.
Select the language to be used for display, and then touch [OK].
 Note:  It will take approximately one minute for the display to appear 

after the power is turned on.
 Note:  Once the initial settings have been made, [Monitor/Operation] 

screen will appear after the power is turned on.

(2) The [Date and time] screen will appear.

(3) Touch the right triangle button to display the [Network] tab, and 
touch it.
Referring to section 5-1-5 “Network”, set the AE-50’s IP 
address, and then touch [Save Settings].
The AE-50 will reboot.
 Note:  When multiple AE-50 controllers are connected, set the IP 

addresses on all AE-50.
 Note:  The AE-200 and AE-50’s IP addresses must have the same 

network address. 
<Reference: Default IP address>

AE-200 192.168.1.1

AE-50 192.168.1.211
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[2]  When setting on the AE-200/AE-50’s Web Browser for Initial Settings
Click [Initial Settings] in the menu bar, and then click [Basic System] to access the Basic System settings screen.

   Note:  The Basic System settings may not be accessible if logged in as a building manager.

   Note:  Although the settings for LAN1 (Network Settings) and LAN2 (Network Settings 2) will appear on the screen, only the 
settings for LAN1 is required. However, only when the LAN1 IP address is required to be set to [192.168.2.1], change the 
default LAN2 IP address to avoid address overlap.

   Note:  After the AE-200 IP address is changed, the AE-50/EW-50 power will be reset.
   Note:  After the AE-200 IP address is changed, the AE-50/EW-50 power will be reset.

Save Settings
Click to save the changes 
made.

LAN1

LAN2
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4-3-2. Setting IP addresses of AE-200
Set the AE-200 IP address and the expansion controller connection.

[1]  AE-200 initial start-up for a system without connection to an AE-50/EW-50 controller
(1) After the power is turned on, a language selection screen will 

appear.
Select the language to be used for display, and then touch [OK].
 Note:  It will take approximately one minute for the display to appear 

after the power is turned on.
 Note:  Do not touch the LCD before any settings screen appears.
 Note:  Once the initial settings have been made, [Monitor/Operation] 

screen will appear after the power is turned on.

(2) Touch the [Unit Info.] and [Unit Info. 2] tabs.
Referring to section 5-1-4 “Unit Information”, make necessary 
basic settings, and then touch [Save Settings].
 Note:  Make sure to set the [System Exp] setting for the AE-200 to [Do 

not expand].
 Note:  Make sure to set the [AE-200 M-NET] setting to [Use].

Unit Info.

Unit Info. 2

[2]  AE-200 initial start-up for a system with connection to one or more AE-50/EW-50 controllers
(1) After the power is turned on to the AE-200, a language 

selection screen will appear.
Select the language to be used for display, and then touch [OK].
 Note:  It will take approximately one minute for the display to appear 

after the power is turned on.
 Note:  Do not touch the LCD before any settings screen appears.
 Note:  Once the initial settings have been made, [Monitor/Operation] 

screen will appear after the power is turned on.
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(2) Touch the [Unit Info.] and [Unit Info. 2] tabs.
Referring to section 5-1-4 “Unit Information”, make necessary 
basic settings, and then touch [Save Settings].
 Note:  Make sure to set the [System Exp] setting for the AE-200 to 

[Expand].
 Note:  The [AE-200 Apportion] setting will appear only when the 

“Charge” license has been registered.

Unit Info.

Unit Info. 2

(3) Touch the right triangle button to display the [Network] tab, and 
touch it.
Referring to section 5-1-5 “Network”, make sure that [AE200] 
is selected as [Controller], set the AE-200’s IP address and 
subnet mask, and then touch [Save Settings].
The AE-200 will reboot.
When the reboot process is complete, log in to the Initial 
Settings menu.
 Note:  Refer to section 5-1-1 “Logging in to the Initial Settings menu” 

for how to log in.
 Note:  Do not touch the LCD during the reboot.

(4) In the [Controller] section, select [1], [2], [3], or [4] to make 
settings for each AE-50/EW-50.
Referring to section 5-1-5 “Network”, set the IP address of 
each AE-50/EW-50 that is connected to the AE-200, and 
M-NET address, and then touch [Save Settings].
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4-4. Software Update
Update AE-200/AE-50/EW-50 software. Prepare the update file so that all versions are standardized, without 
needing to load a previous software version.
The AE-200/AE-50/EW-50 software can be updated by either directly reading the update file in a USB memory 
device or by using a Web browser. 

①   Directly reading the update file in a USB 
memory device

② Using a Web browser

AE-200/AE-50 AE-200/AE-50/EW-50

Update the AE-200/AE-50 software by either “Directly reading the update file in a USB memory device (① )” or “Using 
a Web browser (② ),” and the EW-50 by “Using a Web browser (② ).” 

Caution:
Obtain an approval from the client for the following precautions as necessary.

1. The communication between AE-200/AE-50/EW-50 and the air conditioning units will stop while 
the software is being updated. Although the unit in operation may detect a communication error 
and an error sign may appear on the local remote controllers, the unit will continue its operation 
and be operable from the local remote controllers.
 * Note that Mr. Slim indoor units or systems with no local remote controllers may detect a communication error and come 
to an abnormal stop.

2. Record the operation status of the air conditioning units immediately before updating the 
software. After the software update completes, check the operation status of the units, and 
manually operate the units as necessary.

3. Some operations and functions, such as scheduled operations, billing function, Peak Cut control, 
energy management function, will be disabled while the software is being updated. Check the 
setting details of these functions beforehand, and update the software when it does not affect 
these functions.

4. If the functions in the table below are used on the TG-2000A, avoid updating the software during 
the time period indicated in the right column.

TG-2000A function in use Time period in which the update is prohibited
Electricity charge apportioning function AM 4:05 – 4:35
Malfunction log backup AM 0:05 – 0:15
Peak Cut data backup AM 2:00 – 2:10
Measurement trend data backup AM 1:05 – 1:15

5. CSV output data (e.g., energy management data) will lose up to 60-minute worth of data.
6. When a built-in Pulse Input (PI) is used, pulse signals cannot be input while the software is being 

updated.

USB

USB

CD

PC for update

HUB

LAN
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4-4-1. Directly reading the update file in USB memory device
[1]  Preparation
Store the update file (AExx_FW####_****.dat)*1 in the root folder of a USB memory device.
*1 “xx”: “200” (AE-200) or “50” (AE-50); “####_****”: software version  

(For example, if the update file name is “AE200_FW0730_0105.dat”, the AE-200 software version is 7.30.)

[2]  Update procedures
   Note:  The software cannot be downgraded to an earlier version.

(1) Remove the controller cover, and insert a USB memory device in which the update file is stored to the USB 
port.
 Note:  Do not remove the USB memory device while the software is being updated.
 Note:  The USB memory device may not be recognized if you insert and remove it within a short time. If this happens, reset 

the AE-200/AE-50.

(2) Touch [  ] to display the login window.

(3) Enter the maintenance user name and the password in the login 
window, and touch [Login]. (Default user name: initial, Default 
password: init)

(4) Touch [Maintenance] in the menu bar, and then touch [Update].
Touch [Software Update] to read the update file.

(5) Touch [OK]. A software update process starts.
 Note:  It takes about four minutes to complete the update.
 Note:  The Status LED will blink in blue while the software is being updated.
 Note:  Do not turn off the power to the AE-200/AE-50 while the software is 

being updated.
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(6) The AE-200/AE-50 will reboot after the update is complete.
Disconnect the USB memory device.

(7) Touch [  ] to display the login window.
Check that the version on the login window is the same as the version 
of the update file (AExx_FW####_****.dat).
(For example, if the update file name is “AE200_FW0730_0105.dat”, 
the AE-200 software version is 7.30.)

[3]  Software information
Detailed information about the open source software of the AE-200/AE-50/EW-50 can be checked by accessing the 
following address:
https://[IP address of each AE-200, AE-50, or EW-50]/license/

 * Accessible only if logged in as a maintenance user.
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4-4-2. Using a Web browser
[1]  Preparation
Follow the instructions below to change the IP address of the PC that is used for software update.

   Note:  When the system is connected to the existing LAN, ask the system administrator for permission before changing the IP 
address settings and updating the software.

(1) Click [Control Panel] in the Start menu, and click [Network and Sharing 
Center]>[Local Area Setting].  
In the [Local Area Connection Status] window, click [Properties].

(2) Click [Internet Protocol Version 4 (TCP/IPv4)] to select it, and click 
[Properties].

(3) In the [Internet Protocol Version 4 (TCP/IPv4) Properties] window, 
check the radio button next to [Use the following IP address].
Enter [192.168.1.*] in the [IP address] field. (The number indicated 
with an asterisk must be different from the IP address of the 
AE-200/AE-50/EW-50 to be updated.)
Leave [255.255.255.0] in the [Subnet mask] field as it is.
 Note:   If the IP address of the AE-200/AE-50/EW-50 is [192.168.1.1], set the 

same 1st, 2nd, and 3rd numbers and different 4th number, such as 
[192.168.1.2].

 Note:   Default IP address of AE-200, AE-50, and EW-50 is [192.168.1.1].
 Note:   When performing an update on a PC that is already connected to the 

existing LAN, [255.255.255.0] may not appear in the [Subnet mask] 
field. When [255.255.0.0] appears, enter the same 1st and 2nd numbers 
(192.168) and different 3rd or 4th number of the IP address of the 
AE-200/AE-50/EW-50 in the [IP address] field.
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[2]  Update procedures
(1) Make sure that the PC that has been set in [1] above and the AE-200/AE-50/EW-50 to be updated are 

connected with a LAN cable.

(2) Turn on the power to the AE-200/AE-50/EW-50, and insert a CD or USB memory device in which the update 
file is stored to the PC.

(3) Enter the web page address in the address field of the Web browser as follows:
https://[IP address of each AE-200, AE-50, or EW-50]/swupdate/Update.html
Press the [Enter] key. 
 Note:  If the IP address of the AE-200/AE-50/EW-50 is [192.168.1.1], the web page address is [https: //192.168.1.1/

swupdate/Update.html].

(4) If the security certificate is invalid, a security certificate error page (as 
shown at right) will appear.
Click [Continue to this website (not recommended)].

(5) Enter the maintenance user name and the password in the login 
screen, and click [OK]. (Default user name: initial, Default password: 
init)

(6) A software update screen will appear.

(7) Click the [Browse...] button and select the update file (AExx_
FW####_****.dat) stored in the CD or USB memory device, and click 
[Start Update].
 Note:  The software cannot be downgraded to an earlier version.
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(8) A software update process starts.
 Note:  It takes about ten minutes to complete the update.
 Note:  Do not disconnect the LAN cable or turn off the power to the 

AE-200/AE-50/EW-50 while the software is being updated.

(9) The AE-200/AE-50/EW-50 will reboot after the update is complete.
Check that the version that will appear on the screen is the same as 
the version of the update file. Also check that the version displayed on 
the login window of the AE-200/AE-50’s LCD is also the same.

If the software update did not properly complete, update the software again. If the problem persists, 
the AE-200/AE-50/EW-50 may be damaged. Consult your dealer.
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4-5. License registration for optional functions
There are two ways to register the license — from the AE-200’s LCD, and individually from the AE-200/AE-50/ 
EW-50 Web Browser for Initial Settings.

Please contact your dealer as regards optional functions and purchasing license numbers.
   Note:   After the “Integrated Centralized Control Web” license is registered, licenses can be registered on the Integrated Centralized 

Control Web. For details, refer to [Settings] – [Initial settings] – [License Registration] in the Instruction Book (Integrated 
Centralized Control Web).

[1]  When registering a license on the AE-200’s LCD
Touch [Initial Settings] in the menu bar, and then touch [License].

   Note:   The current date and time settings are required for license registration. Refer to section 5-1-3 “Date and time” for date and 
time settings.

   Note:   The license registration is required for each AE-200/AE-50/EW-50.
   Note:   The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set 

to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to register licenses for each AE-200, 
AE-50, and EW-50 individually.

Important
 ● When one or more AE-50/EW-50 controllers are connected, licenses for the AE-50/EW-50 must be registered with the 
AE-50/EW-50 properly connected to ensure proper settings.

(1) In the [Selecting Optional Function] section, select the optional function to be registered. The current 
availability will appear in the [Current Status] section.

(2) In the “License number entry field” button, enter the license number and touch [Register the license].
In the [Current Status] section, a word [Available] will appear.
If the registration is unsuccessful, verify that the selected optional function and the license number are correct.
 Note:  Alphabet “O” and “I” are not used for license number.

Controller
Select [AE] to register 

licenses for AE-200, and 
select [1], [2], [3], or [4] to 
register licenses for each 

AE-50/EW-50. 

Selecting Optional 
Function

Select the optional function 
to be registered.

Current status
This indicates whether the 

optional function is available 
for use.

Serial No.

License number entry field

Register the license
Touch to register the license.
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[2]  When registering a license on the AE-200/AE-50/EW-50’s Web Browser for Initial Settings
   Note:  The current date and time settings are required for license registration. Refer to section 7-1-1 “Date and Time” for date and 

time settings.
   Note:   The license registration is required for each AE-200/AE-50/EW-50.

(1) On the login screen, click [Registration of Optional Functions]. 

The [Registration of Optional Functions] screen will appear.

(2) In the [Selecting Optional Function] section, select the optional 
function to be registered. The current availability will appear in 
the [Current Status] section.

(3) In the [License number entry] field, enter the license number 
and click [Register the license].
In the [Current Status] section, a word “Available” will appear. 
If the registration is unsuccessful, verify that the selected 
optional function and the license number are correct.
 Note:  Alphabet “O” and “I” are not used for license number.

Registration of Optional Functions

Selecting Optional 
Function

Select the optional function 
to be registered.

Current Status
This indicates whether the 

optional function is available 
for use.

Software version

Login Page
Click to return to the login 
screen.

License number entry field

Register the license
Click to register the license.
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5. Settings on the LCD
5-1. Initial Settings
5-1-1. Logging in to the Initial Settings menu

(1) Touch [  ] to display the login window.

(2) Enter the user name and the password on the keyboard 
screen (See [1] “Keyboard screen”), and touch [Login].
[Initial Settings] menu screen will appear.
The table below shows the default user names, 
passwords, and functions that are available for 
maintenance users and building managers.

User Default  
user name

Default 
password Available functions

Maintenance user initial init All functions

Building manager administrator admin The items to which access rights have been given on the [User 
Info] screen are available.

*1 A maintenance user can specify the functions to be made available for building managers. Refer to section 5-5 “User Information” for 
details.

*2 It is recommended to change the default user name and password so that the users other than the maintenance users and building 
managers will not be able to change the settings.
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[1]  Keyboard screen

5-1-2. Locking the screen
Locking the screen prevents unauthorized users from accessing.

(1) To activate the screen lock function, set the [Screen 
lock] setting to [Use] on the [Unit Info.] screen under the 
[Initial Settings] menu.
If the screen lock function is activated, the screen locks 
when the backlight turns off (after three minutes of not 
touching the screen).
 Note:  The default setting is [Do not use].
 Note:  The screen lock function will not be activated when any 

screen under the [Initial Settings] menu is open.

(2) Touch [  ] on the login screen to lock the screen 
immediately.
To unlock the screen, enter the same user name and 
password used to log in.

The entered characters will 
appear here.

Touch to display the 
keyboard for entering capital 

alphabetic characters.

Touch to display the 
keyboard for entering lower-
case alphabetic characters.

Touch to display the keyboard for 
entering numeric characters and 
symbols.

Arrow
Touch to move the cursor.

Delete
Touch to delete one 
character to the left of the 
cursor.

Cancel
Touch to undo the changes 
made and return to the 
previous screen.

OK
Touch to save the entered 
characters and return to the 
previous screen.
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5-1-3. Date and time
Touch [Initial Settings] in the menu bar, and then touch [Date and time].
Set the current date and time, and then touch [Save Settings].

   Note:   The date and time settings may not be accessible if logged in as a building manager.
   Note:   The date and time settings made on this screen will be reflected on all the units in the M-NET system, all connected 

AE-50/EW-50 units, and the AE-200 units whose [Time Master/Sub] setting is set to [Sub].
   Note:   The date and time cannot be set on this screen if the [Time Master/Sub] setting is set to [Sub].
   Note:   The daylight saving time setting is required only on the AE-200.
   Note:   The date and time settings made on the AE-50/EW-50 unit whose [Time Master/Sub] setting is set to [Sub] will not be sent to 

the other AE-50/EW-50 units.
   Note:   If the current time is moved forward while the scheduled operation is performed, the operation that was scheduled to take 

place during the time that was skipped will not be performed.
   Note:   Changing the date and/or time when the charging function is in use can affect the calculation of the charges.
   Note:  If the system is connected to a TG-2000A, make or change the settings from the TG-2000A.
   Note:   When AE-50/EW-50 controller, DIDO controller (PAC-YG66DCA), AI controller (PAC-YG63MCA), or PI controller (PAC-

YG60MCA) is added to the system, set the current date and time on this screen to synchronize the date and time on the 
added controller.

   Note:   Although date and time settings can be made on each AE-50/EW-50, the date and time synchronization from AE-200 is 
performed once a day. Make the date and time settings on the AE-50/EW-50 only after the AE-50/EW-50 is replaced.

Important
 ● When one or more AE-50/EW-50 controllers are connected, the date and time settings must be made with the AE-50/EW-50 
properly connected to ensure proper settings.

(1) Set the current date and time.

(2) To automatically adjust the daylight saving time, touch the “Daylight saving time” button. Touch the applicable 
country, and then touch [OK].
 Note:  When not using the daylight saving time function, touch “----.”
 Note:  If the applicable country is not found, touch [Custom settings] at the bottom, and touch [OK]. Then, touch [Edit] to open 

the screen below, and manually configure the daylight saving time setting.

Current date and time
Set the current date and 

time.

Daylight saving time
Touch to set the country 

to automatically adjust the 
daylight saving time.

Edit
Touch to manually configure 
the daylight saving time 
setting.

Save Settings
Touch to save the changes 
made.
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Note
 ● Message that will appear when the date and time have been reset 
If the power supply is cut off for a long time due to power failure or other reasons, the date and time will be reset, and the 
following popup message will appear when the power is turned on next. If this message appears, set the date and time 
again.

 * This message will appear periodically until the date and time setting is made.
 * If the controller is used without the date and time being set, the Schedule function or the Night Setback Control will not work properly.
 * If the [Time Master/Sub] setting for the given controller is set to [Sub], temporarily change the setting to [Master], set the current date and 
time, and then set the setting back to [Sub].
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5-1-4. Unit Information
Touch [Initial Settings] in the menu bar, and then touch [Unit Info.] or [Unit Info. 2].
Make necessary basic system settings such as unit settings, display format, sound/brightness settings, use or non-
use of test run, and display or non-display of room temperature/humidity, and then touch [Save Settings].

   Note:   The Unit Information settings may not be accessible if logged in as a building manager.

Unit Info.

Unit Info. 2

[1]  Unit Information
Follow the instructions below to set the unit name, unit ID, and System Expansion setting.

(1) Touch the [Name] button to display the keyboard. Enter the unit name in 40 alphanumeric or symbol characters 
or less. The name entered here will be used on the screen of the software that controls multiple AE-200 units 
and will also be used as a sender name in the error notification e-mail and e-mail alarm.
 Note:  The following characters cannot be used:  <, >, &, “, or ‘

Unit Information
Set the unit name and unit 

ID.

Sound and brightness
Set the sound and 
brightness levels.

Display Format
Set the screen display items.

Save Settings
Touch to save the changes 
made.

Air-conditioner Settings
Set the test run setting 

and display option of room 
temperature/humidity.

Save Settings
Touch to save the changes 
made.
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(2) Touch the [Unit ID] button to display the keyboard. Enter the unit ID in 6 figures. Use this setting to manage 
the multiple unit IDs. The unit ID entered here will be used on the screen of the software that controls multiple 
AE-200 units and will also be used as a sender ID in the error notification e-mail and e-mail alarm.

(3) When connecting one or more AE-50/EW-50 controllers, set the [System Exp] setting to [Expand].
 Note:  The [System Exp] section does not appear on this screen on the AE-50.
 Note:  When the [System Exp] setting is set to [Expand], make sure to make network settings for the AE-50/EW-50 controllers 

on the [Network] screen. (Refer to section 5-1-5 “Network” for details.)  
Set the EW-50’s IP address on the Web Browser for Initial Settings. (Refer to section 4-3-1 “Setting IP addresses of 
AE-50/EW-50” for details.)

(4) When using an AE-200 apportioned electricity billing function or when not using an AE-200 M-NET, set the 
[AE-200 M-NET] setting to [Do not use].
 Note:  When [Do not use] is selected, up to four AE-50/EW-50 controllers can be connected.
 Note:  The [AE-200 M-NET] section does not appear on this screen on the AE-50.
 Note:  The [AE-200 Apportion] section appears when “Charge” license is registered. To use an electricity charge apportioning 

function of TG-2000A, set the [AE-200 Apportion] setting to [Do not use].

[2]  Sound and brightness
(1) In the [Sound] section, select the volume (Level 0–3) of the buzzer that sounds when the screen is touched.

(Level 0: No sound)
 Note:  Although the change will be reflected right away, it will not be saved until [Save Settings] is touched.

(2) In the [Brightness] section, select the brightness (70%, 80%, 90%, 100%) of the screen. (The greater the 
value, the brighter the brightness.)
 Note:  Although the change will be reflected right away, it will not be saved until [Save Settings] is touched.

[3]  Display Format
(1) In the [Date] section, select the desired display format for year, month, and date.

(2) In the [Time] section, select the desired display of time format.

(3) In the [Temperature] section, select the desired temperature unit [ºC] or [ºF].

(4) In the [Language] section, select the desired display language.

(5) In the [Pressure unit] section, select [MPa], [PSI], or [kgf/cm2].

(6) In the [Screen lock] section, select [Use] or [Do not use]. Select [Use] to activate the screen lock function. (Refer 
to section 5-1-2 “Locking the screen” for details.)

(7) In the [Occupancy] section, make the Show/Hide setting for the occupancy/vacancy status that is detected 
by the built-in occupancy sensor on the ME remote controller (North America: PAR-U01MEDU, Europe: PAR-
U02MEDA).
Select [Hide] not to display the occupancy/vacancy status on the [Floor] or [Block] display.
Select [  ] (blue) to display the occupancy icon when the sensor on the remote controller detects occupancy.
Select [  ] (gray) to display the vacancy icon when the sensor on the remote controller detects vacancy.
Select [  ] (blue/gray) to display the occupancy or vacancy icon according to the occupancy status of 
the room.
 Note:  If the ME remote controller has no built-in occupancy sensor, the occupancy/vacancy icons will not be displayed on the 

[Floor] or [Block] display.
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(8) In the [Brightness] section, make the Show/Hide setting for the brightness/darkness status that is detected 
by the built-in brightness sensor on the ME remote controller (North America: PAR-U01MEDU, Europe: PAR-
U02MEDA).
Select [Hide] not to display the brightness/darkness icons on the [Floor] or [Block] display.
Select [  ] (yellow) to display the brightness icon when the brightness level in the room reaches the 
predetermined brightness level.
Select [  ] (gray) to display the darkness icon when the darkness level in the room reaches the 
predetermined darkness level.
Select [  ] (yellow/gray) to display the brightness or darkness icon according to the brightness/
darkness level of the room.
 Note:  If the ME remote controller has no built-in brightness sensor, the brightness/darkness icons will not be displayed on the 

[Floor] or [Block] display.
 Note:  The brightness/darkness detection thresholds are set on the ME remote controller (North America:  PAR-U01MEDU, 

Europe:  PAR-U02MEDA)

[4]  Air-conditioner Settings
(1) In the [Test run] section, select [Use] or [Do not use]. Select [Use] when performing a test run from the 

operation settings screen, or when editing the electricity meter reading value on the [Measurement] display.

Editing measurement values

1. Touch the “Measurement value edit” button to open the screen below.
   Note:  The “Measurement value edit” button will appear only when the [Test run] setting is set to [Use].

2. Touch the “Edit the adjusted measurement value” button. Enter the current electricity meter reading value, 
and then touch [OK].

   Note:  Set the setting back to [Do not use] after completing a test run.
   Note:  The setting will go back to [Do not use] when the time on the AE-200/AE-50 reaches 0: 00 in the morning.
   Note:  Only the electric energy values on the [Measurement] display will change. This setting will not affect the energy-

control-related screens.
   Note:  To reset the adjusted measurement value to the original cumulative value, touch the “Edit the offset value” button 

and set to “0”.

Measurement value edit

Edit the adjusted 
measurement value

Edit the offset value
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(2) In the [Room temperature] section, select the desired temperature display option to be used on the [Floor] or 
[Block] display.
Select [Always show] to display the temperature at all times, [Show during operation] to display the 
temperature only during operation, and [Hide] not to display the temperature.
 Note:  This setting is effective only on the LCD and will not be reflected to the Web browser.
 Note:  Selecting [Show during operation] is recommended because the temperature shown may be higher than the actual 

temperature especially when the unit is stopped during the Heat mode.

(3) In the [Humidity] section, make the Show/Hide setting for the humidity reading of the built-in humidity sensor 
on the ME remote controller (North America: PAR-U01MEDU, Europe: PAR-U02MEDA).
Select [ON] to display the humidity reading on the [Floor] or [Block] display.
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5-1-5. Network
Touch [Initial Settings] in the menu bar, and then touch [Network].
Make necessary basic system settings such as LAN settings, M-NET settings, and external input settings for each 
AE-200, AE-50, and EW-50, and then touch [Save Settings]. A message will appear asking whether or not to restart 
the controller. Touch [OK] to restart the AE-200/AE-50 to reflect the changes.

   Note:   The Network settings may not be accessible if logged in as a building manager.
   Note:   The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set 

to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200, 
AE-50, and EW-50 individually.

Important
 ● Network settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to ensure proper settings. 
Those settings made without the connection of AE-50/EW-50 will not be reflected.

1st page

2nd page

*1 BACnet® is a registered trademark of ASHRAE (American Society of Heating, Refrigerating and Air-Conditioning Engineers, INC.).

Controller
Select [AE] to make 

settings for AE-200, and 
select [1], [2], [3], or [4] 

to make settings for each 
AE-50/EW-50. 

LAN1 Settings
Set the IP address, subnet 

mask, and gateway address.

Touch to go to the next 
page.

M-NET Settings
Set the M-NET address 
and range of prohibited 
controllers.

External Input Setting
Set the external signal input 
mode.

Save Settings
Touch to save the changes 
made.

Touch to go to the previous 
page.

LAN2 Settings
Exclusively used for 

BACnet® function *1.
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[1]  LAN1 Settings
LAN1 settings vary depending on whether the AE-200/AE-50 is connected to a dedicated LAN or an existing LAN.
See the sections below for how to set the AE-200/AE-50 IP addresses, subnet mask, and gateway addresses.
Although the settings for LAN1 and LAN2 will appear on the screen, only the settings for LAN1 is required if the 
BACnet® function is not used. Before making the settings, make sure that the LAN is connected to LAN1 port.

(1) LAN1 settings for connecting the AE-200/AE-50/EW-50 to a dedicated LAN

Settings for an AE-200
   Note:  See the procedures below when making LAN1 settings on the AE-50.

(1) Make sure that [AE200] is selected in the [Controller] section.

(2) Enter the AE-200’s IP address in the [IP Address] field. If the LAN has been newly set up, allocate IP 
addresses to the AE-200 units in a sequential order starting with [192.168.1.1]. For example, the first 
AE-200 unit will have an IP address of [192.168.1.1], the second AE-200 unit will have an IP address of 
[192.168.1.2] and so on. (The same IP addresses cannot be used.)
Allocate IP addresses to the AE-50/EW-50 units in a sequential order starting with [192.168.1.211].
   Note:  The recommended IP address ranges are as follows. 

AE-200:  Between [192.168.1.1] and [192.168.1.40] 
AE-50/EW-50:  Between [192.168.1.211] and [192.168.1.249] 
PC:  Between [192.168.1.101] and [192.168.1.150]

   Note:  After the AE-200 IP address is changed, the AE-50/EW-50 power will be reset.

(3) Enter [255.255.255.0] in the [Subnet Mask] field (only when the IP address is [192.168.1.*]).
 Note:  If [255.255.255.0] is entered, set the IP addresses of all AE-50 units to [192.168.1.*].

(4) When monitoring the system remotely or using e-mail function via a dial-up router, enter the router IP 
address in the [Gateway] field.
Leave the [Gateway] field blank when not connecting a dial-up router.
[192.168.1.254] is recommended for use as the IP address of the dial-up router. Refer to the dial-up router 
instruction manual for details of how to set the IP address.
 Note:  [192.168.1.254] is recommended for use as the IP address of the dial-up router. Refer to the dial-up router 

instruction manual for details of how to set the IP address.
 Note:  The use of a dial-up router with no modem requires a modem (for analog or ISDN) to be connected between the 

router and the public phone line.

Settings for when connecting one or more AE-50/EW-50 controllers

(1) Select [1], [2], [3], or [4] in the [Controller] section to make settings for each AE-50/EW-50.

(2) Enter the IP address of the AE-50/EW-50 that is connected to the AE-200 in the [Dstn IP address] field.
A message that indicates that the connection information of the AE-50/EW-50 is being collected will appear 
for a few minutes.
 Note:  AE-50/EW-50 will not operate properly and the AE-50/EW-50 software version will not appear if the entered address 

does not match the ones that have been set on the AE-50/EW-50.
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(2) LAN1 settings for connecting the AE-200/AE-50 to an existing LAN

(1) When connecting the AE-200/AE-50 to an existing LAN, consult the system administrator to decide the IP 
addresses, subnet mask, and gateway addresses.

(3) LAN2 settings for connecting the AE-200/AE-50 to a dedicated LAN

(1) Do not use the LAN2 port.
 Note:  Change the LAN2 IP address only when the LAN1 IP address is required to be set to [192.168.2.1].

(4) LAN2 settings for connecting the AE-200/AE-50 to an existing LAN

(1) Do not use the LAN2 port.
 Note:  Change the LAN2 IP address only when the LAN1 IP address is required to be set to [192.168.2.1].

[2]  LAN2 Settings
LAN2 port is exclusively used for BACnet® function.
For how to make BACnet® function settings, refer to the Instruction Book (BACnet® function).

   Note:  An IP address set using LAN1 should not be used as a LAN2 IP address.

[3]  M-NET Settings
   Note:  Make the M-NET settings only on the AE-200.

(1) Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200, 
AE-50, and EW-50 individually.

(2) Enter [0] in the [M-NET Address] field (unless otherwise specified).

(3) Select [SC/RC] to prohibit the operation from both the sub system controllers and the remote controllers. 
Select [RC Only] to prohibit the operation only from the remote controllers.

[4]  External Input Setting
Using the external signal input function, the following types of collective operations can be performed for all 
connected air conditioning units: Demand level, Emergency stop, ON/OFF operation, and Prohibit/Permit local 
remote controller operation.
A separately-sold external input/output adapter (PAC-YG10HA-E) is required.

   Note:  Make the M-NET settings only on the AE-200.
   Note:  A separate license is required to activate the Peak Cut control using the external input function. Make sure that the required 

license has properly been registered on the [License] screen. (Refer to section 4-5 “License registration for optional 
functions” for details.)

(1) Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200, 
AE-50, and EW-50 individually.

(2) Select [Demand (Level signal)/Not in use], [Emergency Stop (Level signal)], [ON/OFF (Level signal)], or [ON/
OFF/Prohibit/Permit (Pulse signal)]. Refer to the Installation Manual for details.
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Only when an AE-50/EW-50 is connected
By using a communication error detection function, communication errors between AE-200/AE-50/EW-50 can be 
displayed on the AE-50’s LCD via AE-200.

Touch to go to the previous 
page.

Detect communication 
error
Select whether “Detect” 
or “Do not detect” 
communication error for 
each IP address.

Save Settings
Touch to save the changes 
made.

IP address of AE-200
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5-1-6. Groups
Touch [Initial Settings] in the menu bar, and then touch [Groups].
Register the groups of air conditioning units, LOSSNAY units (ventilators), Air To Water (PWFY) units, AHC, HWHP 
(CAHV, CRHV) units, or general equipment to be connected to the AE-200/AE-50/EW-50, and then touch [Save 
Settings].

   Note:  Some settings may not be accessible if logged in as a building manager.
   Note:  If the system is connected to a TG-2000A, make or change the settings from the TG-2000A.
   Note:  The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set 

to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200, 
AE-50, and EW-50 individually.

Important
 ● Group settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to ensure proper settings. 
Those settings made without the connection of AE-50/EW-50 will not be reflected.

 ● The units connected to AE-200 cannot be grouped together with the units connected to AE-50/EW-50.

[1]  Setting group names
(1) Touch the “Group name” button to display the keyboard. Enter the group name in 20 alphanumeric or symbol 

characters or less.
 Note:  The following characters cannot be used:  <, >, &, “, or ‘

Group No.

Group name

AHC registration

Remote controller 
registration

System controller 
registration

Save Settings
Touch to save the changes 
made.

Controller
Select [AE] to make 

settings for AE-200, and 
select [1], [2], [3], or [4] 

to make settings for each 
AE-50/EW-50. 

Unit selection



49WT07627X01

[2]  Registering air conditioners, Air To Water (PWFY) units, LOSSNAY units, or HWHP (CAHV, 
CRHV) units to a group

(1) To register air conditioners, Air To Water (PWFY) units, 
LOSSNAY units, and HWHP (CAHV, CRHV) units to each 
group, touch the “Unit selection” button under the target 
group name. A screen to select the units will appear.

Select the group type in the [Model] section, and select 
the address numbers of the units to be registered.
The selected unit addresses will appear with an orange 
frame. Touch again to deselect.

 Note:  Each group can contain up to 16 air conditioners.
 Note:  Air conditioners, Air To Water (PWFY) units, LOSSNAY 

units, and HWHP (CAHV, CRHV) units cannot be 
combined with general equipment in one group. To 
change the registered units to air conditioners, Air To 
Water (PWFY) units, LOSSNAY units, or HWHP (CAHV, 
CRHV) units in the group in which general equipment is 
registered, unregister the general equipment first.

 Note:  The addresses of the units that have been registered 
to other groups will appear with a gray background and 
cannot be selected.

(2) To change the unit icon to be used, touch the icon. A 
screen to select an icon will appear. Select an icon to be 
used, and touch [OK].

[3]  Registering remote controllers to a group
(1) To register remote controllers to a group, touch the 

“Remote controller registration” button under the target 
group name. A screen to select the units will appear.

Select the address numbers of the remote controllers to 
be registered.
The selected unit addresses will appear with an orange 
frame. Touch again to deselect.

 Note:  Each group can contain up to two remote controllers.
 Note:  Each group can contain up to four remote and system 

controllers combined.
 Note:  MA remote controllers do not need to be registered to a 

group.
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[4]  Registering system controllers to a group
(1) To register system controllers to a group, touch the 

“System controller registration” button under the target 
group name. A screen to select the units will appear.

Select the address numbers of the system controllers to 
be registered.
The selected unit addresses will appear with an orange 
frame. Touch again to deselect.

 Note:  Each group can contain up to four remote and system 
controllers combined.

[5]  Registering AHC to a group
(1) To register AHC to a group, touch the “AHC registration” 

button under the target group name. A screen to select the 
unit will appear.

Select the address number of the AHC to be registered.
The selected unit address will appear with an orange 
frame. Touch again to deselect.

 Note:  Each group can contain one AHC.
 Note:  AHC must be registered to a group in which air 

conditioners are registered. Do not register AHC to a 
group in which Air To Water (PWFY) units, LOSSNAY 
units, HWHP (CAHV, CRHV) units, or general equipment 
(via PAC-YG66DCA) are registered.
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[6]  Registering general equipment to a group
(1) To register general equipment to a group, touch the “Unit 

selection” button under the target group name. A screen to 
select the units will appear.

Select [General Equipment (via PAC-YG66DCA)] in the 
[Model] section, and select the unit address of the DIDO 
controller (PAC-YG66DCA) that is connected to the 
general equipment to be registered.

The selected number will appear with an yellow-green 
frame.

Then, select contact points to which the general equipment 
are connected, and touch the address assigned to another 
unit to register the first selected item to the group. The 
yellow-green frame will change to an orange frame. (The 
item with a yellow-green frame is the currently selected 
unit, and the ones with an orange frame are the units that 
are already registered to a group.)

Touch again to deselect.

 Note:  Each contact of DIDO controller counts as one unit.
 Note:  Each group can contain up to 16 general equipment.
 Note:  Up to six general equipment can be registered for each 

DIDO controller.
 Note:  Air conditioners, Air To Water (PWFY) units, LOSSNAY 

units, and HWHP (CAHV, CRHV) units cannot be 
combined with general equipment in one group. To 
change the registered units to general equipment in the 
group to which air conditioners, Air To Water (PWFY) 
units, LOSSNAY units, or HWHP (CAHV, CRHV) units are 
registered, unregister the air conditioners, Air To Water 
(PWFY) units, LOSSNAY units, or HWHP (CAHV, CRHV) 
units first.

 Note:  General equipment groups cannot include remote 
controllers or system controllers.

(2) To change the unit icon to be used, touch the icon under 
the [Icon] section. A screen to select an icon will appear. 
Select an icon to be used, and then touch [OK].

(3) In the [Allow Operations] section, make the setting to allow or disallow operation.
Select [In batch and on individual group] to allow the operator to turn on or off the general equipment 
collectively or by the groups.
Select [On individual group] to allow the operator to turn on or off the general equipment by the groups.
Select [No operations (Monitor only)] to disallow the operator to turn on or off the general equipment.

(4) In the [Monitor] section, select which status will be used to reflect the units’ ON/OFF status to the unit icons on 
the [Monitor/Operation] menu screen.
Select [Output status] to use the status that is sent to the general equipment, and [Input status] to use the 
status that is sent from the general equipment.
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5-1-7. Interlocked LOSSNAY
The ON/OFF status of the LOSSNAY unit can be interlocked with the operation of indoor units.
Touch [Initial Settings] in the menu bar, and then touch [Interlock]. Set the interlocking conditions for each AE-200, 
AE-50, and EW-50, and then touch [Save Settings].

   Note:  The Interlocked LOSSNAY settings may not be accessible if logged in as a building manager.
   Note:  If the system is connected to a TG-2000A, make or change the settings from the TG-2000A.
   Note:  The ON/OFF status of the indoor units are not interlocked with the ON/OFF status of the LOSSNAY unit.
   Note:  The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set 

to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200, 
AE-50, and EW-50 individually.

Important
 ● Interlock settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to ensure proper settings. 
Those settings made without the connection of AE-50/EW-50 will not be reflected.

 ● The interlock settings between the units connected to the AE-200 and the AE-50/EW-50, as well as between the units 
connected to different AE-50 controllers, cannot be made.

(1) Touch the “Interlocked LOSSNAY unit registration” button. 
A screen to select the units will appear.
Select the address number of the LOSSNAY unit to be 
registered. The selected unit address will appear with an 
orange frame.
Touch again to deselect.

(2) Touch the “Interlocked indoor unit registration” button. A 
screen to select the units will appear.
Select the address numbers of the indoor units to which 
the selected LOSSNAY unit will be interlocked. The 
selected unit addresses will appear with an orange frame.
Touch again to deselect.
 Note:  Each LOSSNAY unit can be interlocked with up to 16 

indoor units.

Interlocked LOSSNAY unit 
registration

Touch to display the screen 
for registering the LOSSNAY 

unit.

Interlocked indoor unit 
registration
Touch to display the screen 
for registering the indoor 
units.

Save Settings
Touch to save the changes 
made.

Controller
Select [AE] to make 

settings for AE-200, and 
select [1], [2], [3], or [4] 

to make settings for each 
AE-50/EW-50. 
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5-1-8. Blocks
By making block settings, multiple groups in a given block can be collectively monitored or operated.
Touch [Initial Settings] in the menu bar, and then touch [Blocks]. Register the groups to each block, and then touch 
[Save Settings].

   Note:  Some settings may not be accessible if logged in as a building manager.
   Note:  If the system is connected to a TG-2000A, make or change the settings from the TG-2000A.
   Note:  The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set 

to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200, 
AE-50, and EW-50 individually.

Important
 ● Block settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to ensure proper settings. 
Those settings made without the connection of AE-50/EW-50 will not be reflected.

(1) Touch the “Block name” button to display the keyboard. Enter the group name in 20 alphanumeric or symbol 
characters or less.
 Note:  The following characters cannot be used:  <, >, &, “, or ‘

(2) Touch the “Group registration” button of the target block. A 
screen to select the groups will appear.
Touch the group numbers to be registered. (The name of 
the group that was touched last will appear.)
The selected group numbers will appear with an orange 
frame. Touch again to deselect.
 Note:  HWHP (CAHV, CRHV) unit groups cannot be registered to 

a block.

Block name

Group registration

Block No.
Group name

Save Settings
Touch to save the changes 
made.

Controller
Select [AE] to make 

settings for AE-200, and 
select [1], [2], [3], or [4] 

to make settings for each 
AE-50/EW-50. 

Group No.
“AE-50 No. - Group No.” 

will appear if one or more 
AE-50/EW-50 controllers are 

connected.
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5-1-9. EM Blocks
Carrying out EM block (energy management block) settings enables batch status monitoring and operation of 
multiple blocks covering AE-200/AE-50/EW-50.
Touch [Initial Settings] in the menu bar, and then touch [EM Blocks]. Register the blocks to each EM block, and then 
touch [Save Settings].

   Note:  Some settings may not be accessible if logged in as a building manager.

(1) Touch the “EM block registration” button of the target EM 
block. A screen to select the blocks will appear.

(2) Switch to the controllers ([AE200], [Exp1] through [Exp4]) to which the blocks to register belong.

(3) Touch the block numbers to be registered. (The name of the block that was touched last will appear.)
The selected block numbers will appear with an orange frame. Touch again to deselect.
 Note:  To select a LOSSNAY unit that is interlocked with indoor units, touch the  button and select an address number.
 Note:  HWHP (CAHV, CRHV) unit groups cannot be registered to a block.

(4) Touch the “EM block name registration” button to display the keyboard. Enter the EM block name in 20 
alphanumeric or symbol characters or less.
 Note:  The following characters cannot be used:  <, >, &, “, or ‘

EM block name 
registration

EM block registration

EM block No.

Block name

Save Settings
Touch to save the changes 
made.

Block No.
“AE-50 No. - Block No.” 
will appear if one or more 
AE-50/EW-50 controllers are 
connected.
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5-1-10. Floor Layout
The floor layout on the [Floor] display under the [Monitor/Operation] menu can be changed, and the display position 
of the groups on the floor can be changed.
Touch [Initial Settings] in the menu bar, and then touch [Floor Layout]. All unit groups that are under the control of 
both AE-200 and AE-50 can be displayed on the Floor Layout screen of the AE-200.

   Note:  Some settings may not be accessible if logged in as a building manager.
   Note:  Up to 30 groups can be assigned to each area.

Important
 ● Although the Floor Layout settings can also be made on the AE-50’s LCD, only the unit groups that are under the control of 
AE-50 controllers can be set on the AE-50’s LCD.

 ● In independent EW-50 systems, setting of the floor layout using the Initial Setting Tool is possible. (Refer to section 6-5 “Floor 
Settings” for details.)

[1]  Basic floor settings
(1) Touch the “Basic floor settings” button to display the 

basic floor settings screen.

(2) Touch   to set the total number of floors, and select 
the floor layout to be used.
 Note:  If the total number of floors is set to “--,” none of the 

floor layouts can be selected.
 Note:  Up to ten floors can be registerted.

Save Settings
Touch to save the changes 
made.

Floor selection

Area selection

Unassigned groups
Touch to display the groups 

that have not been assigned 
to an area.

Basic floor settings

Cut
Paste
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The display range of the area on the [Floor Layout] screen vary, depending on the selected floor layout.

Floor layout Display area Floor layout Display area

(3) Touch the “Floor level name” button to display the 
keyboard. Enter the floor level name in 3 alphanumeric 
or symbol characters or less.

Then, touch the “Floor name” button to display the 
keyboard. Enter the floor name in 20 alphanumeric or 
symbol characters or less.

(4) To read floor plan files from the USB memory, touch 
[Read from USB Memory]. Refer to [2] below for the 
restrictions on the floor plan files to be read.

(5) To set the width of the gridlines on the floor layout 
screen, touch [Gridline], and switch between [Do not 
show] and [Show].

(6) To change the icon movement width when moving icons 
on the floor layout screen, touch [Width of movement], 
and switch between [Small], [Middle], and [Large].

      

[2]  Restrictions on the floor plan files to be read

File size

900 (height) × 1890 (width) dots for each floor plan
 Note:  The file size must be 900 (height) × 1890 (width) dots regardless of the display range of the area. (Even 

when the floor layout shows only one display area, the file size must be 900 (height) × 1890 (width) 
dots. In this case, create a file plan only in the left top area.)

File format
gif
 Note:  Files that contain extension data (metadata such as XMP, transparent GIF, interlace GIF, animated GIF) 

cannot be read.

Floor level name
Floor name

Small Middle Large

630 dots

450 dots

1890 dots

900 dots
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File name

Floor *1 File name Floor *1 File name

1 floor_01.gif 6 floor_06.gif

2 floor_02.gif 7 floor_07.gif

3 floor_03.gif 8 floor_08.gif

4 floor_04.gif 9 floor_09.gif

5 floor_05.gif 10 floor_10.gif

*1 The floor numbers in the table are not the actual floor level name, but the number counted from the bottom on the [Floor 
Layout] screen. Even if the floor level name is set to “15F,” the file name will be “floor_01.gif” when the floor is the first 
floor in the setting.

File location In the root folder of the USB memory

Available colors 
(RGB) to be 
used in the file

R G B R G B R G B R G B
224 71 72 101 112 150 130 150 153 176 255 185
221 151 152 126 137 176 105 134 135 238 255 240
81 66 81 142 149 175 37 96 86 154 255 163
105 89 105 175 180 199 204 214 211 198 255 203
17 16 17 33 77 225 48 64 59 106 255 116
51 42 52 37 83 234 250 255 253 137 255 144
27 23 30 39 86 240 227 255 243 226 252 227
165 145 185 41 89 245 241 255 248 124 233 125
33 37 57 42 92 249 237 249 243 250 255 250
2 17 85 46 93 246 67 97 79 167 229 166
6 35 160 23 47 124 59 78 66 107 145 104
6 28 122 63 104 238 61 116 80 182 211 180
9 40 168 77 116 241 85 128 100 23 95 15
12 45 176 99 137 255 154 177 162 149 211 141
154 162 194 126 146 214 14 45 24 128 140 126
211 214 227 149 170 235 59 93 70 95 202 74
15 49 182 70 79 108 178 187 181 194 231 186
17 53 188 179 189 222 46 181 88 147 169 142
20 57 195 191 202 230 59 157 90 41 177 3
24 64 205 192 210 241 90 213 129 166 203 154
17 46 149 163 170 180 214 255 225 208 224 202
21 52 163 236 242 250 224 239 228 219 235 211
28 70 215 159 185 210 129 155 135 172 187 164
32 64 178 144 154 162 178 194 182 203 211 197
45 80 204 204 228 245 115 255 143 241 244 238
44 75 190 112 183 219 99 193 117 199 201 195
55 90 213 126 139 145 182 201 185 110 114 98
69 99 205 214 241 251 59 255 88 127 129 119
99 122 202 159 240 253 19 255 48 210 211 196

R G B R G B R G B R G B
255 253 185 179 159 1 225 148 50 195 195 195
193 193 150 172 169 147 214 159 89 193 193 193
255 255 221 187 185 169 77 76 75 191 191 191
121 121 106 179 177 162 230 211 206 189 189 189
162 162 147 205 203 187 207 203 202 185 185 185
142 142 129 224 222 206 225 197 192 179 179 179
94 94 89 212 201 139 225 8 8 173 173 173
212 212 203 136 134 122 221 179 179 171 171 171
235 235 227 158 156 143 152 151 151 169 169 169
213 213 207 217 215 202 255 255 255 166 166 166
203 203 198 230 228 216 250 250 250 161 161 161
137 137 134 142 128 71 249 249 249 154 154 154
116 116 114 254 246 220 246 246 246 148 148 148
245 245 242 244 237 215 243 243 243 143 143 143
85 85 84 33 25 2 241 241 241 133 133 133
121 121 120 111 110 107 239 239 239 129 129 129
253 253 252 63 43 4 236 236 236 103 103 103
119 117 23 106 104 100 232 232 232 82 82 82
255 253 143 133 132 130 228 228 228 70 70 70
253 241 7 116 79 14 225 225 225 64 64 64
174 173 157 254 251 246 220 220 220 58 58 58
208 195 0 255 151 0 217 217 217 51 51 51
220 210 64 93 61 13 215 215 215 44 44 44
156 153 113 254 221 171 211 211 211 41 41 41
201 199 175 157 97 18 209 209 209 34 34 34
151 150 136 211 205 197 207 207 207 4 4 4
187 175 71 205 128 31 205 205 205 0 0 0
195 193 175 187 116 28 202 202 202 255 170 63
198 197 187 219 138 35 198 198 198 255 203 131

 * Use the colors in the table above, otherwise the floor plan will appear in different colors.
 * The default background color is RGB [103, 103, 103].
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[3]  Moving a group to other areas
(1) On the [Floor Layout] screen, touch the group icon to 

be moved. The selected group icon will appear with an 
orange frame.
 Note:  When the “Unassigned groups” button is touched, 

groups that have not been assigned to any area will 
appear in the order of their group numbers. (Up to 30 
groups will appear in an area.)

(2) Touch [Cut].
The orange frame will change to a pale orange frame.

(3) With the pale orange frame being displayed, select the 
area to move the group to, and touch [Paste] to move 
the selected group to the selected area.
 Note:  A popup message will appear when you touch the item 

in the menu bar or sub menu bar to see other screens 
without the changes being saved. Note that the changes 
will NOT be saved unless the [Save Settings] button is 
pressed.

Unassigned groups

Cut

Area selection Paste

Menu bar
Sub menu bar
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(4) Touch [Save Settings].
 Note:  To move the pasted group icon within the area, refer to [4] 

“Moving a group within the area” below.

[4]  Moving a group within the area
   Note:  It is recommended to use a commercially available touch pen.

(1) On the [Floor Layout] screen, touch the group icon to 
be moved. The selected group icon will appear with an 
orange frame.

(2) Touch and hold the group icon for one second. The 
orange frame will change to an yellow-green frame.
 Note:  The group icons cannot be moved on the screen that 

appears when the “Unassigned groups” button.

(3) Drug and drop the icon to move anywhere within the 
area.

(4) Touch [Save Settings].
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5-1-11. System View
Refrigerant system information (connection information of outdoor and indoor units) can be checked for each AE-200, 
AE-50, and EW-50.
Touch [Initial Settings] in the menu bar, and then touch [System View].

   Note:  This screen shows the information of the units that have been registered to a group and have started up successfully.
   Note:  The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set 

to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to display the information for each 
AE-200, AE-50, and EW-50 individually.

(1) Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to check the system information for 
each AE-200, AE-50, and EW-50 individually. (Only on the AE-200’s LCD)

Controller
Select [AE] to display the 

information for AE-200, and 
select [1], [2], [3], or [4] to 
display the information for 

each AE-50/EW-50. 

Outdoor unit address
“Unit address of the main 

unit (Unit address of the sub 
unit)” will appear.

Indoor unit address
Unit address of the indoor 
units that are connected to 
the outdoor unit will appear.
Air to Water (PWFY) units 
will appear, and LOSSNAY 
and HWHP (CAHV, CRHV) 
units will not appear.
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5-1-12. Advanced settings
Touch [Initial Settings] in the menu bar, and then touch [Advanced].
Make necessary settings, and then touch [Save Settings].

   Note:  The Advanced settings may not be accessible if logged in as a building manager.

[1]  Time Master/Sub
The default setting is [Master].
This setting is required to change only for a system with multiple AE-200 controllers connected to an AE-50 
controller (System configuration (1) below).

System configuration

(1) System with multiple AE-200 controllers connected to an AE-50 controller

Set to [Master] on only one of the AE-200 controllers in a system.

AE-200

AE-200

AE-50

Time Master/Sub

Old model compatibility   
mode

Schedule: Season setting

Hold type

Save Settings
Touch to save the changes 
made.

Master Sub
: Time setting flow
: [Time Master/Sub] setting

Master

Sub

Master

Outdoor unit Indoor unit
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(2) System with an AE-200 controller connected to AE-50 controllers

Leave the default setting [Master] as it is.

AE-200 AE-50

AE-50

(3) System with a high-level system (i.e., TG-2000A) connected to AE-200 controllers

Leave the default setting [Master] as it is.

TG-2000A AE-200

AE-200

[2]  Old model compatibility mode
In the [Old model compatibility mode] section, select [ON] or [OFF].
When [ON] is selected, the Dual set point function and Prohibit Remote Controller function (Timer, Air Direction, Fan 
Speed) cannot be used.

   Note:  If the setting is changed, the controller will reboot.

[3]  Hold type
The Hold function is a function to disable the operations that were scheduled for air conditioning unit groups.
If the setting for [Hold] is set to [ON] on the operation settings screen under the [Monitor/Operation] menu and the 
[Hold type] on the screen above is set to [Forced], the [Hold] setting can be cancelled only from the AE-200/AE-50. 
If the [Hold type] is set to [Normal], the [Hold] setting can be cancelled from AE-200/AE-50, other system controllers, 
or remote controllers.

   Note:  The Hold function can be used on the AE-200A/AE-50A, but not on the AE-200E/AE-50E.
   Note:  The Hold function cannot be used on general equipments.
   Note:  The setting [Forced] will not be effective on Air To Water (PWFY) unit groups, LOSSNAY unit groups, HWHP (CAHV, CRHV) 

unit groups, general equipment groups, and air conditioning unit groups that do not support the Hold function (i.e., Mr. Slim 
M-Series/P-Series indoor units). If the setting for [Hold] is set to [ON] on those unit groups on the operation settings screen 
and the [Hold type] on the screen above is set to [Forced], the setting [Normal] will be effective.

[4]  Schedule: Season setting
In the [Schedule: Season setting] section, select [Available] to enable the seasonal settings of the weekly schedules 
and [Not Available] to disable. Unless otherwise specified, leave the default setting [Available] as it is.

   Note:  The settings made on this screen on the AE-200 will be reflected on this screen on the AE-50.

Master
Master

Master

Outdoor unit

Outdoor unit

Indoor unit

Indoor unit

Master

Master

Outdoor unit

Outdoor unit

Indoor unit

Indoor unit
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5-2. Function1
5-2-1. Peak Cut (Energy-save control function)

According to the selected Peak Cut method, the AE-200/AE-50/EW-50 obtains the demand level or the electric 
energy values to determine the control level, and operates outdoor units and blocks of indoor units below the 
specified maximum capacity that corresponds to the control level.
Touch [Functions 1] in the menu bar, and then touch [Peak Cut] to access the Peak Cut control settings screen. 
Make necessary settings, and then touch [Save Settings].

Important
 ● The amount of electricity that is actually used may exceed the maximum power demand due to unexpected problems 
such as controller malfunctions or broken transmission cables. Mitsubishi Electric will not be responsible for exceeding the 
maximum power demand.

 ● An energy-save control can be performed, regardless of the electric energy consumption status. To perform an energy-
save control at the same level (control level 0) at all times, make the control settings for control level 0 for given outdoor and 
indoor units. (In this case, Peak Cut method setting is not necessary.)

   Note:  Peak Cut settings using the LCD are possible on the AE-200/AE-50 from Ver. 7.23 onwards.
   Note:  After completing the settings, perform a test run and confirm proper connections of equipment before using the Peak Cut 

function.
   Note:  A separate license is required to use the Peak Cut function. Make sure that the required license has properly been registered 

on the [License] screen. (Refer to section 4-5 “License registration for optional functions” for details.) If the license is not 
registered, the settings can be saved, but the function will not be available until the license is registered. When the license is 
not registered, a message “License not registered” will appear at the left bottom of the screen.

   Note:  Some settings may not be accessible if logged in as a building manager.
   Note:  Peak Cut control cannot be performed on DIDO controller (PAC-YG66DCA), AHC, or Air To Water (PWFY) unit.
   Note:  The Peak Cut control of indoor units is performed per block. Be sure to make block settings to use the Peak Cut function.
   Note:  The Peak Cut control settings between the outdoor and indoor units connected to the AE-200, AE-50, and EW-50, as well as 

between the units connected to different AE-50/EW-50 controllers, cannot be made.
   Note:  Do not make the Peak Cut control settings for heat pump models of outdoor units or some types of outdoor units. For details, 

refer to section 5-2-1-2 (2) “Control details for outdoor units (All Peak Cut methods)”.

Controller
Select [AE200] to make 
settings for AE-200, and 
select [1], [2], [3], or [4] 

to make settings for each 
AE-50/EW-50. 

Peak Cut method

Save Settings
Touch to save the changes 
made.

https://planetaklimata.com.ua/ua/proizvoditeli/kondicionery-mitsubishi-electric/
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5-2-1-1. Peak Cut method
Touch the [Settings] tab in the Peak Cut control settings screen.

[PLC Software for Demand Input]

AE-200

AE-50

AE-50

AE-50

[Electric Amount Count Software]

AE-200

AE-50

AE-50

AE-50

[PI Controller]

AE-200

AE-50

AE-50

AE-50

AE-200

AE-50

AE-50

AE-50

[External Contact point input] (1)

AE-200

AE-50

AE-50

AE-50

[External Contact point input] (2)

AE-200

AE-50

AE-50

AE-50

Demand level 
signal is sent.

Demand-Input 
PLC 

Maximum ten 
AE-200/AE-50/EW-50 units

Demand 
controller

Demand level is 
input.

Reads electric 
energy values.

Electric Amount 
Count PLC

Maximum fourteen 
AE-200/AE-50/EW-50 units

Pulse

Pulse-watt-
hour meter

<When a PI controller (PAC-YG60MCA) is used> <When a built-in Pulse Input (PI) is used>

Maximum three 
AE-200/AE-50/EW-50 units

Peak Cut method [Remote AE]

Pulse-watt-
hour meter

Reads control 
level.

Pulse

(Built-in Pulse Input (PI))

Reads electric 
energy values.

Reads control 
level.

Peak Cut method [Remote AE]

PI controller

Maximum three 
AE-200/AE-50/EW-50 units

Pulse

Pulse-watt-
hour meter

Maximum three 
AE-200/AE-50/EW-50 units

Demand level is 
input.

Demand 
controller

External input/output 
adapter (PAC-YG10HA-E)

LAN

Peak Cut method [Remote AE]

Reads control 
level.

Maximum three 
AE-200/AE-50 
/EW-50 units

Demand level is 
input.

Demand 
controller

External input/output 
adapter (PAC-YG10HA-E)
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[From external system]

AE-50

AE-50

AE-50

AE-200

(A) When the Peak Cut method [PLC Software for Demand Input] is selected
1st page

2nd page

(1) In the [IP address of PLC] field, enter the IP address of the Demand-Input PLC.

(2) When using the Demand-Input PLC for the first time, initialize its internal memory.
 Note:  Do not initialize the Demand-Input PLC after the operation has begun, for it will reset all settings to the default settings 

and will not properly perform the Peak Cut control.

Demand level 
signal is sent.

PLC etc.

Pulse

Pulse-watt-
hour meter

Maximum ten 
AE-200/AE-50/EW-50 units

Peak Cut method

IP address of PLC

Temperature difference 
between set point and 

inlet

Initialize

Save Settings

IP address of controller

Save Settings
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(3) In the [Temperature difference between set point and inlet] section, a temperature differential can be set to 
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be 
disregarded for the indoor unit groups in which the temperature difference between the set temperature and 
the room temperature is greater than the specified temperature differential.
 Note:  The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the temperature 

differential setting.

(4) In the [IP address of controller] field, enter the IP addresses of the AE-200/AE-50/EW-50 units to which the 
demand level signal is sent. Up to 10 IP addresses can be registered.

(B) When the Peak Cut method [Electric Amount Count Software] is selected
1st page

2nd page

(1) In the [IP address of PLC] field, enter the IP address of the Electric Amount Count PLC.
 Note:  Each PLC can be registered to up to ten AE-200/AE-50 units.
 Note:  This setting is required for each AE-200/AE-50.

(2) When using the Electric Amount Count PLC for the first time, initialize the internal memory.
 Note:  Do not initialize the Electric Amount Count PLC after the operation has begun, for it will reset all settings to the default 

settings and will not properly perform the Peak Cut control.

Peak Cut method

IP address of PLC

Temperature difference 
between set point and 

inlet

Initialize

Save Settings

DI Board

Pulse Unit

Control levels

Save Settings
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(3) Touch the [DI Board] or [Pulse Unit] button to open the window to select the DI board number to which the watt-
hour meter is connected, and the terminal number. If the watt-hour meter is connected to terminal 2 on a DI 
board 1, select 1-2.
 Note:  Select a DI board number 1 or 2, and select a terminal number/code between 0 and F.

(4) In the [Pulse Unit] field, enter the pulse value that the watt-hour meter outputs. Set the pulse value according to 
the watt-hour meter to be used.

Important:  Check the watt-hour meter readings several times on the hour and the half-hour. Then, be sure to check 
that the increase in the watt-hour meter reading for each 30-minute period and the average electric power 
consumption in the same period that the Peak Cut function is used are the same amount. 
The average electric power for the period that the Peak Cut function is used can be checked on the [Peakcut] 
screen.

(5) In the [Control levels] section, the range of the electric power must be set for each control level. For control 
level 4, enter the value that is 10% to 15% below the maximum power demand (average electric energy that 
cannot be exceeded in any 30-minute period). For control levels 3 to 0, enter the value that is decreased by 
about 10% from the set value of the previous control level. (The screenshot above shows the setting example 
of the maximum demand of 200 kW.)
 Note:  The optimum setting depends on the system configuration of the electric equipment and on the indoor environment in 

each building. Determine the appropriate values accordingly.

(6) In the [Temperature difference between set point and inlet] section, a temperature differential can be set to 
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be 
disregarded for the indoor unit groups in which the temperature difference between the set temperature and 
the room temperature is greater than the specified temperature differential.
 Note:  The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the temperature 

differential setting.

Board number

Terminal number
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(C) When the Peak Cut method [PI Controller] is selected
1st page

2nd page

Peak Cut method

Watthour meter

Temperature difference 
between set point and 

inlet

Save Settings

Control levels

Save Settings
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(1) Touch the [Watthour meter] button to open the window to select the PI controller to which the watt-hour meter 
used for the Peak Cut function is connected.

 Note:  Only the watt-hour meters that have been registered on the [Measurement] screen are selectable. (Refer to section 5-2-
2 “Measurement” for how to register metering devices.)

 Note:  When a built-in Pulse Input (PI) is used, [Channel No. + (space) + Metering device name] will appear. (For example, if 
the watt-hour meter used for the Peak Cut function is connected to channel 3 of CN7 of AE-200 and the metering device 
name is “For Peak Cut function,” [3 For Peak Cut function] will appear.)
When a PI controller (PAC-YG60MCA) is used, [PI controller address + “-” + Channel No. + (space) + Metering device 
name] will appear. (For example, if the watt-hour meter used for the Peak Cut function is connected to channel 2 of a PI 
controller (address 10) and the metering device name is not registered, [10-2] will appear.)

 Note:  To deselect the selection, select [-- --].

(2) In the [Temperature difference between set point and inlet] section, a temperature differential can be set to 
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be 
disregarded for the indoor unit groups in which the temperature difference between the set temperature and 
the room temperature is greater than the specified temperature differential.
 Note:  The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the temperature 

differential setting.

(3) In the [Control levels] section, the range of the electric power must be set for each control level. For control 
level 4, enter the value that is 10% to 15% below the maximum power demand (average electric energy that 
cannot be exceeded in any 30-minute period). For control levels 3 to 0, enter the value that is decreased by 
about 10% from the set value of the previous control level. (The screenshot above shows the setting example 
of the maximum demand of 200 kW.)
 Note:  The optimum setting depends on the system configuration of the electric equipment and on the indoor environment in 

each building. Determine the appropriate values accordingly.
 Note:  Other than the AE-200/AE-50/EW-50 units that use a built-in Pulse Input (PI) or a PI controller (PAC-YG60MCA), up 

to three more AE-200/AE-50/EW-50 units can be controlled. Refer to (D) “When the Peak Cut method [Remote AE] is 
selected” below for details.

(D) When the Peak Cut method [Remote AE] is selected

Peak Cut method

IP Address

Temperature difference 
between set point and 

inlet

Save Settings
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(1) In the [IP address] field, enter the IP address of the AE-200/AE-50/EW-50 that uses one of the following.
 - Built-in Pulse Input (PI)
 - PI controller (PAC-YG60MCA)
 -   External contact input (Refer to (E) “When the Peak Cut method [External Contact point input] is selected” 

for details.)

 Note:  As the control level is obtained every minute from the AE-200/AE-50/EW-50 that uses a built-in Pulse Input (PI) or a PI 
controller (PAC-YG60MCA), the control will be late for up to one minute on the AE-200/AE-50 whose Peak Cut method 
setting is [Remote AE].

 Note:  Up to three AE-200/AE-50/EW-50 units can be connected to the AE-200/AE-50/EW-50 unit that uses a built-in Pulse 
Input (PI) or a PI controller (PAC-YG60MCA). When five or more AE-200/AE-50/EW-50 units are connected, add the 
settings explained in (C) “When the Peak Cut method [PI Controller] is selected” or use the Peak Cut method [Electric 
Amount Count Software].

(2) In the [Temperature difference between set point and inlet] section, a temperature differential can be set to 
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be 
disregarded for the indoor unit groups in which the temperature difference between the set temperature and 
the room temperature is greater than the specified temperature differential.
 Note:  The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the temperature 

differential setting.

(E) When the Peak Cut method [External Contact point input] is selected
   Note:  The external signal can be input to AE-200, AE-50, and EW-50, so that all outdoor units and blocks of indoor units can be 

selected.

(1) In the [Temperature difference between set point and inlet] section, a temperature differential can be set to 
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be 
disregarded for the indoor unit groups in which the temperature difference between the set temperature and 
the room temperature is greater than the specified temperature differential.
 Note:  The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the temperature 

differential setting.

Peak Cut method

Temperature difference 
between set point and 

inlet

Save Settings
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(F) When the Peak Cut method [From external system] is selected

(1) In the [Temperature difference between set point and inlet] section, a temperature differential can be set to 
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be 
disregarded for the indoor unit groups in which the temperature difference between the set temperature and 
the room temperature is greater than the specified temperature differential.
 Note:  The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the temperature 

differential setting.

Peak Cut method

Temperature difference 
between set point and 

inlet

Save Settings
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5-2-1-2. Unit settings
Touch the [Air-con] tab in the Peak Cut control settings screen.

(1) Control details for blocks of indoor units

Follow the instructions below to make the Peak Cut control settings for each control level for given blocks of 
indoor units.
If the block settings have not been made, refer to section 5-1-8 “Blocks” for how to make the block settings.

Important
 ● An energy-save control at the same level (control level 0) can be performed at all times regardless of the electric energy 
consumption status.

1st page (Indoor unit settings)

(1) Touch  or  to display the block whose settings are to be made. To make settings for all blocks at once, 
check the [Batch Operations] checkbox.
Then, select the control method for each control level, referring to the table below.
 Note:  Only the control method “OFF” is effective for Air To Water (PWFY) units. Other methods can be selected, but are not 

effective.

Table: Indoor Unit Control Method

Control Method Control details

None Peak Cut control will not be performed.

±2ºC (±4ºF)

During the Peak Cut control, the set temperature in the Cool or Dry mode will be offset by +2ºC (+4ºF), 
and the set temperature in the Heat mode will be offset by -2ºC (-4ºF).
 Note:  Peak Cut control will not be performed during the Fan or Auto mode.
 Note:  When the unit of temperature is Fahrenheit, the set temperature may not be offset by ±4ºF exactly 

because 2ºC is used for the calculation first, and then the temperature in Celsius is converted into 
the temperature in Fahrenheit.

 Note:  The set temperature will be adjusted within the set temperature restrictions settings made on the 
Set Temperature Range Limit screen (accessible via the Web Browser for Initial Settings). Refer to 
section 7-3-1 “Set Temperature Range Limit” for details.

Fan *1
During the Peak Cut control, free-plan indoor units and A-control Mr. Slim indoor units (M-Series/P-Series 
indoor units) will go in to the Thermo-OFF state, and the units older than free-plan units will operate 
in the Fan mode. (When the units are in the Thermo-OFF state, the operation mode on the remote 
controller LCD will not change.)

OFF *1
During the Peak Cut control, the units will stop.
 Note:  If the control method is set to [OFF] and the Control Time is set to [30] minutes, the groups that are 

operated in the Peak Cut control cannot be operated from any controller.

*1 When the indoor unit Peak Cut control function is used during the heating operation, it takes a while to resume operation to prevent cold air 
draft. This may negatively affect the performance of the unit for a certain period of time after the operation is resumed. To ensure maximum 
performance, it is recommended to use an outdoor unit capacity-save control function (that will not stop the compressor operation) during the 
heating operation. If the indoor unit Peak Cut control function is still used, selecting [3] minutes in the Control Time section is recommended.

Control Method

Control levels

Save Settings

Batch Operations
Copy
Paste

Touch to switch the blocks.

Control Time

Touch to go to the next page 
(outdoor unit settings).



73WT07627X01

(2) For each control level, set the total time in which 
the Peak Cut control is performed during every 30 
minutes.
Each Peak Cut control is performed for three 
minutes. If [6] minutes is selected, three-minute 
Peak Cut control will be performed twice during 
every 30 minutes.
If any time other than [30] minutes is selected, the 
indoor units will operate in rotation so that they will 
not perform the Peak Cut control at the same time.

0 3 5 8 10 15 18 20 23 25 3013 28

(3) To copy the settings of a block to the settings for other blocks, display the block whose settings are to be copied 
and touch [Copy], then display the block to which the copied settings are to be pasted and touch [Paste]. The 
rectangular icons next to the selected buttons will appear in yellow-green.

(2) Control details for outdoor units (All Peak Cut methods)

Follow the instructions below to make the Peak Cut control settings for each control level for given outdoor units. 
   Note:  If the outdoor unit is a City Multi unit, the M-NET address will appear. If the outdoor unit is an A-control (Mr. Slim) unit, the 

M-NET address and group name will appear.
   Note:  As for A-control outdoor units, only the inverter models can perform Peak Cut control. The Peak Cut control settings for 

constant-speed models can not be made.
   Note:  Do not make the Peak Cut control settings for heat pump models of outdoor units or some types of outdoor units.

2nd page (Outdoor unit settings)

(1) Touch  or  to display the address of the 
outdoor unit whose settings are to be made. 
To make settings for all outdoor units at once, 
check the [Batch Operations] checkbox.
Then, set the maximum operating capacity for 
each control level.
The smaller the maximum operating capacity, 
the more energy will be saved.
 Note:  Energy-saving effects cannot be expected 

during low-load operation with the capacity 
below the selected maximum capacity.

When [6] minutes is selected

Group 1

Group 2

Group 3

Control time
min

Maximum Capacity

Control levels

Save Settings

Batch Operations
Copy
Paste

Touch to switch the outdoor 
unit addresses.

Control Time

Touch to go to the previous 
page (indoor unit settings).

Capacity

80%

Operating 
Capacity

e.g., Maximum capacity at 80%

No energy-saving effects Energy-saving effects

Energy saved

Time

https://planetaklimata.com.ua/ua/katalog-proizvoditeli/Mitsubishi-Electric/
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 Note:  For heat pump outdoor units and City Multi S series (PUMY) outdoor units, leave the default setting [100%] as it is not to 
activate the capacity-save control.
However, [50%] though [100%] can be set on the following models.
PUMY-P**KM or later
PUMY-P**KM-A or later
PUMY-P**HMC-S or later
PUMY-P**HMC-C or later
PUMY-P**KMC-C or later
PUMY-P**YKM.TH(-T) or later

 Note:  AE-200/AE-50/EW-50 that support Maximum Capacity [50%] are from Ver. 7.23 or later.

(2) For each control level, set the total time in which the Peak Cut control is performed during every 30 minutes. 
Setting the time to [30] minutes is preferable, for shorter control time is not likely to bring much benefit.
If any time other than [30] minutes is selected, the outdoor units will operate in rotation so that they will not 
perform the Peak Cut control at the same time.

(3) To copy the settings of an outdoor unit to the settings for other outdoor units, display the outdoor unit whose 
settings are to be copied and touch [Copy], then display the outdoor unit to which the copied settings are to be 
pasted and touch [Paste]. The rectangular icons next to the selected buttons will appear in yellow-green.
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5-2-2. Measurement
Measurement settings must be made to use temperature sensors, humidity sensors, and metering devices.  
Touch [Function1] in the menu bar, and then touch [Measurement]. Set the measurement settings for each AE-200 
and AE-50, and then touch [Save Settings].

   Note:  The measurement settings may not be accessible if logged in as a building manager.
   Note:   If the system is connected to a TG-2000A, make or change the settings from the TG-2000A.
   Note:  The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set 

to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200, 
AE-50, and EW-50 individually.

Important
 ● Measurement settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to ensure proper 
settings. Those settings made without the connection of AE-50/EW-50 will not be reflected.

[1]  Registering AI controllers and temperature/humidity sensors
Follow the instructions below to make the system settings for measurement sensors. Up to two measurement 
sensors can be connected to an AI controller (PAC-YG63MCA).

(1) Touch  or  to select the address to which the AI controller (PAC-YG63MCA) will be connected.

(2) Select the AI controller icon ( ).

 Note:  Touch again to deselect.

Controller
Select [AE] to make 

settings for AE-200, and 
select [1], [2], [3], or [4] 

to make settings for each 
AE-50/EW-50. 

M-NET address of AI or PI 
controller

Selection of AI or PI 
controller

Touch to show the address 
to which the AI or PI 
controller will be connected.

Setting details

Save Settings
Touch to save the changes 
made.

AI controller icon

Sensor name

Setting details of sensor 1

Setting details of sensor 2

Temperature or humidity 
sensor settings

Offset value

Measurable range
Upper/lower ON- and OFF-
threshold settings for 
e-mail alarm function

Upper limit
(ON-threshold)
Upper limit
(OFF-threshold)
Lower limit
(OFF-threshold)
Lower limit
(ON-threshold)
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(3) Touch the “Sensor name” button to display the keyboard. Enter the name of the sensor in 20 characters or 
less.
 Note:  The following characters cannot be used:  <, >, &, “, or ‘

(4) Touch the “Temperature or humidity sensor settings” 
button to display the sensor settings screen.

Select the temperature sensor icon ( ) or the humidity 
sensor icon ( ).

(5) Touch the [Bottom] and [Top] buttons to display the 
keypad. Enter the measurable range of the sensor, and 
then touch [OK].
 Note:  The settable range for temperature sensor is between 

-100.0ºC (-148.0ºF) and +100.0ºC (+212.0ºF), and for 
the humidity sensor is between 0.0% and +100.0%.

 Note:  When the Pt100 sensor is connected, the range must be 
between -30ºC (-22ºF) and +60ºC (+140ºF).  
When the sensors other than the Pt100 sensors are 
connected, enter the ranges that are described in the 
operation manuals of the sensor.

(6) To set the offset value for the measured values, touch the [Offset] button to display the keypad. Enter the offset 
value, and then touch [OK].
 Note:  The settable offset value range for temperature sensor is between -10.0ºC (-18.0ºF) and +10.0ºC (+18.0ºF), and for the 

humidity sensor is between -10.0% and +10.0%.

(7) To receive an e-mail alarm when the temperature or the 
humidity exceeds certain predetermined values, set the 
ON- and OFF-thresholds for both the upper and lower 
limit temperatures.
Touch the “Upper/lower ON- and OFF-threshold settings 
for e-mail alarm function” section to display the settings 
screen.
Touch the [U alarm ON]/[L alarm ON] and [U alarm OFF]/
[L alarm OFF] buttons to display the keypad. Enter the 
ON- and OFF-thresholds for the upper and lower limit 
temperatures, and then touch [OK].

 Note:  To clear the ON- and OFF-thresholds for the upper limit 
temperatures, touch [U clear]. To clear the ON- and 
OFF-thresholds for the lower limit temperatures, touch [L 
clear].

 Note:  To avoid frequent ON/OFF cycling, the minimum 
differential between the ON- and OFF-threshold values 
should be 1ºC (2ºF).

(8) Touch [Save Settings].

Selection of temperature or humidity 
sensor icon

Offset valueMeasurable range

Upper limit (OFF-threshold)
Upper limit (ON-threshold)

Lower limit (ON-threshold)

Lower limit (OFF-threshold)
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[2]  Registering PI controllers and metering devices

Important
 ● The built-in Pulse Input (PI) settings cannot be made on the TG-2000A.
 ● The built-in Pulse Input (PI) cannot be used for the electricity charge apportioning function of TG-2000A.

Follow the instructions below to make the system settings of the metering devices. Up to four metering devices can 
be connected to a PI controller (PAC-YG60MCA) or CN7 of AE-200/AE-50/EW-50.

   Note:  Although the maximum settable total number of built-in Pulse Input (PI) and PI controllers (PAC-YG60MCA) for each 
AE-200/AE-50/EW-50 is 15, the number of them in a system with connection to one or more AE-50/EW-50 controllers must 
be 20 or less. (Each built-in Pulse Input (PI) counts as one unit.)

<When a built-in Pulse Input (PI) is used>

<When a PI controller (PAC-YG60MCA) is used>

(1) Touch  or  to display the address to which the PI controller (PAC-YG60MCA) will be connected or to 
display the settings area for a built-in Pulse Input (PI) at the top.

(2) Select the PI controller icon ( ).

When a built-in Pulse Input (PI) is used, the top row shows the setting area for the built-in Pulse Input (PI) and 
there is no need to select an icon.
 Note:  Touch again to deselect.

(3) Touch the “Metering device name” button to display the keyboard. Enter the name of the metering device in 20 
characters or less.
 Note:  The following characters cannot be used:  <, >, &, “, or ‘

(4) Touch the “Pulse value” button to display the keypad. Enter 
the pulse value of the metering device, and touch [OK].
 Note:  The settable range is between 0.01 and +100.
 Note:  If the pulse value field is left blank, the reading of the 

metering device cannot be properly obtained. Be sure to set 
the pulse value.

Built-in Pulse Input (PI) 
icon

Metering device name

Pulse value

Measurement unit

PI controller icon

Metering device name

Pulse value

Measurement unit
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(5) Touch the “Measurement unit” button to select the measurement unit.
 Note:  The measurement unit can be selected from [kWh], [m3], [MJ], [--(no unit)], or [(blank)]. Select the blank when not using 

a metering device.

Important
 ● Set the pulse value according to the metering device to be used. To ensure proper settings, first check the value 
measured by the metering device and the value counted by the built-in Pulse Input (PI) or the PI controller (PAC-
YG60MCA). Then, after a certain time, check that both values have increased by equal values. (The values that 
the built-in Pulse Input (PI) or the PI controller (PAC-YG60MCA) counts can be checked on the [Measurement] 
display under the [Monitor/Operation] menu.)

(6) Touch [Save Settings].
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5-2-3. Energy Management
On the Energy Management screen, make the settings for the energy-control-related items that appear on 
the screens under the [Energy Mgmt] menu, such as temperature sensor to measure the outdoor temperature 
with, electricity meters that are used for acquiring the data to display the trend graph of indoor unit electricity 
consumption, and also the mode that are used for apportioning indoor unit electricity consumption.
Touch [Function1] in the menu bar, and then touch [Energy Management].

   Note:  Electricity consumption is apportioned based on the electricity consumed by outdoor units. The electricity consumed by 
indoor units is not considered.

Important
 ● AI and PI controller settings are required beforehand to make energy management settings. Refer to section 5-2-2 
“Measurement” for details.

 ● The energy management settings must be made after all units have been started up. The settings that have been saved 
while one or more units are starting up may be lost.

(1) Touch the “Temperature Sensor” button. The name of the 
temperature sensor that is connected to the AI controller or 
the AHC will appear.
Select a temperature sensor to measure the outdoor 
temperature with, and then touch [OK].
 Note:  To deselect the selection, select [-- --].
 Note:  This setting is not required when not showing the outdoor 

temperature in a line graph on the [Energy Use Status] 
screen.

 Note:  This setting is interlocked with the temperature sensor 
setting on the [External Temperature Interlock] screen.

(2) Touch the [Indoor unit operation apportioning mode] button.
Select the way indoor units’ operation time is counted that is used to apportion the electricity consumption, 
which appears on the screens under the [Energy Mgmt] menu.
Select [Fan operation time] to apportion the electricity consumption based on the fan operation time, and select 
[Thermo-ON time] to apportion the electricity consumption based on the Thermo-ON time of the indoor units.
Select [Capacity save amount] to apportion the electricity consumption based on the indoor unit operation time 
that was calculated based on the amount of energy saved on the indoor units.
The selected setting must meet the system requirements. Selecting [Capacity save amount] is recommended.

Temperature sensor
Select a temperature sensor 

to measure the outdoor 
temperature with.

Indoor unit electricity 
meter

Save Settings
Touch to save the changes 
made.

Indoor unit operation 
apportioning mode
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 Note:  To deselect the selection, select [-- --].
 Note:  “FAN operation time” is the cumulative duration of time in which the indoor unit is powered on.
 Note:  “Thermo-ON time” is the cumulative duration of time in which the refrigerant is flowing into the indoor unit.
 Note:  “Capacity save amount” is the cumulative operation time of the outdoor unit based on its capacity.
 Note:  Electricity consumption is apportioned based on the electricity consumed by outdoor units. The electricity consumed by 

indoor units is not considered.
 Note:  When an AE-200 apportioned electricity billing function is used, this setting is not effective because the billing function 

settings are used to apportion the electricity consumption.

(3) Touch the [Indoor unit electricity meter] button.
Select the electricity meter to be used to measure the 
electricity consumption of each group of indoor units.
[“Address”+ PI controller address + “-” + Electricity meter 
number + Electricity meter name] will appear when a PI 
controller (PAC-YG60MCA) is connected, or [“Meter” + 
Channel No. + Electricity meter name] will appear when a 
metering device is directly connected to the controller.
 Note:  To deselect the selection, select [-- --].
 Note:  If the electricity meter name is long, only part of it may be 

displayed.
 Note:  The electricity meter name will be blank if it has not been 

registered.
 Note:  Only the electricity meters whose measurement unit setting 

is set to [kWh] on the Measurement screen are available for 
selection.

 Note:  LOSSNAY unit groups and general equipment (connected 
via DIDO controller PAC-YG66DCA) groups are excluded. 
(Apportioned calculation is not available for these groups.)

 Note:  When an AE-200 apportioned electricity billing function is 
used, this setting is not effective because the billing function 
settings are used to apportion the electricity consumption.

(4) Touch [Save Settings] to save the settings.
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5-3. Function2
5-3-1. External Temperature Interlock

Based on the temperature difference between the set temperature and the outdoor temperature, the set temperature 
can be adjusted automatically. Making this control setting on the air conditioning unit at an entrance of a building 
prevents extreme temperature change from distressing our bodies and sending us into shock.
Touch [Function2] in the menu bar, and then touch [Ext Temp Interlock].

   Note:  Either an AI controller (PAC-YG63MCA) or AHC, and an outdoor temperature sensor are required to measure the outdoor 
temperature.

   Note:  When connecting one or more AE-50/EW-50 controllers, connect an AI controller (PAC-YG63MCA) or AHC, and outdoor 
temperature sensor on each AE-50/EW-50.

   Note:  The External Temperature Interlock settings may not be accessible if logged in as a building manager.
   Note:  The External Temperature Interlock settings between the units connected to the AE-200 and the AE-50/EW-50, as well as 

between the units connected to different AE-50/EW-50 controllers, cannot be made.
   Note:  The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set 

to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200, 
AE-50, and EW-50 individually.

Important
 ● External Temperature Interlock settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to 
ensure proper settings. Those settings made without the connection of AE-50/EW-50 will not be reflected.

(1) Touch the “Temperature Sensor” button. The name of the 
temperature sensor that is connected to the AI controller or 
the AHC will appear.
Select a temperature sensor to measure the outdoor 
temperature with, and then touch [OK].
 Note:  To deselect the temperature sensor, select [-- --].
 Note:  Connect the temperature sensor to either the Analog Input 1 

or Analog Input 2 port on the AHC.
 Note:  This setting is interlocked with the temperature sensor 

setting on the [Energy Management] screen.

Controller
Select [AE] to make 

settings for AE-200, and 
select [1], [2], [3], or [4] 

to make settings for each 
AE-50/EW-50. 

Temperature Sensor
Select a temperature sensor 

to measure the outdoor 
temperature with.

Group No. and group 
name

Save Settings
Touch to save the changes 
made.

Control levels
Select a maximum 
temperature value to be 
added to or subtracted from 
the set temperature.
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(2) In the [Control levels] section, select a maximum temperature value for each group to be added to or 
sabtracted from the set temperature.
For example, when [±4°C] (±8°F) is selected and the set temperature for the Cool or the Dry mode is set to 
24°C (75°F), the set temperature will be adjusted to a maximum of 28°C (83°F) based on the temperature 
difference between the set temperature and the outdoor temperature. When [±2°C] (±4°F) is selected, the set 
temperature will be adjusted to maximum of 26°C (79°F).
 Note:  When the unit of temperature is Fahrenheit, the selected temperature value may not be added to the set temperature 

accurately because 2ºC is used for the calculation first, and then the temperature in Celsius is converted into the 
temperature in Fahrenheit.

(3) Touch [Save Settings].
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When the External Temperature Interlock function is active, the set temperature will be adjusted as shown 
below.

■■ “Cool” and “Dry” modes

29
30
31
32
33
34
35
36

27
28

26
25
24
23

 

Outdoor temperature conditions Set temperature after being adjusted

Outdoor temperature ≥  
Set temperature + 1.5°C (3°F) Set temperature + 1°C (2°F)

Outdoor temperature ≥  
Set temperature + 4.5°C (9°F) Set temperature + 2°C (4°F)

Outdoor temperature ≥  
Set temperature + 6.5°C (12°F) Set temperature + 3°C (6°F)

Outdoor temperature ≥  
Set temperature + 7.5°C (14°F) Set temperature + 4°C (8°F)

■■ “Heat” mode

12
13
14
15
16
17
18
19

10
11

9
8
7
6

Outdoor temperature conditions Set temperature after being adjusted
Outdoor temperature ≤  

Set temperature - 4.0°C (8°F) Set temperature - 1°C (2°F)

Outdoor temperature ≤  
Set temperature - 6.0°C (11°F) Set temperature - 2°C (4°F)

Outdoor temperature ≤  
Set temperature - 8.0°C (15°F) Set temperature - 3°C (6°F)

Outdoor temperature ≤  
Set temperature - 10.0°C (18°F) Set temperature - 4°C (8°F)

Te
m

pe
ra

tu
re

 (°
C

)

Outdoor temperature

Time

Set temperature after being adjusted 
when [Control levels] is set to [±4°C] 
(±8°F)

Set temperature

Te
m

pe
ra

tu
re

 (°
C

)

Set temperature

Set temperature after being adjusted 
when [Control levels] is set to [±4°C] 
(±8°F)

Time

Outdoor temperature
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5-3-2. Night Setback Control
The Night Setback Control function (hereafter abbreviated as Setback Control) prevents indoor condensation by 
performing heating operation automatically when the room temperature goes outside of the specific range during 
the night. Touch [Function2] in the menu bar, and then touch [Setback].
Heating operation starts when a given group is stopped and the room temperature drops below the specified 
minimum temperature.

   Note:  The Setback Control function also prevents excessive temperature rise by performing cooling operation automatically when 
the room temperature goes outside of the specific range. Cooling operation starts when a given group is stopped and the 
room temperature rises above the specified maximum temperature.

   Note:  If the operation settings (on/off, operation mode, or set temperature) is changed from a local remote controller during the 
Setback Control, the settings selected before the Setback Control will not be restored.

   Note:  If the room temperature is measured by the return air temperature sensor on the air conditioning unit, the measured value 
may not be an accurate representation of the temperature in the room, especially when the air conditioning unit is stopped 
and the room air is stagnant. When this is the case, use an external temperature sensor (PAC-SE40TSA) or remote 
controller sensor to measure the room temperature.

   Note:  The Setback Control may not be accessible if logged in as a building manager.
   Note:  The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set 

to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200, 
AE-50, and EW-50 individually.

Important
 ● Setback Control settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to ensure proper 
settings. Those settings made without the connection of AE-50/EW-50 will not be reflected.

(1) Touch the [Control Time] button to display the settings 
screen.
Set the [Setback] setting to [Use], set the time period in 
which Setback Control is performed, and then touch [OK].
 Note:  When [00: 00 - 00: 00] is selected, Setback Control is active 

for 24 hours.

Controller
Select [AE] to make 

settings for AE-200, and 
select [1], [2], [3], or [4] 

to make settings for each 
AE-50/EW-50. 

Save Settings
Touch to save the changes 
made.

Control Time

Group No. and group 
name

Temperature range
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(2) Touch the “Temperature range” button to display the 
settings screen.
Set the maximum and minimum temperatures for each 
group.
For example, if [Control Time] is set to [01:00 - 05:00] and 
“Temperature range” is set to [12°C - --°C] ([53°F - --°F]), 
heating operation starts automatically when the room 
temperature drops below the set temperature 12°C (53°F) 
between 1:00 and 5:00. When the Setback Control ends at 
5:00, the set temperature returns to the original setting, and 
the operation stops.

 Note:  The air conditioning units in the heating operation will stop and the set temperature will return to the original setting 
when the Setback Control period is over or the room temperature rises to the minimum temperature plus 3°C (6°F). 
Likewise, the air conditioning units in the cooling operation will stop and the set temperature will return to the original 
setting when the Setback Control period is over or the room temperature drops to the maximum temperature minus 3°C 
(6°F).

(3) Touch [Save Settings].

Room temp.
21°C (69°F)

Min. temp.
12°C (53°F)

Heat ON
21°C (69°F)

When the temperature drops below the minimum temperature (heating operation)

Heat OFF

Setback 
operation 
starts.

Setback Control period

Heat ON
12°C (53°F)

Setback 
operation 
ends.

3°C (6°F)

Heat OFF
21°C (69°F)

Max. temp.
28°C (83°F)

Room temp.
24°C (75°F)

Cool ON
24°C (75°F)

When the temperature rises above the maximum temperature (cooling operation)

Cool OFF

Setback Control period

Cool ON
28°C (83°F)

Cool OFF
24°C (75°F)

Setback 
operation 
ends.

3°C (6°F)Setback 
operation 
starts.
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5-4. Ventilation setting
5-4-1. Night purge

During summer, the Night purge function draws cooler outside air into the room to suppress temperature rises at 
night. This energy conservation reduces the load when air conditioning starts the next morning.

   Note:  During the Night purge operation, the ventilation units (LOSSNAY) operate in the Bypass mode.
   Note:  Night purge setting cannot be made from AE-200 for the ventilation units (LOSSNAY) that are connected to the AE-50/EW-50 

in communication error.
   Note:  Some models of ventilation units (LOSSNAY) do not support the Night purge function from AE-200. (As of October 2015, 

only LGH-RVX-E models support the function.) 
For more details about the Night purge function, refer to the Installation Manual, Instruction Book, or technical documents 
that are provided with the ventilation unit (LOSSNAY).

[1]  Night purge settings on the LCD
Log in to the Initial Settings menu, touch [Ventil. Settings] in the menu bar, and then touch [Night purge].
All ventilation unit (LOSSNAY) groups that support the Night purge function from AE-200 will appear.

(1) Touch one or more group icons whose settings are to be made, and then touch [Edit].

(2) In the [Night purge] section, select [Available] to enable the Night purge settings, make detail settings (days 
of the week, start time, end time, outdoor temperature threshold, temperature difference between room 
temperature and outdoor temperature, initial fan speed), and then touch [OK].
 Note:  When [Not Available] is selected in the [Night purge] section, the detail settings cannot be made.
 Note:  Touch [Cancel] to return to the previously saved settings without making any changes.

Edit

Night purge
[Available]/ 

[Not Available]  

Start Time

Outdoor temperature 
threshold

Temperature 
difference between 

room temperature and 
outdoor temperature

Days of the week

End Time

Initial fan speed
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Setting item Setting method Remarks

(1) Night purge
[Available]/[Not Available]

Touch [Available] to enable the 
Night purge settings, and [Not 
Available] not to.

(2) Days of the week

Touch one or more days on 
which the Night purge control is 
executed at the selected Start 
Time below.

<Example>
When the settings are made as follows, the 
Night purge control starts at 23:00 on Monday 
and ends at 6:00 on Tuesday.
 Days of the week: Monday
 Start Time: 23:00
 End Time: 6:00

 * If the [Edit] button is touched with the multiple group 
icons selected, all days of the week are selected 
when the settings window opens.

(3) Start Time
Touch   to set the time at 
which the Night purge control 
starts.

(4) End Time
Touch   to set the time at 
which the Night purge control 
ends.

(5) Outdoor temperature 
threshold

Touch   to set the outdoor 
temperature threshold value as 
a condition for activating the 
Night purge operation.

Touching  or  will increase or decrease the 
value in 1ºC increments.
The settable temperature is between 15ºC and 
30ºC.

(6) 
Temperature difference 
between room temperature 
and outdoor temperature

Touch   to set the 
temperature difference as a 
condition for activating the Night 
purge operation.

Touching  or  will increase or decrease the 
value in 1ºC increments.
The settable temperature is between 0ºC and 
7ºC.

(7) Initial fan speed
Touch   to set the fan 
speed to be set when the Night 
purge operation activates.

(Fan speed 1) (Fan speed 2) (Fan speed 3 or 4)

 * The maximum number of available fan speed setting 
from AE-200 is three.  
Auto cannot be set for the initial fan speed even for 
the units that support the Auto setting.  
The initial fan speed setting will not appear for the 
units with no fan speed switching function.

   Note:  Setting the “Night purge” setting to [Not Available] during the Night purge operation will stop the Night purge operation of the 
ventilation units (LOSSNAY).

   Note:  The settings changed from a local remote controller will be reflected on this screen.
   Note:  When [Not Available] is selected in the [Night purge] section, the detail settings (days of the week, start time, end time, 

outdoor temperature threshold, temperature difference between room temperature and outdoor temperature, initial fan 
speed) cannot be made.
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Night purge control time chart sample
The time chart when conditions below meet is as follows.

Starting condition
  Condition #1: LOSSNAY units stop at 20:00.
  Condition #2: Between the start time 1:00 (setting value 1) and the end time 6:00 (setting value 2)
  Condition #3:   LOSSNAY units detected the outdoor temperature threshold 17ºC (setting value 3) or higher in 

the past 24 hours.
  Condition #4: The current room temperature is higher than 22ºC.
  Condition #5:   The temperature difference between room temperature and outdoor temperature is greater than 

the temperature difference 5ºC (setting value 4).
• LOSSNAY units start the Night purge operation at 3:00 when the temperature difference between room 

temperature and outdoor temperature exceeds 5ºC.
• The Night purge operation is not activated at 1:00 or 2:00 because the temperature difference between room 

temperature and outdoor temperature is less than 5ºC.

Setting value 1

Setting value 3 Setting value 4

Setting value 2

Condition #3
Maximum outdoor 
temperature: 29ºC

Time

Temperature

Outdoor temp.

Room temp.

LOSSNAY ON

Condition #4
Room temp.: 25ºC

OFF

1:00
Temp. 

difference: 
2ºC

2:00
Temp. 

difference: 
4ºC

Condition #5
Temp. difference: 6ºC

Night purge 
operation OFF

22ºC

17ºC
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5-5. User Information
5-5-1. Maintenance User

On the [Maintenance User] screen, the user names and passwords of maintenance users can be changed.
Touch [User Info] in the menu bar, and then touch [Maintenance User].

   Note:  The Maintenance User settings are not be accessible if logged in as a building manager.
   Note:   The Maintenance User settings are required for each AE-200/AE-50/EW-50.

(1) To change the maintenance user name or password, touch the [User name], [Password], and [Retype 
password] buttons. Enter new information on the keyboard.
 Note:  The user name must contain only alphanumeric characters.
 Note:  The user name and password are case-sensitive.
 Note:  The user name must be in 20 characters or less, and the password in 3 to 10 characters.

(2) Touch [Save Settings].

Maintenance user name 
and password

User name and password 
can be changed.

Save Settings
Touch to save the changes 
made.
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5-5-2. Building Manager
On the [Building Manager] screen, the user names and passwords of building managers can be changed, and the 
available functions for building managers can be limited.
For example, you can allow building managers to change the group name settings when the tenant is changed, or 
disallow them to change the basic system settings such as unit settings or network settings.
Touch [User Info] in the menu bar, and then touch [Building Manager].

   Note:   The Building Manager settings are required for each AE-200/AE-50.

(1) To change the building manager’s user name or password, touch the [User name], [Password], and [Retype 
password] buttons. Enter new information on the keyboard.
 Note:  The user name must contain only alphanumeric characters.
 Note:  The user name and password are case-sensitive.
 Note:  The user name must be in 20 characters or less, and the password in 3 to 10 characters.

(2) Touch the functions to be made available for building 
managers. The selected functions will appear with an 
orange frame.
Touch again to deselect.
For more information on each function, refer to the table 
below.

 Note:  If the user logs in as a building manager, the currently 
available functions can be checked, but cannot be changed.

 Note:  The settings on this screen will not be reflected to the 
functions on the Web browser.

(3) Touch [Save Settings].

Building manager’s user 
name and password

User name and password 
can be changed.

Save Settings
Touch to save the changes 
made.

Available Functions
Select the available 

functions for building 
managers.
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Table. Available Function List

Function Content

Initial Settings

Date and time Refer to section 5-1-3 “Date and time” for details.
Unit Info. *1 Refer to section 5-1-4 “Unit Information” for details.
Advanced *1 Refer to section 5-1-12 “Advanced settings” for details.
Network *1 Refer to section 5-1-5 “Network” for details.

Groups
Group Name

Refer to section 5-1-6 “Groups” for details.
Group Structure *1

Interlock *1 Refer to section 5-1-7 “Interlocked LOSSNAY” for details.

Blocks
Block Name

Refer to section 5-1-8 “Blocks” for details.
Block Structure *1

Energy 
Management 
Blocks

Name
Refer to section 5-1-9 “EM Blocks” for details.

Structure *1

Floor layout
Floor Name

Refer to section 5-1-10 “Floor Layout” for details.
Floor Structure *1

Function1
Peak Cut

Setting Refer to section 5-2-1 “Peak Cut (Energy-save control function)” 
for details.Control details

Measurement Refer to section 5-2-2 “Measurement” for details.
Energy Management Refer to section 5-2-3 “Energy Management” for details.

Function2
Ext Temp Interlock Refer to section 5-3-1 “External Temperature Interlock” for details.
Setback Refer to section 5-3-2 “Night Setback Control” for details.

Ventilation 
setting Night purge Refer to section 5-4-1 “Night purge” for details.

*1 At factory shipment, these settings by the building managers are prohibited.
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6. Settings using Initial Setting Tool
6-1. Flow of the initial settings on Initial Setting Tool

Follow the procedures from step ③ onwards to make the initial settings for the apportioned electricity billing 
function.
As shown in flow ① below, settings data can be created beforehand at another location, such as office, to send it to 
the centralized controller on the day of the trial run.

*1 To change the existing AE-200/AE-50/EW-50 settings, make sure to save the settings file (collected from AE-200) before the change.
*2 After the settings data are loaded on the Initial Setting Tool and the changes are made, do not change the settings on the AE-200’s LCD or 

from the Web Browser for Initial Settings until you finish sending the setting changes data.
*3 The settings data created on the Initial Setting Tool cannot be loaded or written to the AE-200 using a USB memory.
*4 Store the settings files set on the Initial Setting Tool (pre-change data and post-change data) in a safe place.

Settings file
(collected from AE-200)

Initial settings (new registration)

Initial Setting Tool

③ When changing the settings

Collecting the settings data from AE-200

By the day 
before the trial 
run (at office)

① (When making the 
initial settings off-site)

Creating the settings 
data

Saving the settings data

On the day of 
the trial run 
(on-site)

② (When making the 
initial settings on-site)

Work on 
site can be 
reduced

Creating the settings 
data

Sending the settings data to AE-200

Saving the settings data

Settings file
(new settings data)

Initial Setting Tool
LAN

Sending the settings data via LAN *3

Saving the settings as pre-change data *1
Example: 20150401A.dat

LAN

Changing the settings

Loading the settings data via LAN *3

Saving the settings as post-change data *4
Example: 20150401B.dat

Sending the settings data to AE-200

Initial Setting Tool

Settings file
(Post-change data)

LAN

Sending the settings data via LAN *3

*2

On-site system check
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6-2. General descriptions of Initial Setting Tool
This section explains operation methods that are common to all setting screens of Initial Setting Tool.

6-2-1. Starting up the Initial Setting Tool

AE-200 Initial Setting Tool

The screen below will appear when the Initial Setting Tool is started up.

When [New] is clicked, all the settings in an unset status will be displayed.
When [Open] is clicked, the “Open” screen will be displayed. You can then select and load the settings file saved on 
the PC (filename.dat) which has been created beforehand. Once the settings file are loaded, the settings screen will 
be displayed with the settings in the file applied.

   Note:  When [Open] is clicked, the “Library” > “Documents” folder will be selected for the first time. Select the file saved on the 
Initial Setting Tool.

Open
Click to open the existing 

settings file

New
Click to newly create a 
settings file.
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6-2-2. Screen configurations and common items

Function Operation method Description

①

Tool bar Operations such as to create, save, 
load and send the settings files, and to 
monitor the status of the settings from the 
centralized controller are possible.

Refer to section 6-2-3 “List of tool bar 
operations”.

②

Tab Click the tab to switch between setting 
screens.
When the upper tabs are switched, the 
corresponding lower tabs will be displayed. 
Click the tab of which you want to make the 
settings.

When the “tab” of which you want to make 
the settings is clicked, settings screen will be 
displayed. Enter the settings data and then 
click [Save].

③

Target centralized 
controller

From the list of the centralized controllers 
with connection configuration set, select 
one to make the settings.
Settings are required for each centralized 
controller.

Depending on the settings screen, this may 
not be displayed.

④
Setting area The area in which settings are made. Refer to sections 6-3 “Basic settings”, 6-4 “Unit 

settings”, and 6-6 “Billing function settings” for 
how to make settings.

⑤

[Save] Click to save the settings in the Initial 
Setting Tool.

Even when [Save] is clicked, the settings data 
will not be sent to the AE-200/AE-50/EW-50. 
After all of the settings are completed, click 
[Send settings] in the tool bar to send it to the 
AE-200/AE-50/EW-50. Refer to section 6-2-3 
[5] “Send” for details. Note also that even when 
saved, the settings are still not been saved in 
a settings file. To save a settings file, click [File] 
> [Save] or [Save As...] in the tool bar.

⑥ [Back] Click to display the previous settings without 
making any changes.

① Tool bar

⑤ [Save] ⑥ [Back]

④ Setting area

② Tab (Upper)
(Lower)

③ Target centralized 
controller
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6-2-3. List of tool bar operations

[1]  New
Click [File] > [New] in the tool bar to create a new “settings file”.

[2]  Open
Click [File] > [Open] in the tool bar to load the “settings file” saved on the PC.

[3]  Save
Click [File] > [Save] or [Save As...] in the tool bar to save a settings file on the PC.

   Note:  After the settings are completed, save the settings file and store it in a safe place.
   Note:  The file will not be saved on the AE-200/AE-50/EW-50.

[4]  Data acquisition
Loads the AE-200/AE-50/EW-50 settings data on the Initial Setting Tool.

   Note:  When changing the AE-200/AE-50/EW-50 settings, make sure to select [Acquire data] first.

(1) Click [Basic Settings] > [System Configuration] and enter the IP address of the AE-200/AE-50/EW-50 from 
which the data is to be acquired. Then click [OK] at the bottom of the screen. (Refer to section 6-3-1 “System 
Configuration settings” for details.)

(2) Click [Data acquisition] > [Acquire data] in the tool bar.

(3) If the settings have been changed, a “Confirmation” screen will be displayed asking you to confirm the save 
operation. Select [Yes] to display the “Authentication information input” screen.

(4) Enter the maintenance user ID and password of the centralized controller from which the data is to be 
acquired. 
If the ID and password are the same as ones for the centralized controller No. 1, check the “Same as No.1” 
checkbox.

(5) Click [OK] to acquire the data of the settings on the centralized controller. The settings will then be applied 
on the Initial Setting Tool.
 Note:  If data acquisition fails, the settings on the centralized controller registered in “System Configuration” will not be 

applied to the settings on the Initial Setting Tool.  
Refer to section 6-3-1 “System Configuration settings”.

[5] Send
Sends the settings data to the centralized  
controller.

File
Creates, opens (loads) and saves 
settings files, and saves settings 
files with another name.

[4] Data acquisition
Acquires settings status of the 
centralized controller.

[8] Help
Displays the version of this software.

Option
Able to select the temperature display format 
and to output trial run check sheets.

[1]
[2]
[3]
[9]

[6]

[7]

Check box
Check the checkbox when the ID 
and password are the same as the  
ones for the centralized controller 
No. 1.

Password input
Enter the password for initial 
settings for the centralized 
controller.

Centralized controller system

Centralized controller name ID input
Enter the ID for initial settings for 
the centralized controller.
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[5]  Send
Click [Send] > [Send settings] in the tool bar to send all Initial Setting Tool settings to the centralized controller.

   Note:  This sends the settings data to all the centralized controller IP addresses set in “System Configuration” at once.
   Note:  Always check that all the items that require settings are entered and set before sending the data. Any items that are not set 

will be sent to all the centralized controllers as unset items.
   Note:  To change the settings, first save the acquired settings and make the setting changes before sending the settings data.

[6]  Temperature unit
Click [Option] > [Temperature] in the tool bar to select the temperature display format on the Initial Setting Tool from 
Celsius (°C) and Fahrenheit (°F).

   Note:  Switching between Celsius and Fahrenheit consists of changing the unit shown on the Initial Setting Tool and does not 
set the unit used on each of the centralized controllers. To change the unit shown on the centralized controllers, make the 
settings in “Unit of temperature” setting in [Basic Settings] > [Basic System].

[7]  Output - Check sheet for billing function trial run
Click [Option] > [Output - Check sheet for billing function trial run] in the tool bar to output the check sheet used for 
billing function trial runs.

   Note:  The check sheet will be output based on the settings on the Initial Setting Tool. 
If the settings on the AE-200/AE-50/EW-50 and the Initial Setting Tool are not the same, the billing function trial will not run 
correctly. Be sure to complete [5] “Send” before starting the trial run.

(1) Click [Option] > [Output - Check sheet for billing function trial run] in the tool bar.

(2) Click the pull-down menu (▼) for “Centralized controller” and select the number for the centralized controller 
to be output.
 Note:  This centralized controller number is the one set in section 6-3-1 “System Configuration settings”.

(3) Click the pull-down menu (▼) for “Output type” and select the [Items to be checked during the trial run] for 
the first trial run. For the second trial run, select [Items to be checked 10 days after the trial run]. For the 
third trial run, select [Items to be checked on the next day of the closing date].

(4) Click [Data Output].

(5) Set the file name and save destination and then click [Save].
 Note:  Refer to the Instruction Book (Apportioned Electricity Billing Function) for details of the check sheet.

[8]  Help
Click [Help] > [About] in the tool bar to display the version of the current Initial Setting Tool.

[9]  Exit
Click [File] > [Exit] in the tool bar to exit the Initial Setting Tool.

Close

Centralized controller
Output type

Data Output
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6-2-4. Unit address selection screen
On unit address selection screen and group registration screen displayed from the group settings screen, the 
selectable unit addresses and groups will be displayed.
When an icon is clicked and selected, the background will change to yellow-green. To deselect an icon, click 
the icon again and it will then turn into deselected status (the background will change to light gray). Click [OK] 
to complete the selections and close the screen. Click [Cancel] to cancel your selections and close the screen. 
Addresses and groups that have already been registered elsewhere will be in gray background and will not be able 
to be selected.
On unit address selection screen displayed from the group settings screen, an icon can be changed. To change 
an icon, click the left or right arrow. The selected icon will be displayed on the AE-200/AE-50’s LCD and in the 
AE-200/AE-50/EW-50 web browser.

Air conditioning unit (including A-control unit), LOSSNAY unit General equipment

System controller Remote controller AHC

Block settings Refrigerant system (indoor unit) settings, 
Interlocked LOSSNAY settings, AI controller 
settings

Refrigerant system (outdoor unit) settings

Energy management block settings PI controller settings Metering device settings

6-2-5. Other settings
• Up to 40 characters can be entered as the name on the basic system settings screen. Up to 20 characters 

can be entered as names in other setting screens.
• The following characters cannot be used for name settings: <, >, &, “, or ‘

Icon selection
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6-2-6. Preparation and flow of the Initial Setting Tool
To change the AE-200/AE-50/EW-50 settings (for systems with initial settings already made), make sure to first 
acquire data of the settings status using the Initial Setting Tool and then follow the procedure below. If you follow a 
different procedure, the settings may not be correctly made.

(1) Connect the AE-200/AE-50/EW-50 to a PC (the Initial Setting Tool) via a LAN.

(2) Start up the Initial Setting Tool.

(3) Click [New] or [Open].
To load a settings file stored on the PC, select [Open].
Otherwise, select [New].

(4) Register the IP address of the AE-200/AE-50/EW-50 in [Basic Settings] > [System Configuration].
Refer to section 6-3-1 “System Configuration settings” for details.

(5) Click [Data acquisition] > [Acquire data] in the tool bar to load the AE-200/AE-50/EW-50 settings information 
onto the Initial Setting Tool.
 * Enter the user ID and password for an AE-200/AE-50/EW-50 maintenance user.

(6) Click [File] > [Save As...] in the tool bar to save the pre-change initial settings data.
 Note:  For backup purposes, save the pre-change settings file under a file name such as “date + pre-change”.
 Note:  At this point, the settings will not be sent to the AE-200/AE-50/EW-50.

(7) Change the initial settings. Refer to sections 6-3 “Basic settings”, 6-4 “Unit settings”, and 6-6 “Billing 
function settings”.

(8) Click [File] > [Save As...] in the tool bar to save the settings data on the PC.
 Note:  Save the data using a different name to the pre-change settings file, such as “date + post-change”.
 Note:  At this point, the settings will not be saved on the AE-200/AE-50/EW-50.

(9) Click [Send] > [Send settings] to overwrite the AE-200/AE-50/EW-50 settings data registered in System 
Configuration settings.



99WT07627X01

6-3. Basic settings
6-3-1. System Configuration settings

Make the configuration settings of centralized controllers and expansion controllers on the Initial Setting Tool.
Click [Basic Settings] > [System Configuration] to access the system configuration settings screen.

   Note:  Connection settings can be made for up to 40 centralized controllers.  
AE-200 units set as the [AE-200 (Billing)] or [AE-200 (No M-NET)] will not be included in this 40 controllers.

(1) Click the “Controller type” pull-down menu (▼) and select [AE-200], [AE-200 (No M-NET)], [AE-200 (Billing)], 
or [EW-50].

(2) Enter the IP address in “Destination IP address”.

(3) Click the “Expansion controller” checkbox.

(4) Enter the IP address of the AE-50/EW-50 in “Destination IP address”.

(5) If there are multiple AE-200/EW-50 units, click the “Centralized controller” checkbox and repeat procedures 
1 to 4.

(6) Click [Save] after completing the settings.
 Note:  The selectable options vary depending on the type of centralized controller selected in the “Controller type” of 

Centralized controller.
 Note:  The AE-200/AE-50/EW-50 IP address cannot be changed in this setting screen.  

To set the AE-200/AE-50/EW-50 IP address, set on the AE-200/AE-50’s LCD, the web browser for initial settings, or 
the quick IP address setting switch (EW-50 only).

Controller type
Set the centralized controller  

type.

Centralized controller
Check the checkbox to add 

a centralized controller.
The checkbox of the first 

row is checked and cannot 
be unchecked.

Destination IP address
Set the IP address of the 

centralized controller.

Save
Click to save the settings.

Expansion controller
Check the checkbox to add 
an expansion controller.

Destination IP address
Set the IP address of the 
expansion controller.

Back
Click to display the previous 
settings without making any 
changes.
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6-3-2. Basic System settings
Click [Basic Settings] > [Basic System] to access the basic system settings screen.
Make necessary basic system settings such as unit settings and M-NET settings for each centralized controller.

[1]  Unit Settings
Set the AE-200/AE-50/EW-50 unit name and unit ID in “Unit Settings”.
Clicking [Acquire] will start communication with the AE-200/AE-50/EW-50 selected in “Target centralized controller”, 
and its serial number and software version will be displayed.

(1) Enter the unit name in “Name” in 40 characters or less. The name entered here will be used as a sender 
name in the error notification e-mail and e-mail alarm.

(2) Enter the unit ID in “Unit ID” in 6 figures. Use this setting to manage the multiple unit IDs.
 Note:  The unit name and the unit ID can be set for each centralized controller that can be selected in “Target centralized 

controller”.
 Note:  The name entered here will be displayed in “Target centralized controller”.
 Note:  The unit ID will be used as a sender ID in the error notification e-mail and e-mail alarm.
 Note:  When the software is updated, check that the ####(****) in “Software Version” is the same as the # of the update file 

(AExx_FW####_****.dat).  
For example, if the AE-200 software version is 7.30 (1.05), the update file name is “AE200_FW0730_0105.dat”.

Target centralized 
controller

Select the connected 
centralized controller whose 

basic settings are to be 
made.

Unit Settings
Set the centralized controller 
name and unit ID. The serial 

number and the software 
version can be acquired. 

Display Format
Set the screen display items 
for the centralized controller 

and the Web browser.

Save
Click to save the settings.

M-NET Settings
Set the M-NET address 
and range of prohibited 
controllers.

External Input Setting
Set the external signal input 
mode.

Back
Click to display the previous 
settings without making any 
changes.

Decimal point character 
and separator character 

for CSV file
Set the format of the CSV 
file that is output from the 

centralized controller. Advanced Setting
Click to display the screen 
for making advanced 
settings.
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[2]  M-NET settings

(1) Enter [0] in “M-NET Address” (unless otherwise specified).

(2) When the local remote controller operation is prohibited on the centralized controller, this setting determines 
the scope of its applicability. Select [SC/RC] to prohibit the operation from both the sub system controllers 
and the remote controllers. Select [RC Only] to prohibit the operation only from the remote controllers.

[3]  External Input setting
In “External Input Setting” column, set the external contact input function. Using a level signal or pulse signal of the 
external contact input function, the air conditioning units can be collectively controlled (e.g., stopped, operated) via 
a separately-sold external input/output adapter (PAC-YG10HA-E).

   Note:  Peak Cut control is performed based on the demand level signal (level 1 to 4) input from the connected demand controller.
   Note:  A separate license is required to use the Peak Cut function.
   Note:  The external input setting is required for each AE-200/AE-50/EW-50.

Important
 ● Refer to the AE-200 Installation Manual for details.

(1) Select one of the following options, referring to the AE-200 Installation Manual: [Demand (Level signal)/Not 
in use], [Emergency Stop (Level signal)], [ON/OFF (Level signal)], [ON/OFF/Prohibit/Permit (Pulse signal)].

[4]  Advanced Settings
Click [Advanced Setting] to open the advanced settings screen.

(1) Time Master/Sub

(1) In “Time Master”, select [Master] or [Sub]. When using two AE-200 units to operate and monitor the 
connected units, set to [Master] on only one AE-200, and set to [Sub] on the other AE-200.  
The date and time synchronization is performed from the AE-200 whose “Time Master” setting is set to 
[Master] to the AE-200 whose “Time Master” setting is set to [Sub].

Important
 ● When only one AE-200 unit is connected to the system, leave the default setting [Master] as it is.
 ● When multiple AE-50/EW-50 units are connected to the system, leave the default setting [Master] as it is on all 
AE-50/EW-50 units.
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(2) Schedule: Season setting

(1) In “Schedule: Season setting”, select [Available] to enable the seasonal settings of the weekly schedules 
and [Not Available] to disable. Unless otherwise specified, leave the default setting [Available] as it is.

(3) Old model compatibility mode

(1) In “Old model compatibility mode”, select [ON] or [OFF].  
Select [ON] when not using a Dual set point function and the Prohibit Remote Controller function (Timer, Air 
Direction, Fan Speed).  
When some of the connected indoor units support a Dual set point function and some do not, selecting [ON] 
will mean that they all do not support the function.  
When some of the connected indoor units support the Prohibit Remote Controller function (Timer, Air 
Direction, Fan Speed) and some do not, selecting [ON] will mean that they all do not support the function.

(4) Hold type

(1) In “Hold type”, select [Normal] or [Forced].  
The Hold function is a function to disable the operations that were scheduled for air conditioning unit 
groups. If the setting for [Hold] is set to [ON] on the Monitor/Operation screen and the “Hold type” on the 
screen above is set to [Forced], the [Hold] setting can be cancelled only from the AE-200/AE-50/EW-50. 
If the “Hold type” is set to [Normal], the [Hold] setting can be cancelled from AE-200/AE-50/EW-50, other 
system controllers, or remote controllers.

   Note:  The Hold function can be used on the AE-200A/AE-50A/EW-50A, but not on the AE-200E/AE-50E/EW-50E.
   Note:  The Hold function cannot be used on general equipments.
   Note:  The setting [Forced] will not be effective on Air To Water (PWFY) unit groups, LOSSNAY unit groups, and air conditioning 

unit groups that do not support the Hold function (i.e., Mr. Slim M-Series/P-Series indoor units).

[5]  Display Format
Set the items in “Display Format”.

(1) In “Unit of Temperature”, select the desired temperature unit.

(2) In “Pressure unit of measure”, select the desired pressure unit.

(3) In “Date Format”, select the desired display format for year, month, and date.

(4) In “Time Format”, select the desired display of time format.

(5) In “Group name display on Condition List screen”, select [ON] to display the group names under the icons 
on the Monitor/Operation screen. Select [OFF] not to display the group names.

(6) In “Filter Sign Display”, select [ON] to display the filter sign on the Monitor/Operation screen, and select [OFF] 
not to. 
When the “Filter Sign Display” is set to [OFF], the filter sign will not appear on the Monitor/Operation screen 
even when the indoor unit detects a filter cleaning signal. 
If the filter is regularly cleaned and the sign display is unnecessary, set it to [OFF].

(7) In “Room temperature”, select the desired temperature display option to be used on the Monitor/Operation 
screen. Select [Always show] to display the temperature at all times, [Show during operation] to display the 
temperature only during operation, and [Hide] not to display the temperature.
 Note:  Selecting [Show during operation] is recommended because the temperature shown may be higher than the actual 

temperature especially when the unit is stopped during the Heat mode.



103WT07627X01

(8) In “Occupancy sensor display”, make the Show/Hide setting for the occupancy/vacancy status that is 
detected by the built-in occupancy sensor on the ME remote controller (North America: PAR-U01MEDU, 
Other countries: PAR-U02MEDA).

Occupancy icon Vacancy icon

Select [Hide] not to display the occupancy/vacancy status on the Monitor/Operation screen. 
Select [Show occupancy icon] to display the occupancy icon when the sensor on the remote controller 
detects occupancy. 
Select [Show vacancy icon] to display the vacancy icon when the sensor on the remote controller detects 
vacancy. 
Select [Show both icons] to display the occupancy or vacancy icon according to the occupancy status of the 
room.
 Note:  If the ME remote controller has no built-in occupancy sensor, the occupancy/vacancy icons will not be displayed on 

the Monitor/Operation screen.

(9) In “Brightness sensor display”, make the Show/Hide setting for the brightness/darkness status that is 
detected by the built-in brightness sensor on the ME remote controller (North America: PAR-U01MEDU, 
Other countries: PAR-U02MEDA).

Brightness icon Darkness icon

Select [Hide] not to display the brightness/darkness icons on the Monitor/Operation screen. 
Select [Show bright icon] to display the brightness icon when the brightness level in the room reaches the 
predetermined brightness level. 
Select [Show dark icon] to display the darkness icon when the darkness level in the room reaches the 
predetermined darkness level. 
Select [Show both icons] to display the brightness or darkness icon according to the brightness/darkness 
level of the room.

(10) In “Humidity sensor display”, make the Show/Hide setting for the humidity reading of the built-in humidity 
sensor on the ME remote controller (North America: PAR-U01MEDU, Other countries: PAR-U02MEDA). 
Select [ON] to display the humidity reading on the Monitor/Operation screen.

[6]  CSV file format settings (separator character and decimal point character)
(1) Set the format of the AE-200 CSV file (apportioned results, charges calculation results from the Charge 

Calculation Tool).

Important
 ● This setting must be the same with the “Decimal point character for CSV file” and “Separator character for CSV file” 
settings on the [Advanced Settings] screen on the Charge Calculation Tool. If the settings are not the same, an error 
message “The CSV file format is not appropriate. Check the directory from which the CSV file is acquired.” will appear.

 ● When multiple AE-200 units are connected, make the same settings for all of them.

[7]  Saving the settings
Click [Save] after setting [1] to [6] above.

(Blue) (Gray)

(Yellow) (Gray)
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6-4. Unit settings
This section explains how to make unit settings on the Initial Setting Tool.

6-4-1. Group settings
 Note:  Each group can contain up to 16 air conditioners.
 Note:  Air conditioners (City Multi indoor unit), Air conditioners (A-control), LOSSNAY units, Air To Water (PWFY) units, HWHP (CAHV, 

CRHV) units, and general equipment groups cannot be combined in one group.
 Note:  When registering LOSSNAY units, do not combine the units that support 24-hour ventilation function or Night Purge function and 

the units that do not in one group.
 Note:  The addresses of the units that have been registered to other groups or used for the interlocked LOSSNAY settings, PI controller 

settings, or AI controller settings will appear with a gray background and cannot be selected.

(1) Click [Unit Settings] > [Groups] to access the group settings screen. 
Register the groups of air conditioning units, LOSSNAY units, LOSSNAY with heater/humidifier, Air To Water 
(PWFY) units, HWHP (CAHV, CRHV) units, general equipment, remote controllers, system controllers, or 
AHC to be connected to the AE-200/AE-50/EW-50.

(2) In “Group Name”, enter the group name in 20 characters or less.

(3) Click the icon in “Unit registration” (  ) to display the unit address selection screen.

(4) Select [Air-conditioners], [Air-conditioners (A-control)], [Air To Water], [HWHP], [LOSSNAY], or [General 
Equipment (via PAC-YG66DCA)].

(5) Select the address numbers of the units to be registered.

(6) When [General Equipment (via PAC-YG66DCA)] is selected, select the contact number that is connected to 
the general equipment to be registered.

(7) To change the icon, click the right or left arrow.
The selected icon will be displayed on the AE-200/AE-50’s LCD and on the AE-200/AE-50/EW-50’s 
Integrated Centralized Control Web.

(8) When [General Equipment (via PAC-YG66DCA)] is selected, make the setting to allow or disallow operation 
in “Allow Operations”.
Select [In batch and on individual group] to allow the operator to turn on or off the general equipment 
collectively or by the groups.
Select [On individual group] to allow the operator to turn on or off the general equipment by the groups. 
Select [No operations (Monitor only)] to disallow the operator to turn on or off the general equipment.

Group No.

Group name

Target centralized 
controller

Select the connected 
centralized controller whose 

group settings are to be 
made.

Save
Click to save the settings.

Unit registration
Click to display the screen 
for registering the air 
conditioners, Air To Water 
(PWFY) units, LOSSNAY 
units, LOSSNAY with heater/
humidifier, HWHP (CAHV, 
CRHV) units, and general 
equipment.

System controller 
registration
Click to display the screen 
for registering the system 
controllers.

Back
Click to display the previous 
settings without making any 
changes.

Remote controller 
registration
Click to display the screen 
for registering the remote 
controllers.

AHC registration
Click to display the screen 
for registering the AHC.
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(9) When [General Equipment (via PAC-YG66DCA)] is selected, in “Monitor”, select which status will be used 
to reflect the units’ ON/OFF status to the unit icons on the Monitor/Operation screen.  
Select [Output status] to use the status that is sent to the general equipment, and [Input status] to use the 
status that is sent from the general equipment.

(10) Click [OK] after completing the settings.

(11) Click the icon in “Remote controller registration” (  ) to display the unit address selection screen.

(12) Select the address numbers of the ME remote controllers to be registered, and click [OK].
 Note:  Each group can contain up to two ME remote controllers.
 Note:  Each group can contain up to four ME remote and system controllers combined.
 Note:  MA remote controllers do not need to be registered to a group.

(13) Click the icon in “System controller registration” (  ) to display the unit address selection screen.

(14) Select the address numbers of the system controllers to be registered, and click [OK].
 Note:  Each group can contain up to four ME remote and system controllers combined.

(15) Click the icon in “AHC registration” (  ) to display the unit address selection screen.

(16) Select the address number of the AHC to be registered, and click [OK].
 Note:  Each group can contain one AHC.

(17) Click [Save] to save the settings.
 Note:  Switch the “Target centralized controller” setting to make group settings for each centralized controller.
 Note:  The controllers to which [AE-200 (Billing)] or [AE-200 (No M-NET)] is set in section 6-3-1 “System Configuration 

settings” will not be displayed in “Target centralized controller”.
 Note:  Up to six general equipment can be registered for each DIDO controller (PAC-YG66DCA). Each contact counts as 

one unit.
 Note:  Each group can contain up to 16 general equipment. (Each contact counts as one unit.)
 Note:  To change the registered units to general equipment in the group to which air conditioners, LOSSNAYs, Air To Water 

(PWFY) units, HWHP (CAHV, CRHV) units, or LOSSNAYs with heater/humidifier are registered, unregister the 
air conditioners, LOSSNAYs, Air To Water (PWFY) units, HWHP (CAHV, CRHV) units, or LOSSNAYs with heater/
humidifier first.

 Note:  General equipment groups cannot include remote controllers or system controllers.
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6-4-2. Refrigerant System settings
Refrigerant system information (connection information of outdoor, sub outdoor, and indoor units) can be set.

(1) Click [Unit Settings] > [Refrigerant System] to access the refrigerant system settings screen.

(2) Click [Data acquisition] with the units properly connected to acquire the connection information from AE-200.

(3) Click the icon in “Outdoor unit registration” (  ) to display the unit address selection screen.

(4) Select the address number of the outdoor unit to be registered, and click [OK].

(5) Click the icon in “Sub outdoor unit registration” (  ) to display the unit address selection screen.

(6) Select the address number of the sub outdoor unit to be registered, and click [OK].

(7) Click the icon in “Indoor unit registration” (  ) to display the unit address selection screen.

(8) Select the address number of the indoor unit to be registered, and click [OK].

(9) Click [Save] to save the settings.
 Note:  Ensure that these settings match the actual connection status. Also open [Initial Settings] > [System View] screen on 

the AE-200’s LCD and check that the settings are the same. If the settings are not the same, the charges will not be 
properly calculated.

 Note:  If A-control units are group registered, the addresses of the A-control units will be displayed under “Indoor unit” or 
“Outdoor unit”.

 Note:  If a “warning message” appeared during [Data acquisition], there may be an error in the air conditioner connection 
information and in the group setting, PI controller setting or AI controller setting on the Initial Setting Tool.  
Review the settings on the Initial Setting Tool and then try the data acquisition again.

 Note:  Adding or deleting the information on this screen will not change the actual refrigerant system.
 Note:  Not all the refrigerant system information may be acquired depending on the centralized controller’s start-up 

condition. In this case, add or change the information on this screen.
 Note:  If the displayed information acquired from the centralized controller differs from the actual system, restart the 

centralized controller or check the air conditioning units.

Outdoor unit registration
Click to display the screen 
for registering the outdoor 

units.

Data acquisition
Click to acquire the 

connection information 
of the actual unit from 

AE-50/EW-50 and replace 
the settings. 

Target centralized 
controller

Select the connected 
centralized controller whose 

refrigerant system settings 
are to be made.

Save
Click to save the settings.

Indoor unit registration
Click to display the screen 
for registering the indoor 
units.

Sub outdoor unit 
registration
Click to display the screen 
for registering the sub 
outdoor units.

Back
Click to display the previous 
settings without making any 
changes.
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6-4-3. Interlocked LOSSNAY settings
The ON/OFF status of the LOSSNAY or LOSSNAY with heater/humidifier can be interlocked with the operation of 
indoor units.

   Note:  The ON/OFF status of the indoor units are not interlocked with the ON/OFF status of the LOSSNAY unit.

(1) Click [Unit Settings] > [Interlocked LOSSNAY] to access the interlocked LOSSNAY settings screen.

(2) Click the icon in “Interlocked LOSSNAY registration” (  ) to display the unit address selection screen.

(3) Select the address number of the LOSSNAY to be interlocked, and click [OK].

(4) Click the icon in “Interlocked indoor unit registration” (  ) to display the unit address selection screen.

(5) Select the address number of the indoor units with whose operations are to be interlocked, and click [OK]. 
Each LOSSNAY can be interlocked with up to 16 indoor units.

(6) Click [Save] to save the settings.

Interlocked LOSSNAY  
registration

Click to display the screen 
for registering the LOSSNAY 

unit to be interlocked.

Save
Click to save the settings.

Interlocked indoor unit 
registration
Click to display the screen 
for registering the indoor 
units with whose operations 
are to be interlocked.

Back
Click to display the previous 
settings without making any 
changes.



108WT07627X01

6-4-4. Block settings
By making block settings, multiple groups in a given block can be collectively monitored or operated on the AE-200’s 
LCD and the Integrated Centralized Control Web.

(1) Click [Unit Settings] > [Blocks] to access the block settings screen.

(2) In “Block Name”, enter the block name in 20 characters or less. 
The name entered here will be displayed on the LCD and the Integrated Centralized Control Web.

(3) Click the icon in “Group registration” (  ) to display the group selection screen.

(4) Select the group numbers to be registered, and click [OK]. 
(To show the group name, move the cursor to the group number.)

(5) Click [Save] to save the settings.

Block No.

Save
Click to save the settings.

Group registration
Click to display the screen 
for selecting groups.

Back
Click to display the previous 
settings without making any 
changes.

Target centralized 
controller

Select one of the connected 
centralized controllers 

whose block settings are to 
be made.

Block name
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6-4-5. Energy management block settings
Make the settings for the energy management block (tenant) used as collective unit for the apportioned electricity 
billing function.

[1]  General descriptions

(1) What is energy management block (tenant)?

• An energy management block (tenant) is the unit used for displaying and outputting charge calculation 
results.

• An energy management block (tenant) is a collection of operation blocks.
• An operation block is a collection of groups.

(2) LOSSNAY (including LOSSNAY with heater and humidifier) settings

Make the settings based on the LOSSNAY system configuration.

Usage Energy management block setting method

LOSSNAY (without 
heater and 
humidifier)

LOSSNAY groups only To apportion the electric energy, set as energy 
management block (tenant).

Interlocked with the operation of indoor 
units

No settings are required (cannot be set).

 Note:  The LOSSNAY electric energy will be 
apportioned based on the operating status 
of the interlocked indoor units.

LOSSNAY with 
heater and 
humidifier

LOSSNAY groups only Set as energy management block (tenant).
Interlocked with 
the operation of 
indoor units

When interlocked with 
the operation of same 
tenant’s indoor units

Set as same energy management block (tenant) 
as the interlocked indoor units.

When interlocked with 
the operation of multiple 
tenants’ indoor units

Make the settings in one of the following ways:

<Method 1>
Set as independent energy management block 
(tenant) and invoice the electricity charges by 
including it to common area charges, etc.

<Method 2>
Exclude these units from the tenant settings.
In this case, the electric energy for LOSSNAY units 
with heater/humidifier will be apportioned based on 
the operating status of the interlocked indoor units.

Energy management block

AE-200 EW-50

Operation block

Group

Group

Operation block

Group
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[2]  Energy management block settings

(1) Click [Unit Settings] > [Energy Management Block] to access the energy management block settings 
screen.

(2) In “Energy management block name”, enter the energy management block number in 20 characters or less.
 Note:  By setting the same name for the energy management blocks that are connected to different AE-200 units, the 

calculation results can be merged. 
Refer to the Instruction Book (Apportioned Electricity Billing Function) for details.

(3) Click the icon in “Member block registration” (  ) to display the member block selection screen.

(4) Select one of the controllers ([AE200], [Exp1] through [Exp4]) of the member block to be registered.

(5) Select the block number of the member block to be registered, and click [OK].
 Note:  To show the block name, move the cursor to the block number.

(6) Click the icon in “Member LOSSNAY with heater/humidifier registration” (  ) to display the unit address 
selection screen.

(7) Select the controller ([AE200], [Exp1] through [Exp4]) of the LOSSNAY with heater/humidifier to be 
registered.

(8) Select the unit address of the LOSSNAY with heater/humidifier to be registered, and click [OK].
 Note:  To show the block name, move the cursor to the block number.

(9) Click [Save] to save the settings.

Energy management block 
No.

Save
Click to save the settings.

Member block registration
Click to display the screen 
for selecting member blocks.

Back
Click to display the previous 
settings without making any 
changes.

Target centralized 
controller

Select one of the connected 
centralized controllers 

whose energy management 
block settings are to be 

made.

Member LOSSNAY 
with heater/humidifier 
registration
Click to display the screen 
for selecting LOSSNAY with 
heater/humidifier.
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6-4-6. PI controller settings
To use metering device on the centralized controller, follow the instructions below to register PI controllers (PAC-
YG60MCA) and to make measurement settings.

   Note:  The maximum settable number of PI controllers for each centralized controller is 15. The maximum number of connectable 
PI controllers in an AE-200 system is 20.

   Note:  A separate license is required to use the Peak Cut function using the measurement values.
   Note:  Only the addresses that have not been registered on the group, interlocked LOSSNAY, or AI controller setting screens are 

available for selection.

(1) Click [Unit Settings] > [PI Controller] to access the PI controller settings screen.

(2) Click the icon in “PI controller registration” (  ) to display the unit address selection screen.

(3) Select the address number of the PI controller to be registered.
When a built-in Pulse Input (PI) of AE-200/AE-50/EW-50 is used, select [PI].

(4) In “Metering device name” (Ch1 to Ch4), enter the metering device name in 20 characters or less.

(5) Enter the pulse weight and select the measurement unit.
 Note: The measurement unit can be selected from [kWh], [m3], [MJ], or [--(no unit)].
 Note: When not using a metering device, leave the pulse weight blank and select [--(no unit)] for the measurement unit.

(6) Click [Save] to save the settings.

Important
 ● Set the pulse weight according to the metering device to be used. To ensure proper settings, first check the value 
measured by the metering device and the value counted by the built-in Pulse Input (PI) of AE-200/AE-50/EW-50 or the PI 
controller. Then, after a certain time, check that both values have increased by equal values. (The values that the built-
in Pulse Input (PI) of AE-200/AE-50/EW-50 or the PI controller counts can be checked on the LCD and the Integrated 
Centralized Control Web.

PI controller registration
Click to display the screen 

for registering PI controllers.

Save
Click to save the settings.

Pulse Weight

Back
Click to display the previous 
settings without making any 
changes.

Target centralized 
controller

Select one of the connected 
centralized controllers 

whose PI controller settings 
are to be made.

Metering device name

Measurement unit
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6-4-7. AI controller settings
To use temperature and humidity sensors, follow the instructions below to register AI controllers (PAC-YG63MCA) 
and to make measurement settings.

   Note:  Only the addresses that have not been registered on the group, interlocked LOSSNAY, or PI controller setting screens are 
available for selection.

(1) Click [Unit Settings] > [AI Controller] to access the AI controller settings screen.

(2) Click the icon in “AI controller registration” (  ) to display the unit address selection screen.

(3) Select the address number of the AI controller to be registered, and click [OK].

(4) Enter the name of the sensor in 20 characters or less.

(5) Select a temperature sensor icon (  ) or humidity sensor icon (  ) for Ch1 and Ch2 respectively. “Not 
in use” can also be selected.

(6) Enter the measurable range of the sensor.
When the Pt sensor is connected, the range must be between -30ºC (-22ºF) and +60ºC (+140ºF).  
When the sensors other than the Pt sensors are connected, enter the ranges that are described in the 
operation manuals of the sensor.

(7) To receive an e-mail alarm when the temperature or the humidity exceeds certain predetermined values, set 
the ON- and OFF-thresholds for both the upper and lower limit temperatures. 
To avoid frequent ON/OFF cycling, the minimum differential between the ON- and OFF-threshold values 
should be 1ºC (2ºF).

(8) Click [Save] after completing the settings.

AI controller registration
Click to display the screen 

for registering AI controllers.

Save
Click to save the settings.

Measurement setting

Back
Click to display the previous 
settings without making any 
changes.

Target centralized 
controller

Select one of the connected 
centralized controllers 

whose AI controller settings 
are to be made.

Selection of 
temperature or humidity 

sensor icon

Sensor name

Acquire

Measurable range
Upper/lower ON- and 
OFF-threshold settings 
for e-mail alarm function

Upper limit
(ON-threshold)

Upper limit
(OFF-threshold)

Lower limit
(OFF-threshold)

Lower limit
(ON-threshold)
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[1]  Offsetting the measured temperature/humidity values
To set the offset value for the measured values, click [Acquire] to acquire the current value, and set the offset value 
according to your usage environment.

   Note:  If AI controller connection settings for a given centralized controller have not been saved, the “measurement value” will not 
be displayed even when [Acquire] is clicked.

   Note:  When registering an AI controller for the first time, the “measurement value” cannot be acquired. To input the “offset value” 
after acquireing and checking the “measurement value”, once the setting information must be sent to the centralized 
controller. After registering the AI controller and temperature/humidity sensors, send the settings data to the centralized 
controller. (See section 6-2-3 [5] “Send”.)

   Note:  The default offset value for temperature sensor is “0.0”. The settable offset value range is between -10.0ºC (-18.0ºF) and 
+10.0ºC (+18.0ºF).

   Note:  The default offset value for humidity sensor is “0.0”. The settable offset value range is between -10.0% and +10.0%.
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6-5. Floor Settings
6-5-1. Floor settings for LCD

The floor layout on the floor display under the [Monitor/Operation] menu on the LCD can be set and changed, and 
the display position of the group icons on the floor can be changed.
Click [Floor Settings] > [Floor] to access the LCD’s floor settings screen.

(1) In [Target centralized controller], select a target centralized controller.
The floor level settings for the selected centralized controller will appear.
 Note:  The target centralized controller No. is the number shown in 6-3-1 “System Configuration settings”. The controller name  

is the name registered in unit settings in Basic System settings.

(2) Click [Edit] in [Total Floors] to display the “Total number of floors setting” screen.

(3) Set the total number of floors by entering the number on the keyboard or by clicking   buttons.

(4) In [Floor Layout], select the floor layout to be used.
 Note:  If the total number of floors is set to “0,” all groups will appear as unassigned groups.
 Note:  Up to ten floors can be registerted. 

The display range of the area on the Floor Layout screen vary, depending on the selected floor layout.

Floor layout Display area Floor layout Display area

(5) In [Floor level name], enter the floor level name in 3 alphanumeric or symbol characters or less.

(6) In [Floor name], enter the floor name in 20 alphanumeric or symbol characters or less.

(7) To read a floor plan file, click [Import] and select a file. Refer to the table below for the restrictions on the floor 
plan files to be imported. Click [Clear] to delete the imported floor plan file.

Total Floors

Floor Layout

Target centralized 
controller

Floor level name

Floor name

Import floor plan

Clear floor plan

Floor plan image

Back

Save

Total number of floors

OK

Cancel
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Restrictions on the floor plan files to be read

File size

900 (height) × 1890 (width) dots for each floor plan
 Note:  The file size must be 900 (height) × 1890 (width) dots regardless of the display range of the area. (Even 

when the floor layout shows only one display area, the file size must be 900 (height) × 1890 (width) 
dots. In this case, create a file plan only in the left top area.)

File capacity Max. 600 KB for each floor plan

File format
gif
 Note:  Files that contain extension data (metadata such as XMP, transparent GIF, interlace GIF, animated GIF) 

cannot be read.

Available colors 
(RGB) to be 
used in the file

R G B R G B R G B R G B
224 71 72 101 112 150 130 150 153 176 255 185
221 151 152 126 137 176 105 134 135 238 255 240
81 66 81 142 149 175 37 96 86 154 255 163
105 89 105 175 180 199 204 214 211 198 255 203
17 16 17 33 77 225 48 64 59 106 255 116
51 42 52 37 83 234 250 255 253 137 255 144
27 23 30 39 86 240 227 255 243 226 252 227
165 145 185 41 89 245 241 255 248 124 233 125
33 37 57 42 92 249 237 249 243 250 255 250
2 17 85 46 93 246 67 97 79 167 229 166
6 35 160 23 47 124 59 78 66 107 145 104
6 28 122 63 104 238 61 116 80 182 211 180
9 40 168 77 116 241 85 128 100 23 95 15
12 45 176 99 137 255 154 177 162 149 211 141
154 162 194 126 146 214 14 45 24 128 140 126
211 214 227 149 170 235 59 93 70 95 202 74
15 49 182 70 79 108 178 187 181 194 231 186
17 53 188 179 189 222 46 181 88 147 169 142
20 57 195 191 202 230 59 157 90 41 177 3
24 64 205 192 210 241 90 213 129 166 203 154
17 46 149 163 170 180 214 255 225 208 224 202
21 52 163 236 242 250 224 239 228 219 235 211
28 70 215 159 185 210 129 155 135 172 187 164
32 64 178 144 154 162 178 194 182 203 211 197
45 80 204 204 228 245 115 255 143 241 244 238
44 75 190 112 183 219 99 193 117 199 201 195
55 90 213 126 139 145 182 201 185 110 114 98
69 99 205 214 241 251 59 255 88 127 129 119
99 122 202 159 240 253 19 255 48 210 211 196

R G B R G B R G B R G B
255 253 185 179 159 1 225 148 50 195 195 195
193 193 150 172 169 147 214 159 89 193 193 193
255 255 221 187 185 169 77 76 75 191 191 191
121 121 106 179 177 162 230 211 206 189 189 189
162 162 147 205 203 187 207 203 202 185 185 185
142 142 129 224 222 206 225 197 192 179 179 179
94 94 89 212 201 139 225 8 8 173 173 173
212 212 203 136 134 122 221 179 179 171 171 171
235 235 227 158 156 143 152 151 151 169 169 169
213 213 207 217 215 202 255 255 255 166 166 166
203 203 198 230 228 216 250 250 250 161 161 161
137 137 134 142 128 71 249 249 249 154 154 154
116 116 114 254 246 220 246 246 246 148 148 148
245 245 242 244 237 215 243 243 243 143 143 143
85 85 84 33 25 2 241 241 241 133 133 133
121 121 120 111 110 107 239 239 239 129 129 129
253 253 252 63 43 4 236 236 236 103 103 103
119 117 23 106 104 100 232 232 232 82 82 82
255 253 143 133 132 130 228 228 228 70 70 70
253 241 7 116 79 14 225 225 225 64 64 64
174 173 157 254 251 246 220 220 220 58 58 58
208 195 0 255 151 0 217 217 217 51 51 51
220 210 64 93 61 13 215 215 215 44 44 44
156 153 113 254 221 171 211 211 211 41 41 41
201 199 175 157 97 18 209 209 209 34 34 34
151 150 136 211 205 197 207 207 207 4 4 4
187 175 71 205 128 31 205 205 205 0 0 0
195 193 175 187 116 28 202 202 202 255 170 63
198 197 187 219 138 35 198 198 198 255 203 131

 * Use the colors in the table above, otherwise the floor plan will appear in different colors.
 * The default background color is RGB [103, 103, 103].

(8) Click [Save] to save the settings.

630 dots

450 dots

1890 dots

900 dots
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6-5-2. Floor Layout settings for LCD
Click [Floor Settings] > [Floor Layout] to access the LCD’s floor layout settings screen.

[1]  Assigning groups
(1) Click [Assignment mode].

(2) Select a target centralized controller.

(3) In [Floor switching], select a floor to set the layout.

(4) Switch between display areas by scrolling up/down, and left/right.

(5) Select the controller managing the group to assign. (EW-50 cannot be selected.)

(6) Select the group number to assign.

 Note:   (green) indicates a selected group,   (dark gray) an assigned group, and   (light gray) a selectable group.

(7) Click on the floor plan image to assign the group.
 Note:  If assigning group icons overlappedly, groups having higher group number are placed above.

(8) Click [Save] to save the changes.

[2]  Moving groups within areas
(1) Click [Assignment mode].

(2) Click the group icon you wish to move within the display area, and this will become selected (with orange 
frame).
 Note:  Before clicking the group icon, placing a check mark in “Assign with gridline” to select (  ) will allow assignment of 

the group icons at a set interval.  
Additionally, removing this check mark (  ) will allow fine assignment of group icons.

(3) Click again in the location to move to in order to confirm the group icon positions.

(4) Click [Save] to save the changes.

[3]  Deleting groups
(1) Click [Deletion mode].

(2) Click the assigned group icon, and this will return to the selectable group.

(3) Click [Save] to save the changes.
 Note:  Up to 30 groups can be assigned to each area. If the layout is 2 (height) × 3 (width), up to a maximum of 180 groups 

can be assigned on each floor.
 Note:  Groups that have not been assigned to any area will appear in “Unassigned groups” on the LCD.

Floor switching

Groups to be assigned

Target centralized 
controller

Assign with gridline

Assigned group

Selected group

Floor plan image

Back

Save

Group name
Centralized controller 

switching

Assignment mode/
Deletion mode
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6-5-3. Floor settings for Integrated Centralized Control Web
Configure floor-related settings for when monitoring and operating air conditioning units with centralized controllers 
using the Integrated Centralized Control Web. Logging in to the centralized controller set as the login destination 
using a Web browser enables monitoring and operating of all air conditioning units connected to the managing 
centralized controller using the Integrated Centralized Control Web.

Here, use the Integrated Centralized Control Web to configure the managing centralized controller, floor level, floor 
name and other floor settings, and the floor plan settings.

Integrated Centralized Control Web login destination

Integrated Centralized 
Control Web

Wireless LAN router

Login

LAN

Tablet

AE-200

AE-200/EW-50

AE-200/EW-50

AE-200/EW-50

AE-200

Max. 50 units

Max. 50 units

Max. 50 units

Max. 50 units

Max. 50 units

Air conditioning units that can be used on the 
Integrated Centralized Control Web 

Floor setting

Floor name

Floor plan
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(1) Click [Floor Settings] > [Floor for Integrated Centralized Control Web] to access the Integrated Centralized 
Control Web’s floor settings screen.

(2) In [Target centralized controller], select a target centralized controller.
The setting contents of the selected centralized controller will appear.

(3) In [Total number of floors setting], set the total number of floors to be displayed on the Integrated Centralized 
Control Web.
Click [Edit] in [Total Floors], and set the total number of floors by entering the number on the keyboard or by 
clicking   buttons.
Up to 99 floors can be set. In the Integrated Centralized Control Web, floors can be divided up into 10 floor 
units and displayed.
 Note:  If the total number of floors is set to “0,” all groups will appear as unassigned groups.

(4) In [Managed centralized controller], set the centralized controllers to be managed with the Integrated 
Centralized Control Web.
Centralized controllers and expansion controllers set in section 6-3-1 “System Configuration settings” will 
appear.
The centralized controller with a check mark (  ) next to [Manage] will be a control target of Integrated 
Centralized Control Web. Even if only one AE-200 is shown with a check mark (  ) in gray, settings and 
reflecting the settings on the Initial Setting Tool is required.
 Note:  Any centralized controller without a check mark (  ) is not a control target of Integrated Centralized Control Web.

Total number of floors 
setting

Target centralized 
controller

Copy floor settings

Import

Floor name setting

Floor plan image

Back
Save

Managed centralized 
controller

Floor No. Floor level name setting

Number of floors: 0 to 10 Number of floors: 41 to 50 Number of floors: 91 to 99

Display area switching
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(5) In [Floor name setting], set the floor level name and floor name to be displayed on the floor layout.
Enter the floor level name in 3 alphanumeric or symbol characters or less.
Enter the floor name in 20 alphanumeric or symbol characters or less.

(6) In [Floor plan image], import a floor layout image and configure settings.
Click [Import] and select a file to import.
To delete the imported floor layout image, click [Clear].
 Note:  Floor layout images other than the following file sizes and file formats cannot be read.

Floor layout size Between 450 (height) × 630 (width) and 900 (height) × 1890 (width) dots
File format gif
File capacity Max. 600 KB for each floor plan

(7) After the settings are completed, click [Save].
 Note:  Adjusting the floor name settings enables application in managing multiple buildings.

Floor level name Floor name

Example) To manage three buildings A to C, configure the floor settings as follows.

Building A
8 floors

Setting contents
 Total number of floors: 25
 Floor level name: No. 1 = A, No. 11 = B, No. 21 = C
 Floor name:   No. 1 to No. 8 = 1F **** to 8F ***** 

No. 11 to No. 20 = 1F **** to 10F ***** 
No. 21 to No. 25 = 1F **** to 5F *****

Building B
10 floors

Building C
5 floors
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6-5-4. Floor Layout settings for Integrated Centralized Control Web
Assign the air conditioning unit icons to display on the Integrated Centralized Control Web floor layout.

   Note:  Assignment of unit groups registered in the centralized controllers selected as “Managed centralized controller” on the “Floor 
for Integrated Centralized Control Web” screen is possible.

(1) Click [Floor Settings] > [Floor Layout for Integrated Centralized Control Web] to access the Integrated 
Centralized Control Web’s floor layout settings screen.

(2) In [Target centralized controller], select a target centralized controller.
 Note:  Make sure to select a target centralized controller set in section 6-5-3 “Floor settings for Integrated Centralized Control 

Web”.

(3) In [Floor switching], select a floor to which the unit groups are assigned.
The floor layout set in section 6-5-3 “Floor settings for Integrated Centralized Control Web” will appear.

(4) In [Centralized controller switching], select a centralized controller of the unit group to assign.

(5) In [Groups to be assigned], select a unit group to assign.

(6) In the floor layout in [Assignment area], assign unit group icons.

Air conditioning unit group
Assign on the floor plan 
image.

Floor switching

Groups to be assigned

Target centralized 
controller

Assign with gridline
Selecting this enables 
movement in grid units.

Save

Back

Group name

Centralized controller 
switching

Assignment mode/
Deletion mode

Scroll bar

Assignment area
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(7) After the settings are completed, click [Save].
 Note:  Up to 180 unit group icons can be assigned in each floor layout.
 Note:  When no floor layout is registered, a white floor will appear.
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6-5-5. Convenient usage methods
[1]  Matching the AE-200’s LCD and the Integrated Centralized Control Web floor layout
Use the Integrated Centralized Control Web to configure the settings to use the floor layout which is the same as on 
the LCD.

   Note:  On the LCD, the floor layout image is divided for display, however on the Integrated Centralized Control Web, it is not divided 
for display.

(1) Carry out LCD floor settings. 
Configure the 6-5-1 “Floor settings for LCD” and 6-5-2 “Floor Layout settings for LCD” settings for the target 
centralized controller.

(2) Configure the floor settings for the Integrated Centralized Control Web. 
From [Floor Settings], click [Floor for Integrated Centralized Control Web], and from [Target centralized 
controller], select the centralized controller set in (1) above.

(3) Click [Copy floor settings] and select [Floor and floor layout settings].

(4) Click [OK].
The settings details for 6-5-1 “Floor settings for LCD” and 6-5-2 “Floor Layout settings for LCD” for the 
centralized controller set in (1) above are copied to the 6-5-3 “Floor settings for Integrated Centralized Control 
Web” and 6-5-4 “Floor Layout settings for Integrated Centralized Control Web”.

  Note:  Even if the floor layout settings for LCD are other than 2 (height) × 3 (width) layout, the copied Web floor plan size will be 900 
(height) × 1890 (width). When handling a floor layout of other than 2 (height) × 3 (width), we recommend that this be replaced 
with a floor plan that has unnecessary areas cut away for Web use.

LCD Integrated Centralized Control Web

Select a centralized controller set in 
“Floor settings for LCD.”

Copy floor settings
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[2]  Creating the login destination centralized controller for backup
Multiple login destinations can be set for the Integrated Centralized Control Web. 
By copying the login destination centralized controller floor settings and preparing a backup centralized controller, 
then if the login destination centralized controller malfunctions, it is possible to use the Integrated Centralized 
Control Web by logging in to the backup centralized controller.

  Note:  Air conditioning unit groups managed by a malfunctioning centralized controller are not covered by monitoring and operation. 
In the event of a malfunction, promptly replace with a new product and configure.

(1) Add an IP address of the backup centralized controller in 6-3-1 “System Configuration settings”.

(2) Configure the centralized controller to be normally logged in. 
Configure the 6-5-3 “Floor settings for Integrated Centralized Control Web” and 6-5-4 “Floor Layout settings for 
Integrated Centralized Control Web” settings for Integrated Centralized Control Web login destination target 
centralized controller.

(3) From [Floor Settings], click [Floor for Integrated Centralized Control Web], and from [Target centralized 
controller], select the backup centralized controller.

Normally logged-in centralized controllerWireless LAN router

Normally 
logged-in

LAN

Tablet

AE-200

AE-200/EW-50

AE-200/EW-50

AE-200/EW-50

AE-200

Backup centralized controller

Max. 50 units

Max. 50 units

Max. 50 units

Max. 50 units

Max. 50 units

Backup log-in

Malfunction

Target centralized controller for the normally logged in centralized 
controller

Target centralized controllers for the backup centralized 
controller

Select the backup centralized controller.

Copy floor settings
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(4) Click [Copy floor settings], select [Floor and floor layout settings for Integrated Centralized Control Web], and 
select a centralized controller set in (1).

(5) Click [OK].
The settings details for 6-5-3 “Floor settings for Integrated Centralized Control Web” and 6-5-4 “Floor Layout 
settings for Integrated Centralized Control Web” for the centralized controller set in (1) above are copied to the 
backup centralized controller.

6-6. Billing function settings
Configure the billing function settings on the Initial Setting Tool. For details about the billing function settings, refer to 
the Instruction Book (Apportioned Electricity Billing Function).

Copy from
Select a centralized 
controller to be normally 
logged in.
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7. Settings using Web Browser for Initial Settings
7-1. Initial Settings

This section explains how to set the initial settings on the Web Browser for Initial Settings.
   Note:  When one or more AE-50/EW-50 controllers are connected, initial settings must be made on each AE-50/EW-50’s Web 

browser. However, only Date and Time settings (section 7-1-1 “Date and Time”) and Basic System settings (section 7-1-2 
“Basic System”) must be made on the AE-200 Web browser.

Important
 ● If the system is connected to a TG-2000A, make or change all settings from the TG-2000A so that the data in the 
TG-2000A and AE-200 will match.

 ● Any control (such as interlock control or Peak Cut control) between the outdoor and indoor units connected to the AE-200, 
AE-50, and EW-50, as well as between the units connected to different AE-50/EW-50 controllers, cannot be performed.



126WT07627X01

7-1-1. Date and Time
Click [Initial Settings] in the menu bar, and then click [Date and Time] to access the date and time settings screen.
Set the current date and time, and then click [Save Settings].

   Note:  The date and time settings may not be accessible if logged in as a building manager.
   Note:  The date and time settings made on this screen will be reflected on all the units in the M-NET system, all connected 

AE-50/EW-50 units, and the AE-200 units whose [Time Master] setting is set to [Sub].
   Note:  The date and time cannot be set on this screen if the [Time Master] setting is set to [Sub].
   Note:  The daylight saving time setting is required only on the AE-200.
   Note:  Changing the date and/or time when the charging function is in use can affect the calculation of the charges.
   Note:  When AE-50/EW-50 controller, DIDO controller (PAC-YG66DCA), AI controller (PAC-YG63MCA), or PI controller (PAC-

YG60MCA) is added to the system, set the current date and time on this screen to synchronize the date and time on the 
added controller.

   Note:   Although date and time settings can be made on each AE-50/EW-50, the date and time synchronization from AE-200 is 
performed once a day. Make the date and time settings on the AE-50/EW-50 only after the AE-50/EW-50 is replaced.

(1) Enter the current date and time.

(2) To adjust the daylight saving time automatically, check the [Automatically adjust clock for daylight saving 
changes] checkbox, and select the applicable country in the pulldown menu.

If the applicable country is not in the pulldown menu, select [Custom Settings] instead. A [Custom Settings] 
button will appear on the right of the pulldown menu.
Click the [Custom Settings] button to open the Custom Settings screen, and configure the daylight saving 
time setting.

Daylight saving time 
setting

Click to enable the daylight 
saving time setting.

Refresh
Click to acquire the current 

date and time from the 
AE-200/AE-50/EW-50.

Current date and time
Enter the current date and 
time.

Save Settings
Click to save the changes 
made.

Custom Settings screen
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7-1-2. Basic System
Click [Initial Settings] in the menu bar, and then click [Basic System] to access the Basic System settings screen. 
Make necessary basic system settings such as AE-200/AE-50/EW-50 unit settings, network settings, and M-NET 
settings, and then click [Save Settings] to send the settings to the AE-200/AE-50/EW-50. A message will appear 
asking whether or not to restart the AE-200/AE-50/EW-50. Click [OK] to restart the AE-200/AE-50/EW-50 to reflect 
the changes.

   Note:  The Basic System settings may not be accessible if logged in as a building manager.

7-1-2-1. Unit Settings
Follow the instructions below to set the AE-200/AE-50/EW-50 unit name and unit ID in the [Unit Settings] section. 
The AE-200/AE-50/EW-50 serial number and software version will appear.

(1) Enter the unit name in the [Name] field in 40 alphanumeric or symbol characters or less. The name entered 
here will be used on the screen of the software that controls multiple AE-200/AE-50/EW-50 units and will 
also be used as a sender name in the error notification e-mail and e-mail alarm.
 Note:  The following characters cannot be used in the [Name] field:  <, >, &, “, or ‘

(2) Enter the unit ID in the [Unit ID] field in 6 figures. Use this setting to manage the multiple unit IDs. The unit 
ID entered here will be used on the screen of the software that controls multiple AE-200/AE-50/EW-50 units 
and will also be used as a sender ID in the error notification e-mail and e-mail alarm.

Unit Settings
Set the 

AE-200/AE-50/EW-50 name 
and unit ID.

Network Settings
Set the 

AE-200/AE-50/EW-50 IP 
address and subnet mask.

Display Format
Set the screen display items  
for the AE-200/AE-50/EW-50 

and the Web browser.

Refresh
Click to import the settings  

from AE-200/AE-50/EW-50.

M-NET Settings
Set the 
AE-200/AE-50/EW-50 
M-NET address and range 
of prohibited controllers.

External Input Setting
Set the 
AE-200/AE-50/EW-50 
external signal input mode.

Advanced Setting
Click to display the screen 
for making advanced 
settings.

Save Settings
Click to save the changes 
made.
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7-1-2-2. M-NET Settings

(1) Enter [0] in the [M-NET Address] field (unless otherwise specified).

(2) When the local remote controller operation is prohibited, this setting determines the scope of its applicability. 
Select [SC/RC] to prohibit the operation from both the sub system controllers and the remote controllers. 
Select [RC Only] to prohibit the operation only from the remote controllers.

7-1-2-3. External Input Setting
Using the external signal input function, the following types of collective operations can be performed for all 
connected air conditioning units: Emergency stop, ON/OFF operation, and Prohibit/Permit local remote controller 
operation.
A separately-sold external input/output adapter (PAC-YG10HA-E) is required for each AE-200, AE-50 and EW-50.
Select the external signal input mode, referring to the explanations below.

   Note:  Peak Cut control is performed based on the demand level signal (level 1 to 4) input from the connected demand controller. (A 
separate license is required to use the Peak Cut function.)

   Note:  If an external signal is input to the AE-200 only, the collective operations will not be performed for the units connected to the 
AE-50/EW-50 controllers.

   Note:  Refer to the AE-200 Installation Manual for details about the external signal input function.
   Note:  General equipment connected via DIDO controller (PAC-YG66DCA) cannot be collectively run or stopped by using the 

external signal input function unless [Emergency Stop (Level signal)] is selected and relevant switches on the DIDO 
controller are set.

(1) Select [Demand(Level signal)/Not in use] when using a level signal to receive a demand level or when not 
using the external signal input function.
   Note:  Refer to the AE-200 Installation Manual for details about the demand level.

9
8
7
6
5
4
3
2
1

Connection to AE-200/AE-50/EW-50 (CN5)

12 or 24 VDC

Demand level 1
Demand level 2
Demand level 3
Demand level 4

Contact ON
Contact OFF

Demand 
OFF

Demand 
ON

Demand 
OFF
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(2) Select [Emergency Stop (Level signal)] when using a level signal to collectively run or stop all the air 
conditioning units connected to the AE-200, AE-50, or EW-50 in an emergency. During an emergency stop, 
the ON/OFF operation from the local remote controllers will be prohibited, and the ON/OFF operation and 
Prohibit/Permit settings on the AE-200, AE-50, or EW-50 will be prohibited.
   Note:  Refer to the AE-200 Installation Manual for details about the demand level.

9
8
7
6
5
4
3
2
1

(3) Select  [ON/OFF (Level signal)] when using a level signal to collectively run or stop all the air conditioning 
units connected to the AE-200, AE-50, or EW-50. The ON/OFF operation from the local remote controllers 
will be prohibited, and the ON/OFF operation and Prohibit/Permit settings on the AE-200, AE-50, or EW-50 
will be prohibited.

 

9
8
7
6
5
4
3
2
1

12 or 24 VDC

Connection to AE-200/AE-50/EW-50 (CN5)

Contact ON

Contact OFF

Normal
Emergency 
stop Normal

Emergency stop/ 
Normal operation

Demand level 2
Demand level 3
Demand level 4

Contact ON
Contact OFF

Demand 
OFF

Demand 
ON

Demand 
OFF

ON signal, 
OFF signal

12 or 24 VDC

Connection to AE-200/AE-50/EW-50 (CN5)

Stop Run Stop

Contact ON
Contact OFF
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(4) Select [ON/OFF/Prohibit/Permit (Pulse signal)] when using a pulse signal to collectively run or stop all the 
air conditioning units connected to the AE-200, AE-50, or EW-50, or to collectively prohibit or permit the 
operation from the local remote controllers.

9
8
7
6
5
4
3
2
1

Connection to AE-200/AE-50/EW-50 (CN5)

12 or 24 VDC

ON signal
OFF signal

: Pulse generator

Prohibit signal
Permit signal

(Example) ON/OFF

(ON) Contact ON
Contact OFF

(OFF) Contact ON
Contact OFF

0.5–1.0 second

(Example) Prohibit/Permit

Stop Run

(Prohibit)

0.5–1.0 second

Contact ON
Contact OFF

Stop

(Permit)

0.5–1.0 second

Contact ON
Contact OFF

Permit

0.5–1.0 second

Prohibit Permit
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7-1-2-4. Advanced Setting

[1]  Time Master/Sub
In the [Time Master] section, select [Master] or [Sub]. The default setting is [Master].
This setting is required to change only for a system with multiple AE-200 controllers. Set to [Master] on only one 
of the AE-200 controllers in a system, and set to [Sub] on the rest of the AE-200 controllers. The date and time 
synchronization is performed from the AE-200 whose [Time Master] setting is set to [Master] to the AE-200 whose 
[Time Master] setting is set to [Sub].

   Note:  When only one AE-200 controller is connected to the system, leave the default setting [Master] as it is.
   Note:  When multiple AE-50 controllers are connected to the system, leave the default setting [Master] as it is on all AE-50 

controllers.

[2]  Schedule: Season setting
In the [Schedule: Season setting] section, select [Available] to enable the seasonal settings of the weekly schedules 
and [Not Available] to disable. Unless otherwise specified, leave the default setting [Available] as it is.

   Note:  The settings made on this screen on the AE-200 will be reflected on this screen on the AE-50/EW-50.

[3]  Hold type
In the [Hold type] section, select [Normal] or [Forced].
The Hold function is a function to disable the operations that were scheduled for air conditioning unit groups.
If the setting for [Hold] is set to [ON] on the Monitor/Operation screen and the [Hold type] on the screen above is 
set to [Forced], the [Hold] setting can be cancelled only from the AE-200/AE-50/EW-50. If the [Hold type] is set 
to [Normal], the [Hold] setting can be cancelled from AE-200/AE-50/EW-50, other system controllers, or remote 
controllers.

   Note:  The Hold function can be used on the AE-200A/AE-50A/EW-50A, but not on the AE-200E/AE-50E/EW-50E.
   Note:  The Hold function cannot be used on general equipments.
   Note:  The setting [Forced] will not be effective on Air To Water (PWFY) unit groups, LOSSNAY unit groups, and air conditioning 

unit groups that do not support the Hold function (i.e., Mr. Slim M-Series/P-Series indoor units). 
If the setting for [Hold] is set to [ON] on those unit groups on the Monitor/Operation screen and the [Hold type] on the screen 
above is set to [Forced], the setting [Normal] will be effective.

[4]  Old model compatibility mode
In the [Old model compatibility mode] section, select [ON] or [OFF].
Select [ON] when not using the Dual set point function.
When [ON] is selected, the Prohibit Remote Controller function (Timer, Air Direction, Fan Speed) cannot be used.

   Note:  If the setting is changed, the controller will reboot.
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7-1-2-5. Network Settings
Network settings vary depending on whether the AE-200/AE-50/EW-50 is connected to a dedicated LAN or an 
existing LAN. See the sections below for how to set the AE-200/AE-50/EW-50 IP, subnet mask, and gateway 
addresses in the [Network Settings] section.

   Note:  LAN2 (Network Settings 2) is exclusively used for BACnet® function. For BACnet® function settings, refer to the Instruction 
Book (BACnet® function).

   Note:  Although the settings for LAN1 (Network Settings) and LAN2 (Network Settings 2) will appear on the screen, only the 
settings for LAN1 is required. However, only when the LAN1 IP address is required to be set to [192.168.2.1], change the 
default LAN2 IP address to avoid address overlap.

   Note:  After the AE-200 IP address is changed, the AE-50/EW-50 power will be reset.

[1]  Settings for connecting the AE-200/AE-50/EW-50 to a dedicated LAN
(1) Enter the AE-200, AE-50, or EW-50’s IP address in the [IP Address] field. If the LAN has been newly set up, 

allocate IP addresses to the AE-200 units in a sequential order starting with [192.168.1.1]. For example, the 
first AE-200 unit will have an IP address of [192.168.1.1], the second AE-200 unit will have an IP address of 
[192.168.1.2] and so on.
Allocate IP addresses to the AE-50/EW-50 units in a sequential order starting with [192.168.1.211].
   Note:  The recommended IP address ranges are as follows. 

AE-200:  Between [192.168.1.1] and [192.168.1.40] 
AE-50/EW-50:  Between [192.168.1.211] and [192.168.1.249] 
PC:  Between [192.168.1.101] and [192.168.1.150]

[IP address setting example]

192.168.1.101 192.168.1.1 192.168.1.211 192.168.1.212 

AE-200 AE-50 AE-50

   Note:  Some hubs have dedicated ports for connection with another hub. 
Connect the AE-200/AE-50/EW-50 and PC to the normal ports.

(2) Enter [255.255.255.0] in the [Subnet Mask] field (unless otherwise specified).

LAN1

LAN2

100 BASE-TX LAN straight cable
Hub

PC
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(3) When monitoring the system remotely or using e-mail function via a dial-up router, enter the router IP 
address in the [Gateway] field.
Leave the [Gateway] field blank when not connecting a dial-up router.

[Remote Monitoring System example]

AE-200

   Note:  [192.168.1.254] is recommended for use as the IP address of the dial-up router. Refer to the dial-up router 
instruction manual for details of how to set the IP address.

   Note:  The use of a dial-up router with no modem requires a modem (for analog or ISDN) to be connected between the 
router and the public phone line.

[2]  Settings for connecting the AE-200/AE-50/EW-50 to an existing LAN
(1) When connecting the AE-200/AE-50/EW-50 to an existing LAN, consult the system administrator to decide 

the IP, subnet mask, and gateway addresses.

[Existing LAN System example]

10.1.1.250 10.1.2.250 

AE-200

Dial-up router
IP Address: 192.168.1.254

Telecommunication Network

IP Address: 192.168.1.1
Subnet Mask: 255.255.255.0
Gateway: 192.168.1.254

IP Address: 192.168.1.101
Subnet Mask: 255.255.255.0
Gateway: Blank

PC

Dial-up router, cellular phone etc.

PC

Gateway

Obtain the addresses from 
the system administrator.

IP Address: 10.1.1.1
Subnet Mask: 255.255.255.0
Gateway: 10.1.1.250

Backbone LAN

IP Address: 10.1.1.101
Subnet Mask: 255.255.255.0
Gateway: 10.1.1.250

PC

Obtain the addresses from 
the system administrator.

Gateway

IP Address: 10.1.2.51
Subnet Mask: 255.255.255.0
Gateway: 10.1.2.250

PC



134WT07627X01

7-1-2-6. Display Format
Follow the instructions below to set the items in the [Display Format] section.

(1) In the [Unit of Temperature] section, select [ºC] or [ºF].

(2) In the [Pressure unit of measure] section, select [MPa], [PSI], or [kgf/cm2].

(3) In the [Date Format] section, select the desired display format for year, month, and date.

(4) In the [Time Format] section, select the desired display of time format.

(5) In the [Group Names on Overview Monitor] section, select [ON] to display the group names under the icons 
on the Monitor/Operation screen. Select [OFF] not to display the group names.
 Note:  Only the first 8 characters will be visible under the icons. To display all characters, move the cursor to the icon.

(6) In the [Filter Sign Display] section, select [ON] to display the filter sign, and select [OFF] not to.
When the [Filter Sign Display] is set to [OFF], the filter sign will not appear on the Monitor/Operation screen 
even when the indoor unit detects a filter cleaning signal.
If the filter is regularly cleaned and the sign display is unnecessary, set it to [OFF].

(7) In the [Room temp. display (except for group list)] section, select the desired temperature display option to 
be used on the Block display of the Monitor/Operation screen.
Select [Always show] to display the temperature at all times, [Show during operation] to display the 
temperature only during operation, and [Hide] not to display the temperature.

Icons with group names Icons without group names
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(8) In the [Occupancy sensor display] section, make the Show/Hide setting for the occupancy/vacancy status 
that is detected by the built-in occupancy sensor on the ME remote controller (North America: PAR-
U01MEDU, Europe: PAR-U02MEDA).
Select [Hide] not to display the occupancy/vacancy status on the Monitor/Operation screen.
Select [Show occupancy icon] to display the occupancy icon when the sensor on the remote controller 
detects occupancy.
Select [Show vacancy icon] to display the vacancy icon when the sensor on the remote controller detects 
vacancy.
Select [Show both icons] to display the occupancy or vacancy icon according to the occupancy status of the 
room.
 Note:  If the ME remote controller has no built-in occupancy sensor, the occupancy/vacancy icons will not be displayed on 

the Monitor/Operation screen.

Occupancy icon Vacancy icon

(9) In the [Brightness sensor display] section, make the Show/Hide setting for the brightness/darkness status 
that is detected by the built-in brightness sensor on the ME remote controller (North America: PAR-
U01MEDU, Europe: PAR-U02MEDA).
Select [Hide] not to display the brightness/darkness icons on the Monitor/Operation screen.
Select [Show bright symbol] to display the brightness icon when the brightness level in the room reaches 
the predetermined brightness level.
Select [Show dark symbol] to display the darkness icon when the darkness level in the room reaches the 
predetermined darkness level.
Select [Show both symbols] to display the brightness or darkness icon according to the brightness/darkness 
level of the room.
 Note:  If the ME remote controller has no built-in brightness sensor, the brightness/darkness icons will not be displayed on 

the Monitor/Operation screen.
 Note:  The brightness/darkness detection thresholds are set on the ME remote controller (North America:  PAR-U01MEDU, 

Europe:  PAR-U02MEDA).

Brightness icon Darkness icon

(10) In the [Humidity sensor display] section, make the Show/Hide setting for the humidity reading of the built-in 
humidity sensor on the ME remote controller (North America: PAR-U01MEDU, Europe: PAR-U02MEDA).
Select [ON] to display the humidity reading on the Block display of the Monitor/Operation screen.

(Blue) (Gray)

(Yellow) (Gray)
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7-1-3. Groups
Click [Initial Settings] in the menu bar, and then click [Groups] to access the group settings screen. Register the 
groups of air conditioning units, LOSSNAY units (ventilators), Air To Water (PWFY) units, AHC, HWHP (CAHV, 
CRHV) units, or general equipment to be connected to the AE-200/AE-50/EW-50, and then touch [Save Settings].

   Note:  Some settings may not be accessible if logged in as a building manager.

7-1-3-1. Setting group names
In the [Group Name] field, enter the group name to be displayed in 20 characters or less.

   Note:  The following characters cannot be used in the [Group Name] field:  <, >, &, “, or ‘

7-1-3-2. Registering air conditioners, Air To Water (PWFY) units, LOSSNAY units, or HWHP (CAHV, 
CRHV) units to a group

(1) To register air conditioners, Air To Water (PWFY) units, 
LOSSNAY units, or HWHP (CAHV, CRHV) units to each group, 
click the [Air conditioner, Air To Water (PWFY) unit, LOSSNAY 
unit, HWHP (CAHV, CRHV) unit, and general equipment 
registration] field next to the target group name. The [Select Unit 
Addresses] screen will appear.

Check the radio button next to [Air-conditioners / Air to water 
/ HWHP], and select the address numbers of the units to be 
registered.
The selected unit addresses will appear with a yellow-green 
background.
Click again to deselect. The deselected unit addresses will 
appear with a light-gray background.

 Note:  Each group can contain up to 16 air conditioners.
 Note:  Air conditioners, Air To Water (PWFY) units, LOSSNAY units, 

and HWHP (CAHV, CRHV) units cannot be combined with 
general equipment in one group. To change the registered units 
to air conditioners, Air To Water (PWFY) units, LOSSNAY units, 
or HWHP (CAHV, CRHV) units in the group in which general 
equipment is registered, unregister the general equipment first.

 Note:  The addresses of the units that have been registered to other 
groups will appear with a gray background and cannot be 
selected.

(2) To change the icon, click the right or left arrow.
The selected icon will be displayed on the Web browser.

Group No.

Group name

AHC registration
Click to display the screen 

for registering the AHC.

Refresh
Click to import the settings  

from AE-200/AE-50/EW-50.

Air conditioner, Air 
To Water (PWFY) unit, 
LOSSNAY unit, HWHP 
(CAHV, CRHV) unit, 
and general equipment 
registration
Click to display the screen 
for registering the air 
conditioners, Air To Water 
(PWFY) units, LOSSNAY 
units, HWHP (CAHV, 
CRHV) units, and general 
equipment.

System controller 
registration
Click to display the screen 
for registering the system 
controllers.

Remote controller 
registration
Click to display the screen 
for registering the remote 
controllers.

Save Settings
Click to save the changes 
made.
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7-1-3-3. Registering remote controllers to a group
(1) To register remote controllers to a group, click the [Remote 

controller registration] field next to the target group name. The 
[Select Unit Addresses] screen will appear.

Select the address numbers of the remote controllers to be 
registered. The selected unit addresses will appear with a yellow-
green background.
Click again to deselect. The deselected addresses will appear 
with a light-gray background.

 Note:  Each group can contain up to two remote controllers.
 Note:  Each group can contain up to four remote and system controllers 

combined.
 Note:  MA remote controllers do not need to be registered to a group.

7-1-3-4. Registering system controllers to a group
(1) To register system controllers to a group, click the [System 

controller registration] field next to the target group name. The 
[Select Unit Addresses] screen will appear.

Select the address numbers of the system controllers to be 
registered. The selected unit addresses will appear with a yellow-
green background.
Click again to deselect. The deselected addresses will appear 
with a light-gray background.

 Note:  Each group can contain up to four remote and system controllers 
combined (excluding AE-200/AE-50/EW-50).

7-1-3-5. Registering AHC to a group
(1) To register an AHC to a group, click the [AHC registration] field 

next to the target group name. The [Select Unit Addresses] 
screen will appear.

Select the address number of the AHC to be registered. The 
selected unit address will appear with a yellow-green background. 
Click again to deselect. The deselected address will appear with 
a light-gray background.

 Note:  Each group can contain one AHC.
 Note:  AHC must be registered to a group in which air conditioners are 

registered. Do not register AHC to a group in which Air To Water 
(PWFY) units, LOSSNAY units, HWHP (CAHV, CRHV) units, or 
general equipment (via PAC-YG66DCA) are registered.
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7-1-3-6. Registering general equipment to a group
(1) To register general equipment to a group, click the [Air 

conditioner, Air To Water (PWFY) unit, LOSSNAY unit, 
HWHP (CAHV, CRHV) unit, and general equipment 
registration] field next to the target group name. The 
[Select Unit Addresses] screen will appear.

Check the radio button next to [General Equipment (via 
PAC-YG66DCA)].
Select the device number of the DIDO controller (PAC-
YG66DCA) that is connected to the general equipment 
to be registered. The selected number will appear with 
a red frame. Also, select contact points to which the 
general equipments are connected.
Click again to deselect. The deselected numbers will 
appear with a light-gray background.

 Note:  Each contact of DIDO controller counts as one unit.
 Note:  Each group can contain up to 16 general equipment.
 Note:  Up to six general equipment can be registered for each DIDO controller.
 Note:  Air conditioners, Air To Water (PWFY) units, LOSSNAY units, and HWHP (CAHV, CRHV) units cannot be combined 

with general equipment in one group. To change the registered units to general equipment in the group to which air 
conditioners, Air To Water (PWFY) units, LOSSNAY units, or HWHP (CAHV, CRHV) units are registered, unregister 
the air conditioners, Air To Water (PWFY) units, LOSSNAY units, or HWHP (CAHV, CRHV) units first.

 Note:  General equipment groups cannot include remote controllers or system controllers.

(2) To change the icon, click the right or left arrow.
The selected icon will be displayed on the Web browser.

(3) In the [Allow Operations] section, make the setting to allow or disallow operation.
Select [In batch and on individual group] to allow the operator to turn on or off the general equipment 
collectively or by the groups.
Select [On individual group] to allow the operator to turn on or off the general equipment by the groups.
Select [No operations (Monitor only)] to disallow the operator to turn on or off the general equipment.

(4) In the [Monitor] section, select which status will be used to reflect the units' ON/OFF status to the unit 
icons on the Monitor/Operation screen. Select [Output status] to use the status that is sent to the general 
equipment, and [Input status] to use the status that is sent from the general equipment.
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7-1-4. Interlocked LOSSNAY
The ON/OFF status of the LOSSNAY unit can be interlocked with the operation of indoor units. Click [Initial Settings] 
in the menu bar, and then click [Interlocked LOSSNAY] to access the Interlocked LOSSNAY settings screen. Set the 
interlocking conditions, and then click [Save Settings].

   Note:  The Interlocked LOSSNAY settings may not be accessible if logged in as a building manager.
   Note:  The ON/OFF status of the indoor units are not interlocked with the ON/OFF status of the LOSSNAY unit.
   Note:  The interlock settings between the units connected to the AE-200, AE-50, and EW-50, as well as between the units 

connected to different AE-50/EW-50 controllers, cannot be made.

(1) Click the [Interlocked LOSSNAY unit registration] field. The [Select a 
Unit Address] screen will appear.
Select the address number of the LOSSNAY unit to be registered. 
The selected unit address will appear with a yellow-green 
background.
Click again to deselect. The deselected address will appear with a 
light-gray background.

(2) Click the [Interlocked indoor unit registration] field. The [Select Unit 
Addresses] screen will appear.
Select the address numbers of the indoor units to which the selected 
LOSSNAY unit will be interlocked. The selected unit addresses will 
appear with a yellow-green background.
Click again to deselect. The deselected addresses will appear with a 
light-gray background.
 Note:  Each LOSSNAY unit can be interlocked with up to 16 indoor units.

Interlocked LOSSNAY unit 
registration

Click to display the screen 
for registering the LOSSNAY 

unit.

Refresh
Click to import the settings  

from AE-200/AE-50/EW-50.

Interlocked indoor unit 
registration
Click to display the screen 
for registering the indoor 
units.

Save Settings
Click to save the changes 
made.
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7-1-5. Blocks
By making block settings, multiple groups in a given block can be collectively monitored or operated on the Web 
browser. Click [Initial Settings] in the menu bar, and then click [Blocks] to access the block settings screen. Register 
the groups to each block, and then click [Save Settings].

   Note:  Some settings may not be accessible if logged in as a building manager.
   Note:  The groups of units connected to the AE-200, AE-50, and EW-50, as well as the groups of units connected to different 

AE-50/EW-50 controllers, cannot be registered to the same block.

(1) Enter the block name in the [Block Name] field to be displayed on the Web browser in 20 characters or less.
 Note:  The following characters cannot be used in the [Block Name] field:  <, >, &, “, or ‘

(2) Click the [Group registration] field next to the target block. The [Select 
Groups] screen will appear.
Select the group numbers to be registered. (To show the group name, 
move the cursor to the group number.)
The selected group numbers will appear with a yellow-green 
background.
Click again to deselect. The deselected group numbers will appear 
with a light-gray background.
 Note:  HWHP (CAHV, CRHV) unit groups cannot be registered to a block.

Block Name

Refresh
Click to import the settings  

from AE-200/AE-50/EW-50.

Group registration

Save Settings
Click to save the changes 
made. 
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7-2. Functions 1
7-2-1. E-Mail

E-mail settings must be configured properly to use the error notification e-mail function or the e-mail communication 
function. Error notification e-mail function is the function to send the error information to the specified e-mail 
addresses. E-mail communication function is the function to send the units’ maintenance data to the specified e-mail 
addresses of the PCs to which Maintenance Tool is installed.
Click [Functions 1] in the menu bar, and then click [E-Mail] to access the e-mail settings screen. Make the various 
e-mail settings, and then click [Save Settings].

   Note:  The E-mail settings may not be accessible if logged in as a building manager.

[1]  E-Mail Settings of AE-200/AE-50/EW-50

Enter the AE-200/AE-50/EW-50’s e-mail information provided by the Internet Service Provider (ISP) or the system 
administrator. The items required to be set vary, depending on the functions to be used. Refer to the table below to 
determine which items need to be set.

   Note:  A contract with the ISP is required to send e-mail via an ISP.

Table: Items required to be set (E-Mail Settings of AE-200/AE-50/EW-50)

Item
Error notification e-mail function E-mail communication function

Without SMTP 
authentication

With SMTP 
authentication

Without SMTP 
authentication

With SMTP 
authentication

E-Mail Address V V V V
User ID - V V V
Password - V V V
Interval of checking incoming mails - - V V

(V) Required to be set, (-) Not required to be set

Mail Server Information
Set the mail server/DNS 

server information.

Mail Communication 
Setting

Set the e-mail addresses 
of the PCs that will receive 
maintenance data through 

e-mail communication 
function.

Refresh
Click to import the settings  

from AE-200/AE-50/EW-50.

E-Mail Settings of 
AE-200/AE-50/EW-50

Error Mail Settings
Enter the e-mail information 
for error notification e-mail 
function.

Save Settings
Click to save the changes 
made.
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[2]  Mail Server Information

Enter the e-mail server information provided by the ISP or the system administrator. The items required to be set 
vary, depending on the functions to be used. Refer to the table below to determine which items need to be set. 
Either the IP address or the host name (server name) can be entered in the [Outgoing Mail Server (SMTP)] and 
[Incoming Mail Server (POP3)] fields.

   Note:  The port number of the Outgoing Mail Server (SMTP) can be changed. (Factory setting: 25)
   Note:  When “587” is entered in the [Port] field, make sure to check the checkbox next to [Use SMTP Authentication].

Table: Items required to be set (Mail Server Information)

Item
Error notification e-mail function E-mail communication function

Without SMTP 
authentication

With SMTP 
authentication

Without SMTP 
authentication

With SMTP 
authentication

Outgoing Mail Server (SMTP)
V

IP address or  
host name

V
Host name

V
IP address or  

host name

V
Host name

Use SMTP Authentication - V - V

Incoming Mail Server (POP3) - -
V

IP address or  
host name

V
IP address or  

host name
DNS Server (Primary) (V) *1 V (V) *1 V
DNS Server (Secondary) (V) *1 V (V) *1 V

(V) Required to be set, (-) Not required to be set
*1 Not required if the IP address is entered in the [Outgoing Mail Server (SMTP)] or [Incoming Mail Server (POP3)] field.

[3]  Error Mail Settings

(1) In the [Mail Subject] field, enter the mail subject to be used for the error notification e-mail function in 40 
characters or less.
 Note:  The following characters cannot be used in the [Mail Subject] field:  <, >, &, “, or ‘

(2) In the [Kind of Errors] field, select the error type out of the following: [Unit Error], [Preliminary Unit Error], 
[Communication Error], [General Equipment], and [User Setting 1] through [User Setting 6]. Then, in the 
[E-Mail Address] field, enter the e-mail addresses of the recipients of the error notification e-mail.

(3) If [User Setting 1] through [User Setting 6] is selected in the [Kind 
of Errors] field, a [User Settings] button will appear. To send error 
notification e-mail only upon occurrences of certain errors, click 
[User Settings] to display the User Settings screen.  
Enter the error codes to be notified. 

Up to 20 error codes can be set for each user setting. In addition 
to specific error codes such as [1302] or [6607], codes that use 
asterisks as wildcards such as [10**] or [12**] can also be used. 
If [10**] is entered, for example, error notification e-mail will be 
sent upon an occurrence of any type of errors between [1000] and 
[1099]. If error codes are entered on this screen, confirm that the 
e-mail addresses of the recipients are registered.
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(4) If [General Equipment] is selected in the [Kind of Errors] field, a 
[PLC Connection] button will appear. To send error notification 
e-mail upon occurrences of errors on the general equipment that 
are connected to PLC Software for General Equipment, click [PLC 
Connection] to display the [PLC Connection] screen. Enter the IP 
addresses of PLC Software for General Equipment.

The row number that corresponds to each IP address will appear 
in the error notification e-mail as a PLC number. (e.g., When an 
error occurs on the general equipment #20 connected to the PLC 
Software in the second row, “PLC2-20” will appear in the [Error 
unit] section in the error notification e-mail.)
 Note:  A TG-2000A is required to monitor the status of the general 

equipment that is connected to the PLC Software for General 
Equipment.

[4]  Mail Communication Setting

To use an e-mail communication function, enter the addresses of the PCs that will receive the units’ maintenance 
data in the [Mail Communication Setting] section. Up to 10 e-mail addresses can be set.

[5]  E-mail format
Error notification e-mail will be sent in the format shown below.

From:Mitsubishi Building(000001)
Date:01/06/2014 16:32:12
Error unit:065
Error code:1302
Status:Occurrence

Mail subject The mail subject entered in section 7-2-1 “E-Mail” [3] will appear.
From The AE-200/AE-50/EW-50 unit name and unit ID entered in section 7-1-2-1 “Unit Settings” will appear.
Date Error occurrence date and time will appear in the format entered in section 7-1-2-6 “Display Format”.

Error unit

 -   When an error occurs on air conditioning units or general equipment, the M-NET address of the unit 
in error will appear.

 -   When an error occurs on general equipment connected to PLC Software for General Equipment, PLC 
number* (1 to 20) and connection number of general equipment (1 to 32) will appear.

 -   When a communication error occurs on PLC Software for General Equipment, PLC number* (1 to 20) 
will appear.

 *   PLC number indicates the row number on the [PLC Connection] screen. (Refer to section 7-2-1 “E-Mail” [3].)

 Note:  When an error occurs on the general equipment connected via DIDO controller, M-NET address of 
the DIDO controller will appear. (The recipients will know that an error has occurred on one of the 
general equipment that is connected to the DIDO controller.)

Error code

Error code (4-digit) will appear.
 -   When an error occurs on air conditioning units, refer to the service manual of the unit for the error 
codes.

 -   When an error occurs on general equipment, “0091” (General equipment error) will appear.
 -   When a communication error occurs on PLC Software for General Equipment, “0003” (LAN 
communication error to PLC) or “0007” (PLC program stopped) will appear.

Status Error status “Occurrence” (The error is occurring) or “Recovery” (The error has been resolved) will 
appear.
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7-2-2. Peak Cut (Energy-save control function)
According to the selected Peak Cut method, the AE-200/AE-50/EW-50 obtains the demand level or the electric 
energy values to determine the control level, and operates outdoor units and blocks of indoor units below the 
specified maximum capacity that corresponds to the control level.
Click [Functions 1] in the menu bar, and then click [Peak Cut] to access the Peak Cut control settings screen. Make 
necessary settings, and then click [Save Settings].

Important:  The amount of electricity that is actually used may exceed the maximum power demand due to unexpected 
problems such as controller malfunctions or broken transmission cables. Mitsubishi Electric will not be 
responsible for exceeding the maximum power demand.

   Note:  After completing the settings, perform a test run and confirm proper connections of equipment before using the Peak Cut 
function.

   Note:  A separate license is required to use the Peak Cut function. Make sure that the required license has properly been registered 
on the Registration of Optional Functions screen. (Refer to section 4-5 “License registration for optional functions” for 
details.)

   Note:  Some settings may not be accessible if logged in as a building manager.
   Note:  Peak Cut control cannot be performed on DIDO controller (PAC-YG66DCA), AHC, or Air To Water (PWFY) unit.
   Note:  The Peak Cut control of indoor units is performed per block. Be sure to make block settings to use the Peak Cut function.
   Note:  The Peak Cut control settings between the outdoor and indoor units connected to the AE-200, AE-50, and EW-50, as well as 

between the units connected to different AE-50/EW-50 controllers, cannot be made.

[1]  Peak Cut method

[Demand-Input PLC]

AE-200

AE-50

AE-50

AE-50

[Electric Amount Count PLC]

AE-200

AE-50

AE-50

AE-50

Peak Cut method

Control details for  
outdoor units

Refresh
Click to import the settings  
from AE-200/AE-50/EW-50 

and PLC.

Setting details for the 
selected Peak Cut method

Control details for blocks 
of indoor units

Save Settings
Click to send the settings to 
AE-200/AE-50/EW-50 and 
PLC.

Demand level 
signal is sent.

Demand-Input 
PLC 

Maximum ten 
AE-200/AE-50/EW-50 units

Demand 
controller

Demand level is 
input.

Reads electric 
energy values.

Electric Amount 
Count PLC

Maximum fourteen 
AE-200/AE-50/EW-50 units

Pulse

Pulse-watt-
hour meter
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[PI Controller]

AE-200

AE-50

AE-50

AE-50

AE-200

AE-50

AE-50

AE-50

[External Contact point input] (1)

AE-200

AE-50

AE-50

AE-50

[External Contact point input] (2)

AE-200

AE-50

AE-50

AE-50

 Note:  An external input/output adapter (PAC-YG10HA-E) is 
required for each AE-200/AE-50/EW-50.

[From external system]

AE-50

AE-50

AE-50

AE-200

<When a PI controller (PAC-YG60MCA) is used> <When a built-in Pulse Input (PI) is used>

Maximum three 
AE-200/AE-50/EW-50 units

Peak Cut method [Remote AE]

Pulse-watt-
hour meter

Reads control 
level.

Pulse

(Built-in Pulse Input (PI))

Reads electric 
energy values.

Reads control 
level.

Peak Cut method [Remote AE]

PI controller

Maximum three 
AE-200/AE-50/EW-50 units

Pulse

Pulse-watt-
hour meter

Maximum three 
AE-200/AE-50/EW-50 units

Demand level is 
input.

Demand 
controller

External input/output 
adapter (PAC-YG10HA-E)

LAN

Peak Cut method [Remote AE]

Reads control 
level.

Maximum three 
AE-200/AE-50 
/EW-50 units

Demand level is 
input.

Demand 
controller

External input/output 
adapter (PAC-YG10HA-E)

Demand level 
signal is sent.

PLC etc.

Pulse

Pulse-watt-
hour meter

Maximum ten 
AE-200/AE-50/EW-50 units
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(A) When the Peak Cut method [Demand-Input PLC] is selected

(1) In the [IP Address] field, enter the IP address of the Demand-Input PLC.

(2) When using the Demand-Input PLC for the first time, click [Initialize] to initialize its internal memory.
 Note:  Do not initialize the Demand-Input PLC after the operation has begun, for it will clear all operation data.

(3) In the [Controlled AE] field, enter the IP addresses of the AE-200/AE-50/EW-50 units to which the demand 
level signal is sent. Up to 10 IP addresses can be registered.

(4) In the [Temperature difference between set point and inlet] section, a temperature differential can be set to 
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be 
disregarded for the indoor unit groups in which the temperature difference between the set temperature and 
the room temperature is greater than the specified temperature differential.
 Note:  The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the 

temperature differential setting.

(B) When the Peak Cut method [Electric Amount Count PLC] is selected

(1) In the [IP address] field, enter the IP address of the Electric Amount Count PLC.

(2) When using the Electric Amount Count PLC for the first time, click [Initialize] to initialize the internal memory.
 Note:  Do not initialize the Electric Amount Count PLC after the operation has begun, for it will clear all operation data.

(3) In the [DI Board] field, select the DI board number to which the watt-hour meter is connected, and the 
terminal number. If the watt-hour meter is connected to terminal 2 on a DI board 1, select 1-2.
 Note:  Select a DI board number 1 or 2, and select a terminal number/code between 0 and F.

(4) In the [Pulse Unit] field, enter the pulse value that the watt-hour meter outputs. Set the pulse value according 
to the watt-hour meter to be used.

Important:  Check the watt-hour meter readings several times on the hour and the half-hour. Then, be sure to check 
that the increase in the watt-hour meter reading for each 30-minute period and the average electric power 
consumption in the same period that the Peak Cut function is used are the same amount.

(5) In the [Control levels] section, the range of the electric power must be set for each control level. For control 
level 4, enter the value that is 10% to 15% below the maximum power demand (average electric energy that 
cannot be exceeded in any 30-minute period). For control levels 3 to 0, enter the value that is decreased 
by about 10% from the set value of the previous control level. (The screenshot above shows the setting 
example of the maximum demand of 200 kW.)
 Note:  The optimum setting depends on the system configuration of the electric equipment and on the indoor environment in 

each building. Determine the appropriate values accordingly.



147WT07627X01

(6) In the [Temperature difference between set point and inlet] section, a temperature differential can be set to 
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be 
disregarded for the indoor unit groups in which the temperature difference between the set temperature and 
the room temperature is greater than the specified temperature differential.
 Note:  The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the 

temperature differential setting.

(C) When the Peak Cut method [PI Controller] is selected

(1) In the [Watthour meter] field, select the watt-hour meter used for the Peak Cut function or the PI controller to 
which the watt-hour meter is connected.
 Note:  Only the watt-hour meters that have been registered on the Measurement screen are selectable. Refer to section 

7-2-3 “Measurement” for how to register metering devices.
 Note:  When a built-in Pulse Input (PI) is used, [“Meter” + Channel No. + (space) + Metering device name] will appear. (For 

example, if the watt-hour meter used for the Peak Cut function is connected to channel 3 of CN7 of AE-200 and the 
metering device name is “For Peak Cut function,” [Meter3 For Peak Cut function] will appear.)
When a PI controller (PAC-YG60MCA) is used, [“Address” + PI controller address + “-” + Channel No. + (space) + 
Metering device name] will appear. (For example, if the watt-hour meter used for the Peak Cut function is connected 
to channel 2 of a PI controller (address 10) and the metering device name is not registered, [Address10-2] will 
appear.)

(2) In the [Control levels] section, the range of the electric power must be set for each control level. For control 
level 4, enter the value that is 10% to 15% below the maximum power demand (average electric energy that 
cannot be exceeded in any 30-minute period). For control levels 3 to 0, enter the value that is decreased 
by about 10% from the set value of the previous control level. (The screenshot above shows the setting 
example of the maximum demand of 200 kW.)
 Note:  The optimum setting depends on the system configuration of the electric equipment and on the indoor environment in 

each building. Determine the appropriate values accordingly.

(3) In the [Temperature difference between set point and inlet] section, a temperature differential can be set to 
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be 
disregarded for the indoor unit groups in which the temperature difference between the set temperature and 
the room temperature is greater than the specified temperature differential.
 Note:  The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the 

temperature differential setting.
 Note:  When a PI controller is only connected to AE-200, and when AE-50/EW-50 monitors AE-200, select “Remote AE” for 

AE-50/EW-50.
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(D) When the Peak Cut method [Remote AE] is selected

(1) In the [IP address] field, enter the IP address of the AE-200/AE-50/EW-50 that uses one of the following.
 - Built-in Pulse Input (PI)
 - PI controller (PAC-YG60MCA)
 -   External contact input (Refer to (E) “When the Peak Cut method [External Contact point input] is 

selected” for details.)
 Note:  As the control level is obtained every minute from the AE-200/AE-50/EW-50 that uses a built-in Pulse Input (PI) or 

a PI controller (PAC-YG60MCA), the control will be late for up to one minute on the AE-200/AE-50 whose Peak Cut 
method setting is [Remote AE].

 Note:  Up to three AE-200/AE-50/EW-50 units can be connected to the AE-200/AE-50/EW-50 unit that uses a built-in Pulse 
Input (PI) or a PI controller (PAC-YG60MCA). When five or more AE-200/AE-50/EW-50 units are connected, add the 
settings in (C) “When the Peak Cut method [PI Controller] is selected” or use the Peak Cut method [Electric Amount 
Count PLC].

(2) In the [Temperature difference between set point and inlet] section, a temperature differential can be set to 
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be 
disregarded for the indoor unit groups in which the temperature difference between the set temperature and 
the room temperature is greater than the specified temperature differential.
 Note:  The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the 

temperature differential setting.

(E) When the Peak Cut method [External Contact point input] is selected
   Note:  The external signal can be input to AE-200, AE-50, and EW-50, so that all outdoor units and blocks of indoor units can be 

selected.

(1) In the [Temperature difference between set point and inlet] section, a temperature differential can be set to 
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be 
disregarded for the indoor unit groups in which the temperature difference between the set temperature and 
the room temperature is greater than the specified temperature differential.
 Note:  The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the 

temperature differential setting.
 Note:  When an external input is only connected to AE-200, and when AE-50/EW-50 monitors AE-200’s control level, select 

“Remote AE” for AE-50/EW-50.
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(F) When the Peak Cut method [From external system] is selected

(1) In the [Temperature difference between set point and inlet] section, a temperature differential can be set to 
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be 
disregarded for the indoor unit groups in which the temperature difference between the set temperature and 
the room temperature is greater than the specified temperature differential.
 Note:  The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the 

temperature differential setting.
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[2]  Control details for outdoor units (All Peak Cut methods)
Follow the instructions below to make the Peak Cut control settings for each control level for given outdoor units. 

   Note:  If the outdoor unit is a City Multi unit, the M-NET address will appear. If the outdoor unit is an A-control (Mr. Slim) unit, the 
M-NET address and group name will appear.

   Note:  As for A-control outdoor units, only the inverter models can perform Peak Cut control. The Peak Cut control settings for 
constant-speed models can not be made.

   Note:  Do not make the Peak Cut control settings for heat pump models of outdoor units or some types of outdoor units.

(1) To make settings for all outdoor units at once, 
check the [Batch Operations] checkbox.
Then, set the maximum operating capacity for 
each control level.
The smaller the maximum operating capacity, 
the more energy will be saved.
 Note:  Energy-saving effects cannot be expected 

during low-load operation with the capacity 
below the selected maximum capacity.

 Note:  For heat pump outdoor units and City Multi 
S series (PUMY) outdoor units, leave the 
default setting [100%] as it is not to activate 
the capacity-save control.
However, [50%] though [100%] can be set on 
the following models.
PUMY-P**KM or later
PUMY-P**KM-A or later
PUMY-P**HMC-S or later
PUMY-P**HMC-C or later
PUMY-P**KMC-C or later
PUMY-P**YKM.TH(-T) or later

 Note:  AE-200/AE-50/EW-50 that support Maximum 
Capacity [50%] are from Ver. 7.23 or later.

(2) For each control level, set the total time in which the Peak Cut control is performed during every 30 minutes. 
Setting the time to [30] or [15] minutes is preferable, for shorter control time is not likely to bring much 
benefit.
If any time other than [30] minutes is selected, the outdoor units will operate in rotation so that they will not 
perform the Peak Cut control at the same time.

(3) To copy the settings of an outdoor unit to the settings for other outdoor units, display the outdoor unit whose 
settings are to be copied and click [Copy], then display the outdoor unit to which the copied settings are to 
be pasted and click [Paste]. The rectangular icons next to the selected buttons will appear in yellow-green.

Control level

Batch Operations
Click to make settings for 
all outdoor units at once. Maximum Capacity

Select the upper limit of outdoor unit 
operating capacity.

Copy

Paste

Control Time

Capacity

80%

Operating 
Capacity

e.g., Maximum capacity at 80%

No energy-saving effects Energy-saving effects

Energy saved

Time
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[3]  Control details for blocks of indoor units
Follow the instructions below to make the Peak Cut control settings for each control level for given blocks of indoor 
units.
If the block settings have not been made, refer to section 7-1-5 “Blocks” for how to make the block settings.

(1) Scroll up or down to display the block whose settings are to be made. To make settings for all blocks at 
once, check the [Batch Operations] checkbox.
Then, select the control method for each control level, referring to the table below.
 Note:  Only the control method “OFF” is effective for Air To Water (PWFY) units. Other methods can be selected, but are not 

effective.

Table: Indoor Unit Control Method

Control Method Control details

None Peak Cut control will not be performed.

±2ºC (±4ºF)

During the Peak Cut control, the set temperature in the Cool or Dry mode will be offset by +2ºC (+4ºF), 
and the set temperature in the Heat mode will be offset by -2ºC (-4ºF).
 Note:  Peak Cut control will not be performed during the Fan or Auto mode.
 Note:  When the unit of temperature is Fahrenheit, the set temperature may not be offset by ±4ºF 

exactly because 2ºC is used for the calculation first, and then the temperature in Celsius is 
converted into the temperature in Fahrenheit.

 Note:  The set temperature will be adjusted within the set temperature restrictions settings.  
Refer to section 7-3-1 “Set Temperature Range Limit” for details.

Fan *1
During the Peak Cut control, free-plan indoor units and A-control Mr. Slim indoor units (M-Series/
P-Series indoor units) will go in to the Thermo-OFF state, and the units older than free-plan units will 
operate in the Fan mode. (When the units are in the Thermo-OFF state, the operation mode on the 
remote controller LCD will not change.)

OFF *1
During the Peak Cut control, the units will stop.
 Note: If the control method is set to [OFF] and the Control Time is set to [30] minutes, the groups 

that are operated in the Peak Cut control cannot be operated from any controller.

*1 When the indoor unit Peak Cut control function is used during the heating operation, it takes a while to resume operation to prevent cold air 
draft. This may negatively affect the performance of the unit for a certain period of time after the operation is resumed. To ensure maximum 
performance, it is recommended to use an outdoor unit capacity-save control function (that will not stop the compressor operation) during the 
heating operation. If the indoor unit Peak Cut control function is still used, selecting [3] minutes in the Control Time section is recommended.

Control level

Batch Operations
Click to make settings for 

all blocks at once.
Control method

Copy 
Paste

Control Time
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(2) For each control level, set the total time in which 
the Peak Cut control is performed during every 30 
minutes.
Each Peak Cut control is performed for three 
minutes. If [6] minutes is selected, three-minute 
Peak Cut control will be performed twice during 
every 30 minutes.
If any time other than [30] minutes is selected, the 
indoor units will operate in rotation so that they will 
not perform the Peak Cut control at the same time.

0 3 5 8 10 15 18 20 23 25 3013 28

(3) To copy the settings of a block to the settings for other blocks, display the block whose settings are to be 
copied and click [Copy], then display the block to which the copied settings are to be pasted and click [Paste]. 
The rectangular icons next to the selected buttons will appear in yellow-green.

When [6] minutes is selected

Group 1

Group 2

Group 3

Control time
min
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7-2-3. Measurement
Measurement settings must be made to use temperature sensors, humidity sensors, and metering devices.  
Click [Functions 1] in the menu bar, and then click [Measurement] to access the measurement settings screen. Set 
the measurement settings, and then click [Save Settings].

   Note:  The measurement settings may not be accessible if logged in as a building manager.

[1]  Registering AI controllers and temperature/humidity sensors
Follow the instructions below to make the system settings for measurement sensors. Up to two measurement 
sensors can be connected to an AI controller (PAC-YG63MCA).

(1) Using the scroll bar, select the address to which the AI controller (PAC-YG63MCA) will be connected.

(2) Select the AI controller icon (  ).

 Note:  Click again to deselect.

(3) In the [Sensor name] field, enter the name of the sensor.

(4) Select the temperature sensor icon (  ) or the humidity sensor icon (  ).

(5) Enter the measurable range of the sensor.
 Note:  When the Pt sensor is connected, the range must be between -30ºC (-22ºF) and +60ºC (+140ºF).  

When the sensors other than the Pt sensors are connected, enter the ranges that are described in the operation 
manuals of the sensor.

Selection of AI or PI 
controller

M-NET address of  
AI or PI controller

Selection of separator 
character for energy 

management data

Selection of decimal point 
character for energy 

management data

Refresh
Click to import the settings  

from AE-200/AE-50/EW-50.

Setting details

Scroll bar
Slide to show the address to 
which the AI or PI controller 
will be connected.

E-mail Settings

Save Settings
Click to save the changes 
made.

AI controller icon

Sensor name

Setting details of  
sensor 1

Setting details of  
sensor 2

Set offset

Selection of temperature 
or humidity sensor icon Measurable range

Upper/lower ON- and 
OFF-threshold settings 
for e-mail alarm function

Upper limit
(ON-threshold)

Upper limit
(OFF-threshold)

Lower limit
(OFF-threshold)

Lower limit
(ON-threshold)
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(6) To receive an e-mail alarm when the temperature or the humidity exceeds certain predetermined values, set 
the ON- and OFF-thresholds for both the upper and lower limit temperatures.
 Note:  To avoid frequent ON/OFF cycling, the minimum differential between the ON- and OFF-threshold values should be 

1ºC (2ºF).

[2]  Offsetting the measured temperature/humidity values
To set the offset value for the measured values, follow the instructions below.

   Note:  The actual measurement values or the adjusted measurement values are not displayed until the connection settings of the 
AI controller are completed. 
When the AI controller is registered for the first time, click [Save Settings] to send the settings data, and click [Functions 
1]-[Measurement] to refresh the measurement settings screen.

(1) Click [Set offset] in the [Setting details] section.

(2) Select the offset value in the [Offset] pulldown menu, or 
select the desired value in the [Modified value] pulldown 
menu.
The settable offset value range for temperature sensor is 
between -10.0ºC (-18.0ºF) and +10.0ºC (+18.0ºF), and 
for the humidity sensor is between -10.0% and +10.0%.

[3]  Registering PI controllers and metering devices
Follow the instructions below to make the system settings of the metering devices. Up to four metering devices can 
be connected to a PI controller (PAC-YG60MCA) or CN7 of AE-200/AE-50/EW-50.

   Note:  Although the maximum settable total number of built-in Pulse Input (PI) and PI controllers (PAC-YG60MCA) for each 
AE-200/AE-50/EW-50 is 15, the number of them in a system with connection to one or more AE-50/EW-50 controllers must 
be 20 or less. (Each built-in Pulse Input (PI) counts as one unit.)

<When a built-in Pulse Input (PI) is used>

<When a PI controller (PAC-YG60MCA) is used>

(1) Using the scroll bar, display the address to which the PI controller (PAC-YG60MCA) will be connected or to 
display the settings area for a built-in Pulse Input (PI) at the top.

(2) Select the PI controller icon (  ).
When a built-in Pulse Input (PI) is used, the top row shows the setting area for the built-in Pulse Input (PI) 
and there is no need to select an icon.
  Note:  Click again to deselect.

(3) In the [Metering device name] field, enter the name of the metering device.

Metering device name

Setting details of 
metering device 1

Setting details of 
metering device 3

Pulse value
Measurement unit

Setting details of 
metering device 2

Setting details of 
metering device 4

Metering device name

PI controller icon

Setting details of 
metering device 1

Setting details of 
metering device 3

Pulse value
Measurement unit

Setting details of 
metering device 2

Setting details of 
metering device 4
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(4) Enter the pulse value of the metering device, and select the measurement unit.
 Note:  The measurement unit can be selected from [kWh], [m3], [MJ], or [--(no unit)].
 Note:  Select the blank in the measurement unit pulldown menu when not using a metering device.
 Note:  If the pulse value field is left blank, the reading of the metering device cannot be properly obtained. Be sure to set the 

pulse value.

Important:  Set the pulse value according to the metering device to be used. To ensure proper settings, first check the value 
measured by the metering device and the value counted by the PI controller. Then, after a certain time, check 
that both values have increased by equal values. (The values that the PI controller counts can be checked on 
the LCD and the Integrated Centralized Control Web.)

[4]  E-mail alarm function settings 
To receive an e-mail alarm when the temperature or the humidity exceeds certain predetermined values, set the 
e-mail settings by following the instructions below.

(1) In the [Type of E-Mail] field, select [Out-of-limit alarm]. 
Then, enter the mail subject and the e-mail addresses.
 Note:  The following characters cannot be used in the [Mail 

Subject] field:  <, >, &, “, or ‘

An e-mail alarm will be sent in the format shown below.

From: Mitsubishi Building(000001)
Date/Time: 13/03/2014 09:38:39
Address: 50-1
Current value: 24.9 deg C
Status: Exceeded lower limit
Trend Data:
09:38 25.2 deg C
09:37 25.4 deg C
09:36 25.6 deg C
09:35 25.8 deg C
09:34 26.1 deg C
09:33 26.4 deg C
09:32 26.7 deg C
09:31 27.0 deg C
09:30 27.5 deg C
09:29 27.7 deg C

From

AE-200/AE-50/EW-50 name + Unit ID
 Note:  The AE-200/AE-50/EW-50 unit name and unit 

ID entered in section 7-1-2-1 “Unit Settings” 
will appear.

Date/Time
yyyy/mm/dd hh:mm:ss
 Note:  The date and time will appear in the format 

selected in section 7-1-2-6 “Display Format”.
Address M-NET address of AI controller + sensor No.

Current value
Current temperature or humidity (one decimal place)
 Note:  [**.*] may appear until the value measured by 

sensor becomes stable.

Status
“Exceeded upper limit,” “Recovered from upper 
limit,” “Exceeded lower limit,” or “Recovered from 
lower limit”

Trend Data Time + Temperature or humidity values (for the last 
10 minutes)

(2) Click [E-Mail Settings] to enter the mail server 
information.
 Note:  The setting details are the same as those described 

in sections 7-2-1 “E-Mail” [1] and [2]. Refer to those 
sections for details.
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[5]  Energy management data format settings
Set the format of the energy management data that can be output in a CSV format from the screens under the 
Energy Management menu.

Select the separator character.

Select the decimal point character.
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7-2-4. Energy Management Settings
On the Energy Management Settings screen, make the settings for the energy-control-related items, such as 
temperature sensor to measure the outdoor temperature with, electricity meters that are used for acquiring the data 
to display the trend graph of indoor unit electricity consumption, and also the mode that are used for apportioning 
indoor unit electricity consumption.
Click [Functions 1] in the menu bar, and then click [Energy Management Settings] to access the energy 
management settings screen.

   Note:  The energy management settings may not be accessible if logged in as a building manager.
   Note:  Electricity consumption is apportioned based on the electricity consumed by outdoor units. The electricity consumed by 

indoor units is not considered.

Important:   The energy management settings must be made after all units have been started up. 
The settings that have been saved while one or more units are starting up may be lost.

(1) In the [Temperature sensor] section, select a temperature sensor to measure the outdoor temperature with.
In the pulldown menu, the name of the temperature sensor that is connected to the AI controller or the AHC 
will appear.
 Note:  Connect the temperature sensor to either the Analog Input 1 or Analog Input 2 port on the AHC.
 Note:  This setting is interlocked with the temperature sensor setting on the External Temperature Interlock settings screen.

(2) In the [Indoor unit operation apportioning mode] section, select the way indoor units' operation time is 
counted that is used to apportion the electricity consumption, which appears on the screens under the 
Energy Management menu.
Select [Fan operation time] to apportion the electricity consumption based on the fan operation time, and 
select [Thermo-ON time] to apportion the electricity consumption based on the Thermo-ON time of the 
indoor units.
Select [Capacity save amount] to apportion the electricity consumption based on the indoor unit operation 
time that was calculated based on the amount of energy saved on the indoor units.
The selected setting must meet the system requirements. Selecting [Capacity save amount] is 
recommended.
 Note:  “FAN operation time” is the cumulative duration of time in which the indoor unit is powered on.
 Note:  “Thermo-ON time” is the cumulative duration of time in which the refrigerant is flowing into the indoor unit.
 Note:  “Capacity save amount” is the cumulative operation time of the outdoor unit based on its capacity.
 Note:  Electricity consumption is apportioned based on the electricity consumed by outdoor units. The electricity consumed 

by indoor units is not considered.
 Note:  When an AE-200 apportioned electricity billing function is used, this setting is not effective because the billing 

function settings are used to apportion the electricity consumption.

Temperature sensor
Select a temperature sensor 

to measure the outdoor 
temperature with.

Refresh
Click to import the settings  

from AE-200/AE-50/EW-50.

Indoor unit operation 
apportioning mode

Indoor unit electricity 
meter

Indoor unit address

Group Name

Electricity meter

Save Settings
Click to save the changes 
made.
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(3) In the [Indoor unit electricity meter] section, select the electricity meter to be used to measure the electricity 
consumption of each group of indoor units.
In the pulldown menu, [“Address”+ PI controller address + “-” + Electricity meter number + Electricity 
meter name] will appear when a PI controller (PAC-YG60MCA) is connected, or [“Meter” + Channel No. + 
Electricity meter name] will appear when a metering device is directly connected to the controller.
 Note:  If the electricity meter name is long, only part of it may be displayed.
 Note:  The electricity meter name will be blank if it has not been registered.
 Note:  Only the electricity meters whose measurement unit setting is set to [kWh] on the Measurement screen are available 

for selection.
 Note:  When an AE-200 apportioned electricity billing function is used, this setting is not effective because the billing 

function settings are used to apportion the electricity consumption.

(4) Click [Save Settings] to save the settings.
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7-3. Functions 2
7-3-1. Set Temperature Range Limit

The settable temperature range for the local remote controllers can be limited. By restricting the lower and upper 
limit of the set temperatures for cooling, heating, and auto modes, energy consumption can be reduced.
Click [Functions 2] in the menu bar, and then click [Set Temperature Range Limit] to access the set temperature 
range restrictions settings screen.

   Note:  The set temperature range restrictions settings may not be effective, depending on the unit model of the remote controller 
and the indoor unit.

   Note:  A-control (Mr. Slim) units, room air conditioners, and residential air conditioners do not support the set temperature range 
restrictions settings.

   Note:  The set temperature range restrictions settings may not be accessible if logged in as a building manager.
   Note:  The set temperature limit range for the AUTO mode cannot be set for the groups that support the dual set point function in 

the AUTO mode. The set temperature ranges for the normal cooling and heating modes will be used for the ones for cooling 
and heating in the Auto (dual set point) mode.

(1) Scroll up or down to display the group whose settings are 
to be made. To make settings for all groups at once, click 
[Batch Operations].
Then, click the [Set temperature range] area to display 
the setting screen.
Set the temperature ranges for cooling, heating, and auto 
modes.
Click [OK] to return to the previous screen.
 Note:  When the temperature unit is Fahrenheit, temperatures 

are displayed in 2ºF increments.
 Note:  The temperature range for Dry mode will be the same as 

the one for cooling mode.

(2) To copy the settings of a group to the settings for other groups, click [Copy] in the row of the group whose 
settings are to be copied, then click [Paste] in the row of the group to which the copied settings are to be 
pasted. The rectangular icons next to the selected buttons will appear in yellow-green.

(3) Click [Save Settings] to save the settings.

Group No. and  
group name

Refresh
Click to import the settings  

from AE-200/AE-50/EW-50.

Set temperature range

Batch Operations
Click to make settings for all 
groups collectively.

Copy 

Paste

Save Settings
Click to save the changes 
made.
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7-3-2. Night Mode (quiet operation) Schedule
Outdoor units can be operated in a quiet mode for the specified time period. Use the Night mode when low-noise 
operation of the outdoor unit is preferable during the night.
Click [Functions 2] in the menu bar, and then click [Night Mode Schedule] to access the Night Mode Schedule 
settings screen.

   Note:  Make the Night Mode Schedule settings only when all the units are in normal operation. When connection error occurs with 
the indoor or the outdoor units, the target outdoor units may not be displayed properly.

   Note:  The degree of noise reduction depends on the outdoor unit model.
   Note:  The Night Mode Schedule settings may not be accessible if logged in as a building manager.

(1) In the [Start Time] and [End Time] sections, specify the start and end times for the Night mode.
 Note:  When the start time and the end time is the same, the units will operate in the Night mode at all times.
 Note:  The time period over the next day (such as 22: 00 - 6: 00) can be set.

(2) In the [Target Outdoor Units] section, select the M-NET addresses of the target outdoor units.

(3) Click [Save Settings] to save the settings.

Start Time

Target Outdoor Units

Refresh
Click to import the settings  

from AE-200/AE-50/EW-50.

End Time

Save Settings
Click to save the changes 
made.
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7-3-3. System-changeover
The System-changeover function switches the operation modes of the indoor units connected to the same outdoor 
unit between cooling and heating based on the room temperature and the set temperature. Click [Functions 2] in the 
menu bar, and then click [System-changeover] to access the System-changeover settings screen.
The System-changeover function is available only on the Y series of outdoor units, whose operation modes do not 
include the Auto mode. Use this function to operate the air conditioning units in the heating mode in the morning 
and in the cooling mode in the afternoon. The operation mode of all indoor units will automatically be switched, 
eliminating the need to switch the operation mode manually from the remote controllers.

   Note:  Because the operation mode is selected based on the demands of the representative group or of the majority of the groups, 
not all areas may be air conditioned to the optimum temperature.

   Note:  The System-changeover settings may not be accessible if logged in as a building manager.
   Note:  If the outdoor unit is an R2 series, whose operation modes include the Auto mode, use the Auto mode instead of the System-

changeover function to switch the operation mode automatically.

(1) Select the Change Mode [None], [Averaging], or [Representative Group], referring to the table below.  
If [Representative Group] is selected, also select a representative group from among the groups on the 
right.

Table: Change Mode

Change Mode Content
None System-changeover function will not be used.

Averaging

The operation mode (cooling or heating) will be determined and switched every 15 
minutes based on the demands of the majority of all groups connected to the outdoor 
unit, taking into consideration the capacity of each indoor unit and the temperature 
differences between the set temperatures and room temperatures.

Representative Group
The operation mode (cooling or heating) will be switched based on the temperature 
difference between the set temperature and the room temperature of the 
representative group.

(2) Click [Save Settings] to save the settings.

Target outdoor unit
The M-NET address of the 

outdoor unit appears.

Change Mode

Refresh
Click to import the settings  

from AE-200/AE-50/EW-50.

Groups
The names of the groups 
that are connected to the 
outdoor unit appear. 
When the [Representative 
Group] mode is selected, 
select the representative 
group from among these 
groups.

Save Settings
Click to save the changes 
made.
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7-4. Functions 3
7-4-1. External Temperature Interlock

Based on the temperature difference between the set temperature and the outdoor temperature, the set temperature 
can be adjusted automatically. Making this control setting on the air conditioning unit at an entrance of a building 
prevents extreme temperature change from distressing our bodies and sending us into shock. Click [Functions 3] in 
the menu bar, and then click [External Temperature Interlock] to access the External Temperature Interlock settings 
screen.

   Note:  External Temperature Interlock is available only for air conditioning unit groups.
   Note:  Either an AI controller (PAC-YG63MCA) or AHC, and an outdoor temperature sensor are required to measure the outdoor 

temperature.
   Note:  When connecting one or more AE-50/EW-50 controllers, connect an AI controller (PAC-YG63MCA) and outdoor temperature 

sensor on each AE-50/EW-50.
   Note:  The External Temperature Interlock settings between the units connected to the AE-200, AE-50, and EW-50, as well as 

between the units connected to different AE-50/EW-50 controllers, cannot be made.
   Note:  The External Temperature Interlock settings may not be accessible if logged in as a building manager.

(1) In the [Temperature Sensor] section, select a temperature sensor to measure the outdoor temperature with.
In the pulldown menu, the name of the temperature sensor that is connected to the AI controller or the AHC 
will appear.
 Note:  Connect the temperature sensor to either the Analog Input 1 or Analog Input 2 port on the AHC.

(2) In the [Set Temperature Variation Range] section, select a maximum temperature value for each group to be 
added to or subtracted from the set temperature.
For example, when [±4°C] (±8°F) is selected and the set temperature for the Cool or the Dry mode is set to 
24°C (75°F), the set temperature will be adjusted to a maximum of 28°C (83°F) based on the temperature 
difference between the set temperature and the outdoor temperature. When [±2°C] (±4°F) is selected, the 
set temperature will be adjusted to maximum of 26°C (79°F).
 Note:  When the unit of temperature is Fahrenheit, the selected temperature value may not be added to the set temperature 

accurately because 2ºC is used for the calculation first, and then the temperature in Celsius is converted into the 
temperature in Fahrenheit.

(3) Click [Save Settings] to save the settings.

Temperature Sensor
Select a temperature sensor 

to measure the outdoor 
temperature with.

Group No. and  
group name

Refresh
Click to import the settings  

from AE-200/AE-50/EW-50.

Set Temperature Variation 
Range
Select a maximum 
temperature value to be 
added to or subtracted from 
the set temperature.

Save Settings
Click to save the changes 
made.
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When the External Temperature Interlock function is active, the set temperature will be adjusted as shown 
below.

■■ “Cool” and “Dry” modes

29
30
31
32
33
34
35
36

27
28

26
25
24
23

 

Outdoor temperature conditions Set temperature after being adjusted

Outdoor temperature ≥  
Set temperature + 1.5°C (3°F) Set temperature + 1°C (2°F)

Outdoor temperature ≥  
Set temperature + 4.5°C (9°F) Set temperature + 2°C (4°F)

Outdoor temperature ≥  
Set temperature + 6.5°C (12°F) Set temperature + 3°C (6°F)

Outdoor temperature ≥  
Set temperature + 7.5°C (14°F) Set temperature + 4°C (8°F)

■■ “Heat” mode

12
13
14
15
16
17
18
19

10
11

9
8
7
6

Outdoor temperature conditions Set temperature after being adjusted
Outdoor temperature ≤  

Set temperature - 4.0°C (8°F) Set temperature - 1°C (2°F)

Outdoor temperature ≤  
Set temperature - 6.0°C (11°F) Set temperature - 2°C (4°F)

Outdoor temperature ≤  
Set temperature - 8.0°C (15°F) Set temperature - 3°C (6°F)

Outdoor temperature ≤  
Set temperature - 10.0°C (18°F) Set temperature - 4°C (8°F)

Te
m

pe
ra

tu
re

 (°
C

)

Outdoor temperature

Time

Set temperature after being adjusted 
when [Set Temperature Variation 
Range] is set to [±4°C] (±8°F)

Set temperature

Te
m

pe
ra

tu
re

 (°
C

)

Set temperature

Set temperature after being adjusted 
when [Set Temperature Variation 
Range] is set to [±4°C] (±8°F)

Time

Outdoor temperature
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7-4-2. Night Setback Control
The Night Setback Control function (hereafter abbreviated as Setback Control) prevents indoor condensation by 
performing heating operation automatically when the room temperature goes outside of the specific range during 
the night. Click [Functions 3] in the menu bar, and then click [Night Setback Control] to access the Night Setback 
Control settings screen.
Heating operation starts when a given group is stopped and the room temperature drops below the specified 
minimum temperature.

   Note:  The Setback Control function also prevents excessive temperature rise by performing cooling operation automatically when 
the room temperature goes outside of the specific range. Cooling operation starts when a given group is stopped and the 
room temperature rises above the specified maximum temperature.

   Note:  If the room temperature is measured by the return air temperature sensor on the air conditioning unit, the measured value 
may not be an accurate representation of the temperature in the room, especially when the air conditioning unit is stopped 
and the room air is stagnant. When this is the case, use an external temperature sensor (PAC-SE40TSA) or remote 
controller sensor to measure the room temperature.

   Note:  The Night Setback Control may not be accessible if logged in as a building manager.

(1) Select [Use] and set the time period in which Setback Control is performed.
 Note:  When [00: 00 - 00: 00] is selected, Setback Control is active for 24 hours.

(2) In the [Temperature range] section, set the maximum and minimum temperatures for each group.
For example, if [Setback Control Period] is set to [01:00 - 05:00] and [Temperature range] is set to  
[12°C - --°C] ([53°F - --°F]), heating operation starts automatically when the room temperature drops below 
the set temperature 12°C (53°F) between 1:00 and 5:00. When the Setback Control ends at 5:00, the set 
temperature returns to the original setting, and the operation stops.

Setback Control Usability

Group No. and group 
name

Refresh
Click to import the settings  

from AE-200/AE-50/EW-50.

Setback Control Period

Temperature range

Copy

Paste

Save Settings
Click to save the changes 
made.
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 Note:  The air conditioning units in the heating operation will stop and the set temperature will return to the original setting 
when the Setback Control period is over or the room temperature rises to the minimum temperature plus 3°C (6°F). 
Likewise, the air conditioning units in the cooling operation will stop and the set temperature will return to the original 
setting when the Setback Control period is over or the room temperature drops to the maximum temperature minus 
3°C (6°F).

(3) To copy the settings of a group to the settings for other groups, click [Copy] in the row of the group whose 
settings are to be copied, then click [Paste] in the row of the group to which the copied settings are to be 
pasted. The rectangular icons next to the selected buttons will appear in yellow-green.

(4) Click [Save Settings] to save the settings.

Room temp.
21°C (69°F)

Min. temp.
12°C (53°F)

Heat ON
21°C (69°F)

When the temperature drops below the minimum temperature (heating operation)

Heat OFF

Setback 
operation 
starts.

Heat ON
12°C (53°F)

Max. temp.

Setback Control period

28°C (83°F)

Room temp.
24°C (75°F)

Setback 
operation 
ends.

Cool ON
24°C (75°F)

Heat OFF
21°C (69°F)

3°C (6°F)

Cool OFF

Setback 
operation 
starts.

When the temperature rises above the maximum temperature (cooling operation)

Cool ON
28°C (83°F)

Setback 
operation 
ends.

Setback Control period

3°C (6°F)

Cool OFF
24°C (75°F)
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7-4-3. Interlock control
Click [Functions 3] in the menu bar, and then click [Interlock control] to access the Interlock Control settings screen. 
Set the interlocking conditions and actions, and then click [Save Settings] to save the settings.

   Note:  A separate license is required to use the Interlock Control function. Make sure that the required license has properly been 
registered on the Registration of Optional Functions screen. (Refer to section 4-5 “License registration for optional functions” 
for details.)

   Note:  The Interlock Control settings may not be accessible if logged in as a building manager.
   Note:  Interlock Control is not effective when [External Input Setting] is set to [ON/OFF (Level signal)]. (See section 7-1-2-3 “External 

Input Setting”).
   Note:  If a group is deleted on the group settings screen, be sure to delete the Interlock Control settings in which the group is 

selected as the input units or the output units.

Up to 150 Interlock Control settings from No.1 through No.150 can be set for each AE-200/AE-50/EW-50. (Up 
to 600 Interlock Control settings can be made when one AE-200 and three or four AE-50/EW-50 controllers are 
connected.) The Interlock Control verifies the state changes in an ascending order of No.1 to No.150 every three 
to five seconds. When the interlocking conditions are met, the interlocking action commands will be issued to the 
output units.
By making the interlocking condition settings (input category, input states, and input units) and interlocking action 
settings (output unit type, actions, and output units) for each Interlock Control setting, the operation of the output 
units can be interlocked with the operation of the input units.

Caution:
Before using the Interlock Control function, you must agree to the following.

1. This function must not be used for disaster prevention or security purposes unless a backup device is 
provided in case of failure of this function. (This function should never be used in the way that would put 
people's lives at risk.)

2. The interlocking action settings that are not supported by the interlocked output units must not be made on 
the [Set up Actions] screen. Failure to observe this precaution may result in malfunctions.

3. After completing each Interlock Control setting, perform a test run and confirm proper settings and 
operation.

4. Do not set the Interlock Control settings as the following examples show. Doing so will cause short-cycling, 
resulting in unit damage.

    Example 1:  Group 1 is turned off when Group 1 is turned on.
    Example 2:  Group 1 is turned on when Group 1 is turned off.

Execute/Stop Execution
Click to enable/disable the 

Interlock Control.

Enable/Disable
Click to enable/disable each 

Interlock Control setting.

Input Category
Input state 1
Input state 2

Select Input Units
Click to display the screen to 

select input units.

Refresh
Click to import the settings  

from AE-200/AE-50/EW-50.

Save Settings
Click to save the changes 

made. 

Delete all steps
Click to delete all Interlock 
Control settings.

Output Unit Type

Edit buttons

Status bar
Shows the settings status 
of 150 settings (Green: 
Settings have been made; 
Red: Incomplete settings 
exist.)

Scroll bar
Slide to show different 
Interlock Control settings 
between No.1 and No.150.

Action
Click to set the interlocking 
actions.

Select Output Units
Click to display the screen to 
select output units.
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Shown below are eight examples of Interlocked operations.

Example 1:  Interlocked operation of indoor unit and card key via a DIDO controller

AE-200

Example 2:  Interlocked operation of operation mode between indoor units

AE-200

Example 3:  Interlocked operation of indoor unit and window through the free contact on an indoor unit

AE-200

Example 4:  Interlocked operation of indoor unit, lighting, and card key through the free contact on an indoor 
unit

AE-200

② Signal indicating the card 
key has been removed

③ Signal to stop the indoor 
unit

DIDO controller
(PAC-YG66DCA)

① The card key status is input 
through the contact.

Indoor unit

Card key

② Signal indicating the operation mode for the 
indoor unit #1 has changed to fan mode

③ Signal to change the 
operation mode for the 
indoor unit #2 to fan 
mode

Indoor unit #1 
(conference room No.1)

Indoor unit #2 
(conference room No.2)

① The operation mode has changed 
from heating to fan mode.

Remote 
controller

② Signal indicating the 
window has been opened

③ Signal to stop the indoor 
unit

Indoor unit

① The open/close status of the window is 
input to the free contact (CN32).

Window

② Signal indicating the card 
key has been removed

③ Signal to stop the indoor 
unit and turn off the 
lighting

① The card key status is input 
to the free contact (CN32).

Indoor unit

④ Signal to turn off the lighting 
via the free contact

Card key

Lighting
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Example 5:  Interlocked operation of indoor unit and other company’s ventilation unit via a DIDO controller

AE-200

Example 6:  Interlocked operation of the indoor unit in error and the auxiliary unit

AE-200

Example 7:  Interlocked operation of the indoor units

AE-200

Example 8:  Interlocked operation of the security system and the connected units

AE-200

② Signal to operate the other company’s 
ventilation unit

① The indoor unit has 
started operation

DIDO controller
(PAC-YG66DCA)

Indoor unit

Other company’s 
ventilation unit

② Signal to operate the 
auxiliary unit

Indoor unit

Auxiliary unit

① An error has occurred in the 
indoor unit.

Indoor unit in error

② Signal to stop the other 
indoor units

Representative 
indoor unit

① The representative indoor unit 
has stopped

Indoor unit Indoor unit Indoor unit

② Signal to stop the 
indoor unit

Representative 
indoor unit

① The security system alarm is input to 
the free contact (CN32).

Indoor unit

Indoor unit LOSSNAY unit

Security system
② Signal to stop the 

indoor unit
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[1]  Making the interlocking condition settings
(1) Setting an Input Category and Input States

Select an Input Category and Input States 1 and 2, referring to the table below.

Table: Interlocking condition settings

Input Category Input 
unit icon Input State 1 Input State 2

Group 
(On/Off)

All Groups On
All Groups Off
One or more Groups On
One or more Groups Off

–

Group 
(Mode)

All groups in the mode
All groups out of the mode
One or more groups in the mode
One or more groups out of the mode

Air conditioning unit group:            *1 *2 *3

 Cool, Dry, Fan, Heat, Auto, Setback
LOSSNAY unit group: 
 Bypass, Heat Recovery, Auto

Group 
(Error/Normal)

All units in error
All units in normal operation
One or more units in error
One or more units in normal operation

–

Free Input Points 
(On/Off)

All Units On
All Units Off
One or more Units On
One or more Units Off

–

*1 The operation modes for Air To Water (PWFY) unit groups, HWHP (CAHV, CRHV) unit groups, or general equipment groups are 
not available for selection.

*2 If the selected operation mode is not available on the input unit, interlocking conditions will not be fulfilled.
*3 The Setback mode can be selected on the AE-200A/AE-50A/EW-50A, but not on the AE-200E/AE-50E/EW-50E.

   Note:  If the Input Category is set to [Group (On/Off)] and the Input State 1 is set to [All Groups On], the interlocking action 
commands will be issued to the output units when the state on the input units changes to [All Groups On] from another state [All 
Groups Off], [One or more Groups On], or [One or more Groups Off].

   Note:  Free contact is available for use on R410A- and R407C-compatible indoor units with software Ver. 33 or later. The software 
version can be confirmed with the Maintenance Tool.

   Note:  When [External Input Setting] is set to [Emergency Stop (Level signal)] (see section 7-1-2-3 “External Input Setting”) or when 
the indoor unit is stopped due to the Peak Cut control (see section 7-2-2 “Peak Cut (Energy-save control function)”), only the 
Interlock Control of free contact and DIDO controller (PAC-YG66DCA) will be performed, but other Interlock Control will not 
be.
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(2) Selecting the input units
Click [Select Input Units] to display one of the following screens, depending on the selected Input Category.

(A) When [Group (On/Off)], [Group (Mode)], or [Group (Error/Normal)] is selected as the Input Category

The [Select Input Groups] screen will appear.

Select the group numbers of the input unit groups. The 
selected group numbers will appear with a yellow-green 
background.
Click again to deselect. The deselected group numbers will 
appear with a light-gray background.
To deselect all selected groups, click [Reset selections].

To select a block of groups, click [Select a Block]. Select a 
block name and press [OK]. The groups that are registered 
to the block will appear with a yellow-green background.

   Note:  If the Input Category is set to [Group (On/Off)] or [Group (Error/Normal)], air conditioning unit groups, LOSSNAY 
unit groups, Air To Water (PWFY) unit groups, HWHP (CAHV, CRHV) unit groups, and general equipment 
(connected via DIDO controller PAC-YG66DCA) groups can be selected. 
If the input category is set to [Group (Mode)], air conditioning unit groups and LOSSNAY unit groups can be 
selected.

   Note:  Different types of groups (air conditioning unit groups, LOSSNAY unit groups, or general equipment (connected 
via DIDO controller PAC-YG66DCA) groups) cannot be simultaneously selected.

(B) When [Free Input Points (On/Off)] is selected as the Input Category

The [Select Addresses of Input Units] screen will appear.

Select the addresses of the indoor units to which the 
general equipment is connected, and select contact points 
for each indoor unit.
The selected unit address will appear with a red frame. The 
unit addresses whose contact points have been set will 
appear with a yellow-green background.
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[2]  Making the interlocking action settings
(1) Setting an Output Unit Type and Actions

Select an Output Unit Type and set the Actions, referring to the table below.

Table: Interlocking action settings

Output Unit 
Type

Output 
unit icon

Actions

Setting item*2 Setting options

Group

ON/OFF ON, OFF

Mode *1
Air conditioning unit group:
 Cool, Dry, Fan, Heat, Auto, Setback*3

LOSSNAY unit group:
 Bypass, Heat Recovery, Auto

Set Temp. *1 Desired temperature

Air direction *1 Mid3, Mid2, Mid1, Mid0, Horizontal, Swing, Auto

Fan speed *1 Low, Mid2, Mid1, High, Auto

Prohibit Remote Controller 
Operation (ON/OFF) Permit, Prohibit

Prohibit Remote Controller 
Operation (Mode) Permit, Prohibit

Prohibit Remote Controller 
Operation (Set Temp.) Permit, Prohibit

Free Output 
Points ON/OFF ON, OFF

*1 The available setting options vary, depending on the connected indoor unit model. 
Make the interlocking action settings that are available for the output units.

*2 Only the items “ON/OFF” and “Prohibit Remote Controller Operation (ON/OFF and Set Temp.)” can be selected for Air To Water 
(PWFY) units. Only the item “ON/OFF” can be selected for HWHP (CAHV, CRHV) units.

*3 The Setback mode can be selected on the AE-200A/AE-50A/EW-50A, but not on the AE-200E/AE-50E/EW-50E.
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The screen display under Action will vary, depending on the selected Output Unit Type.

(A) When [Group] is selected as the Output Unit Type

Click [Edit] under Action. The [Set up Actions] 
screen will appear.

Set the interlocking actions to be taken when the 
interlocking conditions are met.

   Note:  The current operation status will be maintained for the setting items that were not changed.
   Note:  The set temperature cannot be set unless the operation mode has been set.
   Note:  If the selected operation mode is not available on the interlocked output units, the Interlock Control will not be 

performed.
   Note:  To prevent malfunctions of the air conditioning units, be sure to set the set temperature to a temperature within 

the normal operating temperature range, although there may be rare cases in which it is possible to set the set 
temperature to a temperature outside the normal operating temperature range (depending on the model of the 
air conditioning units that are connected to a system).

   Note:  Signals for Swing and Auto of Air direction setting and Auto of Fan speed setting will not be output unless these 
functions are available on the interlocked output units. 
With respect to the air direction and fan speed, if the number of settable air directions and fan speeds vary 
among the connected unit models, the signals that are rounded up to the settable range may be output.

   Note:  When the interlocking conditions are met, it will take some time to issue the interlocking action commands to the 
output units. This may delay the state change verification, which is usually performed every three to five seconds.

(B) When [Free Output Points] is selected as the Output Unit Type

Select [ON] or [OFF] under Action to turn on or off 
the output units.
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(2) Selecting the output units
Click [Select Output Units] to display one of the following screens, depending on the selected Output Unit 
Type.

(A) When [Group] is selected as the Output Unit Type

The [Select Output Groups] screen will appear.

Select the group numbers of the output unit groups. The 
selected group numbers will appear with a yellow-green 
background.
Click again to deselect. The deselected group numbers will 
appear with a light-gray background.
To deselect all selected groups, click [Reset selections].

To select a block of groups, click [Select a Block]. Select a 
block name and press [OK]. The groups that are registered 
to the block will appear with a yellow-green background.

   Note:  If the Output Unit Type is set to [Group], air conditioning unit groups, LOSSNAY unit groups, Air To Water (PWFY) 
unit groups, HWHP (CAHV, CRHV) unit groups, and general equipment (connected via DIDO controller PAC-
YG66DCA) groups are available for selection.

   Note:  Different types of groups (air conditioning unit groups, LOSSNAY unit groups, Air To Water (PWFY) unit groups, 
HWHP (CAHV, CRHV) unit groups, or general equipment (connected via DIDO controller PAC-YG66DCA) 
groups) cannot be simultaneously selected.

(B) When [Free Output Points] is selected as the Output Unit Type

The [Select Addresses of Output Units] screen will appear.

Select the addresses of the indoor units to which the 
general equipment is connected, and select contact points 
for each indoor unit.
The selected unit address will appear with a red frame. 
The unit addresses whose contact points have been set 
will appear with a yellow-green background.
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[3]  Disabling/Enabling Interlock Control settings
Use the Enable/Disable button to enable or disable each Interlock Control setting.
No actions will be taken for the Interlock Control setting that is set to [Disable].

[4]  Temporarily disabling the Interlock Control
Click the [Stop Execution] button to temporarily disable the Interlock Control. Click [Execute] to resume the Interlock 
Control.

   Note:  State change that occurs while [Stop Execution] is selected will be ignored.

[5]  Editing Interlock Control settings
Use the Edit buttons to edit each row of Interlock Control setting.

Button name Function
Delete all steps Deletes all Interlock Control settings.

Insert a step
Inserts a blank row of Interlock Control setting above the row that is displayed, and moves all 
rows down by one.
If interlocking conditions are entered in the last row, no more rows can be inserted.

Delete a step Deletes the row of Interlock Control setting that is displayed, and moves up the rows below by 
one.

Clear the display Clears the row of Interlock Control setting that is displayed.

Copy To copy the settings of a row to the settings for other rows, display the row whose settings are 
to be copied and click [Copy], then display the row to which the copied settings are to be pasted 
and click [Paste].Paste
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7-4-4. AHC Port Name Settings
On the AHC Port Name Settings screen, enter the names of the input and output ports of the Advanced HVAC 
CONTROLLER (AHC).
The names that are entered on this screen will appear on the AHC List screen.
Click [Functions 3] in the menu bar, and then click [AHC Port Name Settings] to access the AHC Port Name Settings 
screen.

   Note:  The AHC port name settings may not be accessible if logged in as a building manager.

Important:   The AHC port name settings must be made after all units have been started up. 
The settings that have been saved while one or more units are starting up may be lost.

(1) In the [Input Port Name] field, enter the input port name in 20 characters or less.
 Note:  Digital Input (DI) 1–15, Extended Input (EI) 1–4, and Analog Input (AI) 1–8 will appear regardless of whether the 

ports are used or not.
 Note:  The following characters cannot be used in the [Input Port Name] field:  <, >, +, &, “, or ‘

(2) In the [Output Port Name] field, enter the output port name in 20 characters or less.
 Note:  Digital Output (DO) 1–9, Extended Output (EO) 1–4, and Analog Output (AO) 1–2 will appear regardless of whether 

the ports are used or not.
 Note:  The following characters cannot be used in the [Output Port Name] field:  <, >, +, &, “, or ‘

(3) Click [Save Settings] to save the settings.

Unit address

Digital Input
(1–15)

Input Port Name

Refresh
Click to import the settings  

from AE-200/AE-50/EW-50.

Extended Input
(1–4)

Output Port Name

Digital Output
(1–9)

Extended Output
(1–4)

Analog Output
(1–2)

Analog Input
(1–8)
Save Settings
Click to save the changes 
made.
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7-5. Ventilation Settings
7-5-1. Night purge

During summer, the Night purge function draws cooler outside air into the room to suppress temperature rises at 
night. This energy conservation reduces the load when air conditioning starts the next morning.
Click [Ventilation Settings] in the menu bar, and then click [Night purge Setting] to access the Night purge settings 
screen.
All ventilation unit (LOSSNAY) groups that support the Night purge function from AE-200 will appear.

   Note:  During the Night purge operation, the ventilation units (LOSSNAY) operate in the Bypass mode.
   Note:  Night purge setting cannot be made from AE-200 for the ventilation units (LOSSNAY) that are connected to the AE-50/EW-50 

in communication error.
   Note:  Some models of ventilation units (LOSSNAY) do not support the Night purge function from AE-200. (As of March 2015, only 

LGH-RVX-E models support the function.)
For more details about the Night purge function, refer to the Installation Manual, Instruction Book, or technical documents 
that are provided with the ventilation unit (LOSSNAY).

(1) Click the “Setting contents” section in the row of the group whose settings are to be made. A settings screen 
will appear.
 Note:  To make settings for all groups at once, click [Batch Operations].

(2) In the Night purge setting section, select [Available] to enable the Night purge settings.

(3) Select one or more days on which the Night purge control is executed at the selected start time.

(4) Set the times at which the Night purge control starts and ends.

(5) Set the outdoor temperature threshold value as a condition for activating the Night purge operation. 
 * The settable temperature is between 15ºC and 30ºC.

Night purge setting
[Available]/[Not Available]  

Group No. and group 
name

Refresh

Batch Operations
Click to operate the units in 
all groups at once.

Setting contents

Save Settings
Click to save the changes 
made.

Night purge setting
[Available]/[Not 

Available]  

Outdoor temperature 
threshold

Temperature 
difference between 

room temperature and 
outdoor temperature

Days of the week

End Time

Initial fan speed

Start Time
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(6) Set the temperature difference as a condition for activating the Night purge operation.
 * The settable temperature is between 0ºC and 7ºC.

(7) Set the fan speed to be set when the Night purge operation activates.

(8) Click [OK] to go back to the previous screen.

(9) After the settings are completed, click [Save Settings] to send the settings to the AE-200/AE-50/EW-50.

Starting condition
  Condition #1: LOSSNAY units stop at 20:00.
  Condition #2: Between the start time 1:00 and the end time 6:00
  Condition #3:   LOSSNAY units detected the outdoor temperature threshold 17ºC or higher in the past 24 hours.
  Condition #4: The current room temperature is higher than 22ºC.
  Condition #5:   The temperature difference between room temperature and outdoor temperature is greater than 

the temperature difference 5ºC.
• LOSSNAY units start the Night purge operation at 3:00 when the temperature difference between room 

temperature and outdoor temperature exceeds 5ºC.
• The Night purge operation is not activated at 1:00 or 2:00 because the temperature difference between room 

temperature and outdoor temperature is less than 5ºC.

Condition #3
Maximum outdoor 
temperature: 29ºC

Time

Temperature

Outdoor temp.

Room temp.

LOSSNAY ON

Condition #4
Room temp.: 25ºC

OFF

1:00
Temp. 

difference: 
2ºC

2:00
Temp. 

difference: 
4ºC

Condition #5
Temp. difference: 6ºC

Night purge 
operation OFF

22ºC

17ºC
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7-6. User Settings
On the User Settings screen, the user names and passwords of maintenance users and building managers can be 
changed, and the available functions for building managers can be limited.
For example, you can allow building managers to change the group name settings when the tenant is changed, or 
disallow them to change the basic system settings such as unit settings or network settings.
Also, maintenance users can use this screen to change the user name and password of building managers in case 
that they are forgotten.
Click [User Settings] in the menu bar to access the User Settings screen.

(1) To change the maintenance user name or password, type new information in the [User Name], [New 
Password], and [Retype Password] fields.
 Note:  If the user logs in as a building manager, the maintenance user name and the password will not be displayed, and 

cannot be changed.
 Note:  User name must contain only alphanumeric characters.
 Note:  The user name and password are case-sensitive.
 Note:  The user name must be in 20 characters or less, and the password in 3 to 10 characters.

(2) To change the building manager’s user name or password, type new information in the [User Name], [New 
Password], and [Retype Password] fields.

Maintenance user name 
and password

User name and password 
can be changed.

Building manager’s user 
name and password

User name and password 
can be changed.

Refresh
Click to import the settings  

from AE-200/AE-50/EW-50.

Available functions
Select the available functions 
for building managers.

Save Settings
Click to save the changes 
made.
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(3) Click the functions to be made available for building managers. The rectangular icons next to the selected 
functions will appear in yellow-green.
Click again to deselect. The rectangular icons next to the deselected functions will appear in gray.
For more information on each function, refer to the table below.
 Note:  If the user logs in as a building manager, the currently available functions can be checked, but cannot be changed.
 Note:  The settings on this screen will not be reflected to the functions on the AE-200/AE-50’s LCD.

Table: Available Function List

Function Content

Initial Settings

Date and Time Refer to section 7-1-1 for details.
Basic System *1 Refer to section 7-1-2 for details.

Groups
Group Name

Refer to section 7-1-3 for details.
Group Structure

Interlocked LOSSNAY *1 Refer to section 7-1-4 for details.

Blocks
Block Name

Refer to section 7-1-5 for details.
Block Structure *1

Functions 1

E-Mail *1 Refer to section 7-2-1 for details.

Peak Cut
System Settings

Refer to section 7-2-2 for details.
Control Details

Measurement Refer to section 7-2-3 for details.
Energy Management Settings Refer to section 7-2-4 for details.

Functions 2
Set Temperature Range Limit Refer to section 7-3-1 for details.
Night Mode Schedule Refer to section 7-3-2 for details.
System-changeover Refer to section 7-3-3 for details.

Functions 3

External Temperature Interlock Refer to section 7-4-1 for details.
Night Setback Control Refer to section 7-4-2 for details.
Interlock control Refer to section 7-4-3 for details.
AHC Port Name Settings Refer to section 7-4-4 for details.

Ventilation 
Settings Night purge Setting Refer to section 7-5-1 for details.

*1 At factory shipment, these settings by the building managers are prohibited.

(4) Click [Save Settings] to save the settings.
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8. Maintenance
This section explains backup and reading of settings data.

There are two ways to backup the settings data — from the AE-200’s LCD to a USB memory device, and from 
AE-200/AE-50/EW-50 Web Browser for Initial Settings.

8-1. Settings Data Backup from the AE-200’s LCD
Backup the settings data from the AE-200’s LCD to a USB memory device. 
Backup of settings for the AE-200 and for the expansion controller is possible.

   Note:  Use a USB memory device that meets the following conditions.
• Supports USB 2.0
• Formatted with FAT32 or FAT (FAT16)
• Security function is not provided or not required to be set.

   Note:   Test the USB memory device several times before use and verify that the device functions properly. Reading data from or 
writing data to a USB memory device that has not been confirmed to work may cause unexpected problems. (If the data 
cannot be output to the USB memory device after a writing error occurs and the device is replaced, reboot the AE-200/AE-50 
(turn off the power and restart). Do not use the USB memory device that has experienced writing error once.)

8-1-1. Backing up settings data
The settings data can be exported to a USB memory as a backup.
Touch [Maintenance] in the menu bar, and then touch [Backup].

   Note:   IP address settings will not be backed up. Make sure to write them down.

Important
 ● The USB memory device may not be recognized if you insert and remove it within a short time. If this happens, reset the 
AE-200/AE-50.

 ● The AE-50/EW-50 data can be output from the AE-200.

(1) Remove the controller cover, and insert a USB memory device to the USB port.

All settings

Copy to USB Memory
Touch to back up the 
settings data.
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(2) Touch [All settings], then touch [Copy to USB Memory].
The settings data file will be created in the root folder of the USB memory.

 ■ File output destination, folder name, and file name
[Root folder of the USB memory]\[Serial No.]\“SettingData”\“AE” *1
*1 “AE1,” “AE2,” “AE3,” or “AE4” when one or more AE-50/EW-50 controllers are connected

<Example>

Root folder of the USB memory
12345-123 (AE-200 serial No.)

SettingData
AE AE-200 settings file
AE1 AE-50_1 settings file
AE2 AE-50_2 settings file
AE3 AE-50_3 settings file
AE4 AE-50_4 settings file

 Note:  It will take a few minutes to create the settings data.
 Note:  Do not remove the USB memory device while the data is being output.
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8-1-2. Importing settings data
The exported data can be imported back to the AE-200/AE-50/EW-50 to restore the previous settings after the 
controller replacement.
Touch [Maintenance] in the menu bar, and then touch [Import].

Important
 ● The USB memory device may not be recognized if you insert and remove it within a short time. If this happens, reset the 
AE-200/AE-50/EW-50.

(1) Have the settings data to be imported ready in the root folder of the USB memory as shown below.

 ■ File location, folder name, and file name
[Root folder of the USB memory]\“SetupData”_[IP address]\“AE” *1
*1 “AE1,” “AE2,” “AE3,” or “AE4” when one or more AE-50/EW-50 controllers are connected

<Example (When AE-200 LAN1 IP address is [192.168.1.1]>

Root folder of the USB memory
SetupData_192_168_1_1 *2

AE AE-200 settings file
AE1 AE-50_1 settings file
AE2 AE-50_2 settings file
AE3 AE-50_3 settings file
AE4 AE-50_4 settings file

*2 The folder name will not be [SetupData_192_168_001_001].
 Note:  Only the data that have been backed up from the AE-200 can be imported to the AE-200. The data that have been 

backed up from the AE-50 must be imported to the AE-50.
 Note:  Do not change the file name from that of when backup was performed. If the folder name or file name is different from 

the given name, no data can be read.

(2) Remove the controller cover, and insert a USB memory device to the USB port.

(3) Touch [All settings], then touch [Read from USB Memory].
 Note:  It will take a few minutes to import the settings data.
 Note:  Do not remove the USB memory device while the data is being imported.
 Note:  If the data is not read, check the folder name and the file name.
 Note:  If the data is not read, check if the USB memory device is inserted correctly.

All settings

Read from USB Memory
Touch to import the settings 
data.
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8-2. Settings Data Backup from the Web Browser for Initial Settings
Backup settings data from the AE-200/AE-50/EW-50 Web Browser for Initial Settings to a hard disk or to a USB 
memory device.
If there are multiple AE-200/AE-50/EW-50, then it is necessary to back up these individually.

Click [Utility] in the menu bar, and then click [Back up/import settings data] to access the Back up/import settings 
data screen.

   Note:  Back up/import settings data function is accessible only if logged in as a maintenance user.

8-2-1. Backing up settings data
(1) To back up the data, click [Back up settings data]. The settings data will be created and the Window’s 

standard file download dialog will appear.
 Note:  It will take a few minutes to create the settings data.
 Note:  The name of the settings data will be “SettingData.dat”.

Data import source
The path to the file to be 

imported will appear.

Back up settings data
Click to back up the 
AE-200/AE-50/EW-50 
settings data.

Browse...
Click to browse for a file 
that contains the data to be 
imported.

Import settings data
Click to import the file 
specified in the “Data 
import source” field to the 
AE-200/AE-50/EW-50.



184WT07627X01

8-2-2. Importing settings data
(1) Click the [Browse...] button to launch the explorer and browse for a file that contains the data to be imported. 

Select the desired file, and click [Open]. The path to the file to be imported on an external storage media will 
appear in the [Data import source] field.

(2) Click [Import settings data] to import the data from the external storage media to the AE-200/AE-50/EW-50.
 Note:  It will take a few minutes to import the settings data.

(3) When the settings data has been successfully imported, the AE-200/AE-50/EW-50 will restart.

(4) Go back to the login screen and login again.
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9. Troubleshooting
See the table below and troubleshoot accordingly.

No. Problem Possible cause Solution

(1) 

Errors are displayed 
on the [Malfunction] 
screen under the 
[Status List] menu.

Or,

Error log is 
displayed on the 
[Unit Error] screen 
under the [Log] 
menu.

“Version combination error 
(0092)”

The versions of the 
AE-200/AE-50/EW-50 do 
not match.

• Check the versions of the AE-200 
and AE-50/EW-50.

Refer to the Instruction Book 
(Apportioned Electricity Billing 
Function) for details.

(2) 

“Warning - possibility of 
damaged metering device 
(0095)”

The measurement value 
of the metering device 
(which should count up the 
operation amount of air-
conditioning units) does 
not count up for 3 days or 
longer.

• Check if the measurement value 
is properly counted up on the 
[Measurement] screen under the 
[Monitor/Operation] menu.

• Check for proper connection 
between the electricity meter 
and the PI controller (when a PI 
controller is used).

• Check for proper connection 
between the electricity meter 
and the built-in Pulse Input (PI) 
on the AE-50/EW-50 (when a 
built-in Pulse Input (PI) on the 
AE-50/EW-50 is used).

• Check if no communication error 
between the PI controller and the 
AE-50/EW-50 is occurring.

(3) 

A message is 
displayed when 
Initial Setting 
Tool settings are 
transmitted.

Message:
“The versions of one or 
more centralized controllers 
are old and not compatible 
with this tool. The settings 
that are not supported for 
these centralized controllers 
will not be sent. Check the 
transmission result.”

Settings transmitted from 
Initial Setting Tool Ver. 1.1 
to AE-200/AE-50/EW-50 
Ver. 7.2.

Settings for functions added 
in AE-200/AE-50/EW-50 Ver. 
7.3 (Floor, Floor for Integrated 
Centralized Control Web) have not 
been carried out. 
Update the AE-200/AE-50/EW-50. 
Refer to section 4-4 “Software 
Update” for details of updates.

(4) 

Initial settings data cannot be output from the 
LCD to the USB memory device.

1)   The USB memory 
device is not set 
correctly.

2)   There is insufficient 
free space on the USB 
memory device.

3)   The USB memory 
device does not support 
the AE-200/AE-50.

4)   The USB memory 
device was removed or 
inserted too quickly.

5)   The USB memory 
device is write-
protected.

Check causes 1) to 3).

Cause 1)
Check that the USB memory device 
is fully inserted.

Cause 2)
Check that there is sufficient free 
space on the USB memory device, 
and if necessary, create more free 
space. (Maximum 64 MBytes)

Cause 3)
Use a USB memory device as 
detailed in section 8 “Maintenance”. 
After a malfunction has occurred, if 
writing does not proceed normally 
even after using a different USB 
memory device, then restart the 
AE-200/AE-50 (power OFF→ON), 
then try again using a USB memory 
different from that originally used.

Cause 4)
Restart the AE-200/AE-50 (power 
OFF→ON). 

Cause 5)
Unlock the write-protect switch on 
the USB memory. 
For details, refer to the USB 
memory device Instruction Book.
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No. Problem Possible cause Solution

(5) 

Reading of initial settings data from the USB 
memory device by using an LCD is not possible.

1)   The USB memory 
device is not set 
correctly.

2)   The USB memory 
device read folder is 
different.

3)   A USB memory device 
that supports the 
AE-200/AE-50 is not 
used.

Check causes 1) to 3).

Cause 1)
Check that the USB memory device 
is properly inserted.

Cause 2)
Check that the folder name for the 
initial settings data is correctly set 
as “SetupData” (case-sensitive). 
For details, refer to section 8-1 
“Settings Data Backup from the 
AE-200’s LCD”.

Cause 3)
Refer to Cause 3) of problem (4).

(6) 

Login to the initial settings screen from the LCD 
was successful, but the settings button stays 
pressed, and cannot be operated.

1)   This is logged in as 
the building manager, 
so there is no right for 
settings.

Cause 1)
Input the maintenance user login 
name and password, and log in. 
In order to log in as the building 
manager and configure settings, 
have the settings rights changed to 
maintenance user.

(7) 

When the AE-200’s Web Browser for Initial 
Settings is accessed, the message “If you see 
this you don’t have a Java-enabled Web browser. 
Here’s a picture of what you are missing.” or “Error. 
Click for details.” appears, and no login window 
appears.

1)   Improper temporary 
files remain in the web 
browser, generating an 
error.

Cause 1)
Refer to section 9-1 “Notes on 
connecting to Web browser” and 
use the web browser, and reset the 
temporary files.
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9-1. Notes on connecting to Web browser
Follow the instructions below to change settings if the message “If you see this you don’t have a Java-enabled 
Web browser. Here’s a picture of what you are missing.” or “Error. Click for details.” appears, and no login window 
appears when the AE-200’s Web page is accessed.

   Note:  To remedy the above-mentioned problem, go to section 9-1-1 “Clearing cache” first, and if the problem still persists, go to 
section 9-1-2 “Resetting Internet Explorer”. Resetting Internet Explorer will reset Internet Explorer’s settings to their default 
condition.

9-1-1. Clearing cache
[1]  How to clear Java cache
(1) Click [Control Panel]>[Java].

 Note:  If [Category] is selected in the top right corner, next to [View by: ], change it to [Large icons] or [Small icons].

(2) Java Control Panel will open. 

(3) Click [Settings…] under [Temporary Internet Files].

(4) The [Temporary Files Settings] dialog will appear. Click [Delete 
Files…].

(5) The [Delete Files and Applications] dialog will appear. Make sure 
that the checkboxes next to [Trace and Log Files] and [Cached 
Applications and Applets] are both checked, and then click [OK].
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[2]  How to clear Internet Explorer cache
(1) Open the Internet Explorer, click [Tools] in the menu bar, and then click [Internet options].

(2) The [Internet Options] dialog will appear. 
Click [Delete...] under [Browsing history].

(3) Make sure that the checkbox next to [Temporary Internet files] is 
checked, and then click [Delete].
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9-1-2. Resetting Internet Explorer
If the problem persists after section 9-1-1 “Clearing cache”, reset Internet Explorer settings.

   Note:  Resetting Internet Explorer’s settings will impact the following. Before you make any changes, write down the current 
settings if necessary. 
- Disable toolbars and add-ons 
- Advanced options 
- Default web browser settings 
- Tabbed browsing settings 
- Privacy settings 
- Pop-up settings 
- Security settings

(1) Open the Internet Explorer, click [Tools] in the menu bar, and then click [Internet options].

(2) The [Internet Options] dialog will appear. 
Click the [Advanced] tab, and then click [Reset...] under [Reset 
Internet Explorer settings].
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10. Advance preparation
This section explains preparations for prior to configuring initial settings.

10-1. Preparation of the PC
Prepare a PC with which to use the Initial Setting Tool and Web Browser for Initial Settings. 
These preparations are not required when configuring all settings using only the LCD.

Carry out preparations using the following procedure.

 
In order to use the Initial Setting Tool, connect to the Internet, 
and install the .NET Framework.
(See section 10-1-1 “Installation procedures of .NET 
Framework”.)

Install Initial Setting Tool.
(See section 10-1-2 “Installation procedures of the Initial 
Setting Tool”.)

Set the IP address of the PC.
(See section 10-1-3 “Setting the PC’s IP address”.)

Configure Web browser settings to use the Web Browser for 
Initial Settings.
(See section 10-1-4 “Setting the Web Browser”.)

Configure Java settings to use the Web Browser for Initial 
Settings.
(See section 10-1-5 “Java settings”.)

Check that you can log into the Web Browser for Initial 
Settings.
(See section 4-1 “Logging in to the Web Browser for Initial 
Settings”.)

Use Initial Setting Tool

.NET Framework installation

PC’s IP address setting

Web browser settings

Completed

Initial Setting Tool installation

Not use Web Browser for 
Initial Settings

Not use Initial Setting Tool

Java settings

Use Web Browser for Initial 
Settings

Login to the Web Browser for Initial Settings
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10-1-1. Installation procedures of .NET Framework
If .NET Framework 4.5.2 or later is not already installed, download the .NET Framework 4.5.2 installer from the URL 
shown below, and then install it.

URL for when the Internet is connected (Web installer) (English):
http://www.microsoft.com/en-US/download/details.aspx?id=42643

URL for when the Internet is not connected (Offline installer) (English):
http://www.microsoft.com/en-US/download/details.aspx?id=42642

 * Other language can also be selected from this website.

10-1-2. Installation procedures of the Initial Setting Tool
(1) Execute the install file for the Initial Setting Tool.

 * The install file name is “SetupISToolA_V***” for AE-200A/AE-50A/EW-50A. 
The install file name is “SetupISToolE_V***” for AE-200E/AE-50E/EW-50E. 
(“V***” indicates version number. “V110” indicates Ver. 1.10.)

(2) If the “Security Warning” message appears, click [Run].

(3) When the “Setup Wizard” screen appears, click [Next].

(4) The “License Agreement” screen will appear. Select [I Agree] and 
click [Next].

(5) The “Select Installation Folder” screen will appear. Select the save 
destination folder and click [Next].
 Note:  To allow all users who can login the PC to have access to the Initial 

Setting Tool, check that the [Everyone] checkbox is selected and 
then click [Next].
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(6) When the “Confirm Installation” screen appears, click [Next].

(7) The Initial Setting Tool will be installed.

(8) Once installation is completed, click [Close].

   Note:  An Initial Setting Tool shortcut icon will be created on the desktop.  
To launch the software, double-click the icon.
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10-1-3. Setting the PC’s IP address
Set the PC’s IP address so that settings data can be sent from the Initial Setting Tool to the AE-200/AE-50/EW-50. 
When setting the PC’s IP address, set a network address in the same system as the IP address for the 
AE-200/AE-50/EW-50.
(Example: AE-200 IP address: 192.168.1.1; PC IP address: 192.168.1.101)

[1]  For Windows 7
(1) Click [Control Panel] in the Start menu.

(2) Click [Network and Sharing Center] > [Local Area Setting].

(3) In the “Local Area Connection Status” window, click [Properties].

(4) Click [Internet Protocol Version 4 (TCP/IPv4)] to select it, and click 
[Properties].
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(5) In the [Internet Protocol Version 4 (TCP/IPv4) Properties] window, 
check the radio button next to [Use the following IP address].

(6) Enter the PC’s IP address (e.g., [192.168.1.101]) in the “IP 
address” field.

(7) Enter the subnet mask [255.255.255.0] (unless otherwise specified) 
in the “Subnet mask” field.

(8) In the “Default gateway” field, enter the gateway address as 
necessary.

Important
 ● Consult the system administrator to decide the IP, subnet mask, and gateway addresses.

(9) Keep clicking [OK] or [Close] to close all windows.

[2]  For Windows 8.1
(1) Click the [Desktop] icon on the Start screen.

(2) Double-click the [My Computer] icon on the desktop.

(3) Click [Open Control Panel] in the tool bar.

(4) Click the [Network and Sharing Center] icon.

(5) Click [Change adapter settings].

(6) Double-click the [Ethernet] icon.

(7) In the “Ethernet Status” window, click [Properties].

(8) Click [Internet Protocol Version 4 (TCP/IPv4)] to select it, and click [Properties].

(9) In the [Internet Protocol Version 4 (TCP/IPv4) Properties] window, check the radio button next to [Use the 
following IP address]

(10) Enter the PC’s IP address (e.g., [192.168.1.101]) in the “IP address” field.

(11) Enter the subnet mask [255.255.255.0] (unless otherwise specified) in the “Subnet mask” field.

(12) In the “Default gateway” field, enter the gateway address as necessary.
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 Important
 ● Consult the system administrator to decide the IP, subnet mask, and gateway addresses.

(13) Keep clicking [OK] or [Close] to close all windows.
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10-1-4. Setting the Web Browser
Web browser setting varies with the Internet connection type. See the sections below for how to make Web browser 
settings for different types of Internet connection.

   Note:  To prevent unauthorized access, always use a security device such as a VPN router when connecting the 
AE-200/AE-50/EW-50 to the Internet.

[1]  No Internet connection
To monitor and operate the air conditioning units from a PC with no Internet connection, follow the instructions 
below to set the environment for the Web browser.

(1) Click [Tools] in the menu bar, then click [Internet options].

(2) In the [Internet Options] window, click the [Connections] tab.

(3) Check the radio button next to [Never dial a connection] in the middle 
of the window, and click [OK] to close the window.
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[2]  Connecting to the Internet via proxy server using an existing LAN
To monitor and operate the air conditioning units from a PC that connects to the Internet through a proxy server 
by connecting to an existing LAN, such as a LAN within your company, follow the instructions below to set the 
environment for the Web browser.

(1) Click [Tools] in the menu bar, then click [Internet options].

(2) In the [Internet Options] window, click the [Connections] tab. 
 

(3) Check the radio button next to [Never dial a connection] in the middle 
of the window. 

(4) Click [LAN settings] under [Local Area Network (LAN) settings].

(5) In the [Local Area Network (LAN) Settings] window, check [Bypass 
proxy server for local addresses], and click [Advanced].

(6) In the [Proxy Settings] window, enter the AE-200/AE-50/EW-50’s 
IP address (e.g., 192.168.1.1) in the [Exceptions] field. Then, keep 
clicking [OK] or [Close] to close all windows.

If connecting multiple AE-200/AE-50/EW-50 units, enter their 
addresses (e.g., [192.168.1.1; 192.168.1.2]). It is also possible to use 
an asterisk as a wildcard (e.g., [192.168.1.*]).
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10-1-5. Java settings
Java settings are required to use the Web Browser for Initial Settings.

[1]  How to register exception site list
(1) Click [Control Panel]>[Java].

 Note:  If [Category] is selected in the top right corner, next to [View by: ], change it to [Large icons] or [Small icons].

(2) Java Control Panel will open. 
Click the [Security] tab.

(3) The security setting window will open.
Click the [Edit Site List...] button.

(4) The [Exception Site List] dialog will appear. 
Click [Add].

(5) The [Exception Site List] dialog will appear.
In the white box, enter the following, and then click [OK].
http://[IP address of AE-200, AE-50, or EW-50]
 Note:  If the IP address of the AE-200 is [192.168.1.1], enter 

[http: //192.168.1.1].
 Note:  When using HTTPS (SSL) connection, prefix the web address with 

[https]. (https: //[IP address of AE-200, AE-50, or EW-50])

(6) The security warning screen will appear. 
Click [Continue].
 Note:  The security warning screen will not appear when HTTPS (SSL) 

connection is used.
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(7) Add all AE-200/AE-50/EW-50 to the list in the same manner, and 
click [OK].

(8) If a PC with 32-bit OS is used, after completing the settings, close all Internet Explorer windows, and access 
the Web page again to make sure the appropriate window will appear.
If a PC with 64-bit OS is used, go to step (9) below.

(9) Click [My Computer]>[Local Disk (C:)]>[Program Files (x86)]*1>[Java]>[jre*] (The asterisk indicates a version 
number. (i.e., jre1.8.0_31))>[bin] to open the [bin] folder.

*1 If a PC with 64-bit OS is used, both [Program Files] and [Program Files (x86)] folders will appear. Make sure to select [Program 
Files (x86)].

(10) Double click the “javacpl.exe” file in the [bin] folder.

(11) Java Control Panel will open. Follow the steps (3) through (8) again.

[2]  How to enable Java content
(1) Open the security setting window. (See [1] “How to register exception site list”.)

(2) Click on the checkbox next to [Enable Java content in the browser] 
unless it is already checked.
Click [Apply] at the right bottom corner of the screen, and then click 
[OK].

(3) After completing the settings, close all Internet Explorer windows, and access the Web page again to make 
sure the appropriate window will appear.
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11. Explanation of terms
This explains terms used in this manual.

• AE-200 system
This indicates one AE-200 connected to 0 to 4 AE-50/EW-50 expansion controllers. 
System configurations are as follows.

■ AE-200 (independent)

A system that does not use an expansion controller. 
Use this configuration when not using the apportioned electricity billing function, with up to 50 units managed, 
and controlled from the LCD.

 

■ AE-200

A system that uses 1 to 3 expansion controllers. 
Use this configuration when not using the apportioned electricity billing function, with 50 or more units 
managed.

 

■ AE-200 (No M-NET)

A system that uses 1 to 4 expansion controllers. 
Use this configuration when not using the apportioned electricity billing function, with 50 or more units 
managed, and with the management room far from the indoor units, with electric power not reaching from the 
AE-200 to the indoor units.

 

AE-200

M-NET

AE-200

M-NET

LAN

AE-50/EW-50

M-NET

AE-200

M-NET

LAN

AE-50/EW-50

M-NET
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■ AE-200 (Billing)

A system that uses 1 to 4 expansion controllers. 
Use this configuration when using the apportioned electricity billing function.

 

• EW-50 system

This indicates a single EW-50 unit. 
Use this configuration when not using the apportioned electricity billing function, with up to 50 units managed, 
not using the LCD, and controlled from the Integrated Centralized Control Web.

 

• BACnet® Setting Tool
The BACnet® Setting Tool is used for configuring BACnet® functions from a PC. 
This allows separate configuration of single AE-200/AE-50/EW-50 units.
For how to use the BACnet® Setting Tool, refer to the Instruction Book (BACnet® Setting Tool).

 * BACnet® is a registered trademark of ASHRAE (American Society of Heating, Refrigerating and Air-Conditioning Engineers, INC.).

• Group
Groups are the smallest operational units. The same operation as with local remote controllers. 
Control 1 to 16 units together.

• Block (Operation block)
Blocks are multiple groups grouped together. 
It is possible to create blocks by partition or room, for batch monitoring and operation. 
Control 1 to 50 groups together. However, blocks that cover AE-200/AE-50/EW-50 cannot be configured.

• Energy management block
An energy management block combines multiple operation blocks and LOSSNAY with FU attribute.
This is the unit at which AE-50/EW-50 are together managed, and using the apportioned electricity billing function, 
at which the electric energy and billing calculation results are displayed and output.
Create energy management blocks by units such as tenant or floor, enabling batch monitoring, control, and 
management of electric energy and billing.
Control 1 to 200 operations groups together. However, energy management blocks that cover AE-200/EW-50 
systems cannot be configured.

AE-200

M-NET

LAN

AE-50/EW-50

M-NET

EW-50

M-NET
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AE-200

M-NET

LAN

M-NET

AE-50/EW-50

Energy management block

Operation block

Group

Indoor unit

Energy management block

Operation block

Group

Indoor unit

Group

AE-200

Energy management block

Operation block

Group

Group

Operation block

Energy management block

Indoor unit

Group

Operation block

Group

Group

LOSSNAY
(FU)
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• Main and Sub system controllers

Each group can be controlled by a Main system controller or a Sub system controller.
AE-200/AE-50 is exclusively for use as a Main system controller and cannot be used as a Sub system controller.

Main system controller
Main system controller refers to a system controller that controls all other system controllers including the units 
they control. If a given system has only one system controller, that controller becomes a Main system controller. 
Group settings and interlock settings can be made only from a Main system controller.

Sub system controller
Sub system controller refers to a system controller that is controlled by a Main system controller.

The system cannot be configured as shown in the examples below.

 ● Groups that are not under the control of a Main system controller cannot be controlled from a Sub system controller.

 ● Each group cannot be placed under the control of two or more Main system controllers.

 ● Sub system controllers cannot be placed under the control of two or more Main system controllers.

• License
A license may be required for AE-200/AE-50/EW-50 depending on the functions used.
Licenses required will differ depending on the functions used. Please contact your dealer as regards license types 
and purchasing.
Refer to section 4-5 “License registration for optional functions” for license registration method.

Sub system controller's  
control range

Main system controller's 
(AE-200/AE-50's) control range

Group Group Group

Group

Main system 
controller

Group

Sub system 
controller

Group

Group

Main system 
controller 1

Group

Main system 
controller 2

Group

Group

Main system 
controller 1

Group

Sub system 
controller

Group

Main system 
controller 2

Group
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Error code list
Error codes and their definitions are shown below. If an error occurs, note the error code and consult your dealer.
(A) indicates A-control units.

[1]  M-NET errors
0092 Version combination error
0093 System configuration change warning
0094 “Charge” license not registered
0095 Warning - possibility of damaged metering device
0096 Air conditioning charges file automatic output abnormality
0097 Apportioned calculation data collection error
0100 Equipment abnormality
01*0 Equipment abnormality (PAC-YG66DCA) in system *
01** Equipment abnormality in system **
0200 Hydraulic abnormality
0201 Heater overheating
0202 Heater disconnected
0203 General equipment
0204 Bad defrosting
0205 COS fault
0300 Hydraulic abnormality
0301 Heater overheating
0302 Heater disconnected
0303 General equipment
0304 Bad defrosting
0310 Maintenance inspections (inclusive)
0311 Long compressor running time
0400 Controller abnormality (inclusive)
0401 Controller I/O module abnormality
0402 Controller memory abnormality
0403 Serial transmission trouble
0404 Indoor unit EEPROM error (A)
0405 Outdoor unit EEPROM error (A)
0701 Combustion circuit abnormality (A)
0702 Combustion heat exchange overheating protection (A)
0703 Accidental fire (A)
0704 Heater abnormality (A)
0705 Seismoscope malfunction (A)
0706 Flame current sensor abnormality (A)
0707 Ignition abnormality (A)
0708 Blower motor rotation abnormality (A)
0709 Oil pump circuit abnormality (A)
0900 Test run
1000 Refrigerant cycle abnormality
10*0 Refrigerant cycle abnormality in line *
1102 Discharge temperature abnormality (TH4) (A)
1108 Inner thermo (49C) operation (A)
11** Refrigerant cycle temperature abnormality - Common operand: **
1300 Low-pressure abnormality (63L operation) (A)
13** Refrigerant cycle pressure abnormality - Common operand: **
1500 Refrigerant cycle not operate due to overcharge
1501 Refrigerant cycle not operate due to undercharge (/compressor shell temperature abnormality)
1502 Refrigerant cycle not operate due to liquid back /Low-discharge super heat abnormality (A)
1503 Refrigerant cycle not operate due to coil frost
1504 Refrigerant cycle not operate due to overheat protection
1505 Refrigerant cycle not operate due to compressor vacuum operation protection/refrigerant low temperature abnormality
1506 Refrigerant cycle not operate due to refrigerant pump abnormality
1507 Refrigerant cycle not operate due to composition detection abnormality
1508 Refrigerant cycle not operate due to control valve fault
1509 Refrigerant cycle not operate due to high pressure abnormality (ball valve closed)
1510 Refrigerant cycle - Gas leakage
1511 Refrigerant cycle not operate due to oil slick abnormality
1512 Refrigerant cycle not operate due to a stop of freezing protection function
1513 Refrigerant cycle - Brine freezing
1514 Refrigerant cycle - Refrigerant circuit error
1559 Oil balance circuit abnormality
1600 Refrigerant overfilled
1601 Insufficient refrigerant
1602 Liquid floodback
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1603 Freezing
1604 Excessive temperature rise protection
1605 Compressor vacuum operation protection
1606 Gas pump abnormality
1607 Composition detection abnormality
1608 Control valve fault delay
1610 Gas leak alarm
1615 Compressor excessive start-stop
1659 Oil equalizing circuit fault delay
2000 Water system abnormality (Pump interlock abnormality)
20*0 Water system abnormality in line *
21** Water system temperature abnormality - Common operand: **
23** Water system pressure abnormality - Common operand: **
2500 Water system not operate due to water leak
2501 Water system not operate due to water supply suspension
2502 Water system not operate due to drain pump abnormality
2503 Water system not operate due to drain sensor abnormality/float switch function
2504 Water system not operate due to liquid level abnormality
2505 Water system not operate due to cool water valve abnormality
2506 Water system not operate due to warm water valve abnormality
2507 Water system not operate due to dew condensation prevention control activated
2508 Water system - Air pump abnormality
2509 Water system - Brine pump abnormality
2510 Water system - Water level abnormality (heat storage tank, etc.)
2511 Water system - Brine low level abnormality
2512 Water system - Control valve fault
2515 Water system - Water pump abnormality
2550 Water system - Float switch 2
2555 Water system - Cold water solenoid valve 2
2556 Water system - Hot water solenoid valve 2
2600 Water system operation restricted due to water leak
2601 Water system operation restricted due to water supply suspension/humidifier water supply suspension
2602 Water system operation restricted due to drain pump abnormality
2603 Water system operation restricted due to drain sensor abnormality
2604 Water system operation restricted due to liquid level abnormality
2607 Water system - Condensation prevention control operation
2608 Water system - Air pump abnormality
2609 Water system - Brine pump abnormality
2610 Water system - Water level abnormality (heat storage tank, etc.)
2611 Water system - Brine low level abnormality
2613 Drop in water flow rate
2615 Water pump abnormality
3000 Air system - General air system abnormality 
30*0 Air system - Air system general X system abnormality (inclusive)
31** Air system - Temperature abnormality - Common operand: **
3152 Air system operation restricted due to inverter control box inner temperature abnormality
3182 Air system operation restricted due to housing inner temperature abnormality
33** Air system - Pressure abnormality - Common operand: **
3600 Air system operation restricted due to filter clogging
3601 Air system operation restricted due to filter maintenance
3602 Air system operation restricted due to damper position detecting abnormality
3604 Air system - Filter cleaning position detection abnormality (slim)
3605 Air system - Filter cleaning dust box installation abnormality (slim)
3606 Air system - Filter cleaning position detection abnormality
3607 Air system - Filter cleaning dust box installation abnormality
3608 Air system - Filter cleaning position detection connector connection abnormality
3609 Air system - Ambient temperature high
3610 Air system - Heat exchanger blockage
37** Air system operation humidity abnormality allowance - Common operand: **
38** Air system operation humidity abnormality - Common operand: **
4000 Electric system abnormality
40*0 Electric system abnormality in line *
4100 Electric system not operate due to overcurrent shut-off
4101 Electric system not operate due to overcurrent protection
4102 Electric system not operate due to open phase /Open phase (T phase) (A)
4103 Electric system not operate due to reversed phase/open phase
4104 Electric system not operate due to electric leak
4105 Electric system not operate due to short circuit
4106 Electric system not operate due to self power supply OFF/power failure
4107 Electric system not operate due to overload
4108 Electric system not operate due to overload protection/OCR51C /Open phase (S phase),51CM connector open (A)
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4109 Electric system not operate due to OCR51F
4110 Electric system not operate due to high voltage part
4111 Electric system not operate due to bus current
4112 Electric system not operate due to coil overheat 49°C
4113 Electric system not operate due to heater overheat
4114 Electric system not operate due to fan controller abnormality
4115 Electric system not operate due to power supply synchronism abnormality /Input circuit (board) failure
4116 Electric system not operate due to motor abnormality/speed abnormality
4117 Compressor self-protection function operation (A)
4118 Opposite phase detection circuit (board) failure (A)
4119 Open of 2 or more connectors (A)
4120 Electric system - Differing voltage applied
4121 Electric system not operate due to trouble in equipment to which a measure against higher harmonics is taken
4122 Electric system - Air blower fan interlock
4123 Electric system not operate due to Inverter output error
4124 Electric system not operate due to damper abnormality
4125 Electric system - Rush-proof circuit abnormality
4126 Electric system - Analog input abnormality
4127 Electric system - Deodorizing circuit abnormality
4128 Electric system - Pulse discharge circuit abnormality
4200 Inverter abnormality
420* Inverter abnormality - Inverter No.: *
4210 Inverter overcurrent shut-off
421* Inverter overcurrent shut-off - Inverter No.: *
4220 Inverter bus voltage insufficiency / Voltage abnormality (A)
422* Inverter bus voltage insufficiency - Inverter No.: *
4230 Inverter radiating thermostat abnormality
423* Inverter radiating thermostat abnormality - Inverter No.: *
4240 Inverter overcurrent (overload) protection
424* Inverter overcurrent protection - Inverter No.: *
4250 Inverter IPM/bus voltage abnormality /Power module abnormality (A)
425* Inverter IPM abnormality *
4260 Inverter cooling fan trouble
426* Inverter cooling fan trouble - Inverter No.: *
5000 Sensor trouble
50*0 Sensor trouble in system *
51** Temperature sensor trouble - Sensor No.: **
5202 Connector (63L) open (A)
52** Pressure sensor trouble - Sensor No.: **
5300 Current sensor abnormality (A)
53** Current sensor trouble - Sensor No.: **
54** Humidity sensor trouble - Sensor No.: **
55** Gas sensor trouble - Sensor No.: **
56** Air speed sensor trouble - Sensor No.: **
57** Limit switch trouble - Switch No.: **
58** Sensor trouble - Sensor No.: **
59** Other sensors trouble - Sensor No.: **
6000 System abnormality
6100 Instantaneous power interruption
6101 System not operate due to abnormality - With response frame
6102 No answer back
6103 Fire alarm emergency stop
6200 Controller H/W abnormality
6201 E2PROM abnormality
6202 RTC abnormality
6203 Timer kit abnormality
6204 External memory read/write error
6500 Communication error
6600 Communication error - Address duplicate
6601 Communication error - Polarity unsettled
6602 Communication error - Transmission processor hardware error
6603 Communication error - Transmission line busy
6604 Communication error - No ACK (06H) (communication circuit error)
6605 Communication error - No response frame
6606 Communication error - Transmission processor communication error
6607 Communication error - No ACK return
6608 Communication error - No return of response frame
6609 Communication error
6610 Communication error
6800 Communication error - Other communication errors
6801 Communication error - V-control communication error
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6810 Communication error - UR communication error
6811 Communication error - UR communication synchronism not recover
6812 Communication error - UR communication hardware error
6813 Communication error - UR communication status bit detection error
6820 Other communication errors
6821 Other communication errors - Transmission line busy
6822 Other communication errors - No communication ACK
6823 Other communication errors - No response command
6824 Other communication errors - Receive data error
6830 Communication error - MA communication refrigerant address double setting error
6831 Communication error - No MA communication reception error
6832 Communication error - MA communication synchronism not recover
6833 Communication error - MA communication transmission/reception hardware trouble
6834 Communication error - MA communication start bit detection error
6840 Communication error - A control no indoor/outdoor communication/reception abnormality
6841 Communication error - A control indoor/outdoor communication synchronization recovery abnormal
6842 Communication error - A control indoor/outdoor communication - Communication H/W abnormality
6843 Communication error - A control indoor/outdoor communication - Start bit detection abnormality
6844 Communication error - A control indoor/outdoor communication incorrect indoor/outdoor wiring connection, excessive number of indoor 

units (more than five units)
6845 Communication error - A control indoor/outdoor communication incorrect indoor/outdoor wiring connection (telecommunication, 

disconnection)
6846 Communication error - A control indoor/outdoor communication startup time exceeded
7000 System abnormality
7100 System abnormality - Total capacity error
7101 System abnormality - Capacity code error
7102 System abnormality - Connecting unit number excess
7103 System abnormality - Piping length setting error
7104 System abnormality - Floor height setting error
7105 System abnormality - Address setting over 254
7106 System abnormality - Attribute setting error
7107 System abnormality - Distributor setting error
7108 System abnormality - Refrigerant system setting error
7109 System abnormality - Connection setting error
7110 System abnormality - Refrigerant system connection/connection data unsettled
7111 System abnormality - I/O connection equipment not connected/remote controller sensor abnormality
7112 System abnormality - I/O type setting error
7113 System abnormality - Equipment unsettled
7114 System abnormality - Too many VAV units
7115 System abnormality - Too many units requiring ventilation
7116 System abnormality - Replace non-wash setting error
7117 System abnormality - Model identification setting error
7130 System abnormality - Different unit model error
7131 System abnormality - Mixed cooling only H/P connection error (Facility PAC)
7132 System abnormality - Multiple entries of operation performance (Facility PAC)
7200 System abnormality - Numeric values unsettled
7201 System abnormality - Numeric values unsettled
73** System abnormality - LON system equipment abnormality

[2]  Errors between AE-200 and AE-50 (EW-50)
6920 Communication error - No response error
6922 Communication error - Receiving frame ID error
7901 System abnormality - Excessive number of connected units
7902 System abnormality - Connection lock error
7903 System abnormality - Unit information error
7904 System abnormality - System setting error
7905 System abnormality - Version error/Different unit model error



This product is designed and intended for use in the residential,  
commercial and light-industrial environment.

The product at hand is based on the following EU regulations:
• Low Voltage Directive 2006/95/EC
• Electromagnetic Compatibility Directive 2004/108/EC
• Restriction of Hazardous Substances 2011/65/EU

Please be sure to put the contact address/telephone number  
on this manual before handing it to the customer.

HEAD OFFICE: TOKYO BLDG., 2-7-3, MARUNOUCHI, CHIYODA-KU, TOKYO 100-8310, JAPAN

WT07627X01


	Instruction Book –Initial Settings–
	1.	Safety precautions
	1-1. General precautions
	1-2. Precautions for relocating or repairing the unit
	1-3. Additional precautions

	2.	Introduction
	2-1. Terms used in this manual
	2-2. Flow of the initial settings and trial run
	2-3. Functions that can be set

	3.	Parts to be used
	3-1. Separately sold parts
	3-2. Commercially available parts
	3-3. PC requirements

	4.	Preparation
	4-1. Logging in to the Web Browser for Initial Settings
	4-2. Date and time setting
	4-3. IP address settings
	4-3-1. Setting IP addresses of AE-50/EW-50
	4-3-2. Setting IP addresses of AE-200

	4-4. Software Update
	4-4-1. Directly reading the update file in USB memory device
	4-4-2. Using a Web browser

	4-5. License registration for optional functions

	5.	Settings on the LCD
	5-1. Initial Settings
	5-1-1. Logging in to the Initial Settings menu
	5-1-2. Locking the screen
	5-1-3. Date and time
	5-1-4. Unit Information
	5-1-5. Network
	5-1-6. Groups
	5-1-7. Interlocked LOSSNAY
	5-1-8. Blocks
	5-1-9. EM Blocks
	5-1-10. Floor Layout
	5-1-11. System View
	5-1-12. Advanced settings

	5-2. Function1
	5-2-1. Peak Cut (Energy-save control function)
	5-2-2. Measurement
	5-2-3. Energy Management

	5-3. Function2
	5-3-1. External Temperature Interlock
	5-3-2. Night Setback Control

	5-4. Ventilation setting
	5-4-1. Night purge

	5-5. User Information
	5-5-1. Maintenance User
	5-5-2. Building Manager


	6.	Settings using Initial Setting Tool
	6-1. Flow of the initial settings on Initial Setting Tool
	6-2. General descriptions of Initial Setting Tool
	6-2-1. Starting up the Initial Setting Tool
	6-2-2. Screen configurations and common items
	6-2-3. List of tool bar operations
	6-2-4. Unit address selection screen
	6-2-5. Other settings
	6-2-6. Preparation and flow of the Initial Setting Tool

	6-3. Basic settings
	6-3-1. System Configuration settings
	6-3-2. Basic System settings

	6-4. Unit settings
	6-4-1. Group settings
	6-4-2. Refrigerant System settings
	6-4-3. Interlocked LOSSNAY settings
	6-4-4. Block settings
	6-4-5. Energy management block settings
	6-4-6. PI controller settings
	6-4-7. AI controller settings

	6-5. Floor Settings
	6-5-1. Floor settings for LCD
	6-5-2. Floor Layout settings for LCD
	6-5-3. Floor settings for Integrated Centralized Control Web
	6-5-4. Floor Layout settings for Integrated Centralized Control Web
	6-5-5. Convenient usage methods

	6-6. Billing function settings

	7.	Settings using Web Browser for Initial Settings
	7-1. Initial Settings
	7-1-1. Date and Time
	7-1-2. Basic System
	7-1-3. Groups
	7-1-4. Interlocked LOSSNAY
	7-1-5. Blocks

	7-2. Functions 1
	7-2-1. E-Mail
	7-2-2. Peak Cut (Energy-save control function)
	7-2-3. Measurement
	7-2-4. Energy Management Settings

	7-3. Functions 2
	7-3-1. Set Temperature Range Limit
	7-3-2. Night Mode (quiet operation) Schedule
	7-3-3. System-changeover

	7-4. Functions 3
	7-4-1. External Temperature Interlock
	7-4-2. Night Setback Control
	7-4-3. Interlock control
	7-4-4. AHC Port Name Settings

	7-5. Ventilation Settings
	7-5-1. Night purge

	7-6. User Settings

	8.	Maintenance
	8-1. Settings Data Backup from the AE-200’s LCD
	8-1-1. Backing up settings data
	8-1-2. Importing settings data

	8-2. Settings Data Backup from the Web Browser for Initial Settings
	8-2-1. Backing up settings data
	8-2-2. Importing settings data


	9.	Troubleshooting
	9-1. Notes on connecting to Web browser
	9-1-1. Clearing cache
	9-1-2. Resetting Internet Explorer


	10.	Advance preparation
	10-1. Preparation of the PC
	10-1-1. Installation procedures of .NET Framework
	10-1-2. Installation procedures of the Initial Setting Tool
	10-1-3. Setting the PC’s IP address
	10-1-4. Setting the Web Browser
	10-1-5. Java settings


	11.	Explanation of terms
	Error code list



